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Abstract  
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higher.  This covers the common features found in all iDoctor components within the 
Main Window. 
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1 Introduction 

This document covers the iDoctor client and major common functions provided in all components.  Some 
common functionality is also covered separately in additional chapters (i.e.  Power, Data Viewer.) 

1.1 Starting iDoctor  
iDoctor may be launched in one of several ways: 
 

1. via the IBM iDoctor for IBM i desktop icon   
2. On Windows 7; Start -> Programs -> IBM iDoctor for IBM i -> IBM iDoctor for IBM i) or  
3. On Windows 8/10/11: Start -> IBM iDoctor for IBM i 
4. By passing an idoctor:// URL string to a web browser.  To generate this string, look for a “Copy 

URL” button or menu where this option is available. 
  

The iDoctor Main Window will initially show a list of recent changes made in the iDoctor Update History 
window. 
 

  
 
Pressing Close on this screen will return you to the Main Window where you can define a connection or 
pick an existing connection on the IBM i Connections View in order to begin looking at data. 
Right click in the IBM i Connections View and use the Add Connection menu to add a connection or 
double-click on a system name shown to connect.   
 
Next you will be prompted for your username and password and then shown the iDoctor components 
window that displays the components available: 
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If the status indicates the component is not available due to a missing access code you can enter the 
access code at the bottom of this window.   
 
If the status message indicates the access code is invalid, these are the possible reasons: 

1. Serial number provided to IBM was incorrect. 
2. The wrong OS level of the iDoctor server code is installed.  This can happen (for example) if 

you have iDoctor 7.1 installed and then upgrade the system to 7.4 without also updating the 
iDoctor server code. 

3. The access code entered was for the wrong component (you asked for PEX but really wanted 
Job Watcher) 

4. Access code generation error (on IBM’s side).  This could be due to an administrative error, 
website problem, etc.  

 
Note: If the iDoctor components window does not list the component as “Available” but lists a message 
about the client and server build levels not being up to date, you can still continue to launch the 
component anyway.  But in this situation some functionality may not work correctly.  If problems occur, 
then it’s typically recommended to download the latest version and install it on both client and server. 
 
Assuming the desired component is listed as “Available”, double-clicking on it will open the component 
view for it.   Component views display all reporting options available for the desired system and 
component.  Multiple component views may be in use within the same Main Window as desired.   To 
launch a second component view you would either need to revisit the Connections View and double-click 
the desired system a second time or simply uncheck the option “close window after clicking Launch” on 
the iDoctor components window. 
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Job Watcher component view example 
 

1.2 iDoctor and Internet connectivity 
This section describes the functions performed behind the scenes at startup that require an Internet 
connection to be successful.  If one is not available or blocked by a firewall on the PC, then these 
functions will NOT be performed.   

 

1.2.1 Automatic client updates 

When the iDoctor client starts, it will check if a newer client build is available.  If one is available, you will 
be asked if it should be downloaded and installed. 

 

By picking yes, the latest client will be downloaded, the current client will end, and the default web 
browser will be started to download the latest client update.  After installation is complete, the iDoctor GUI 
will be launched again. 

Note: This check can be disabled by going under Preferences -> Confirm and unchecking the 1st option 
shown. 
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1.2.2 Automatic server PTF checking 

When the iDoctor client starts, it will attempt to determine the latest required PTFs for the various 
performance components of IBM i, used by iDoctor.  These PTF lists are stored on the iDoctor website’s 
FTP server and downloaded to the PC.  When PTFs are checked later when collections are started, the 
latest PTF lists will be used. 

1.3 MDI Tabbed Styles  
The MDI Tabbed styles options let you control the style of interface you wish to use.  You can change this 
under the View -> MDI Tabbed Style menu. 

 

The options are: 

1) None – this is a classic Windows MDI without tabs which was more commonly used in the 1990s and 
early 2000s. 

2) Standard – Provides tabs and allows users to tile and cascade but you cannot create groups of MDI 
tabs to compare with other tabs. 

3) Grouped – Default setting. Tabs cannot be tiled or cascaded but you can create groups of MDI 
tabs to make comparisons. 

4) Preferences – Use this interface to control options for these styles. 

1.3.1 None 

This style is the classic Windows MDI style where the frame window contains one or more child windows 
that can be individually moved/resized, cascaded or tiled horizontally or vertically.   

If “None” is used, then some newer features are not available: 

1) The View -> Full Screen option. 

2) You will not be able to group several views/tabs together to make comparison with another set of 
views/tabs. 

However, when using “None” you will be able to use the Windows -> Cascade, or Windows -> Tile menus 
to rearrange the views shown. 

An example of the “None” MDI Tabbed Style in use is: 
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Main Window with the MDI Tabbed Style set to None 

1.3.2 Standard 

The Standard MDI style combines the benefits of using tabs with the classic MDI features of cascading 
and tiling.  However, this style does not allow tabs to be grouped together, so it will be more difficult to 
make comparisons with another set of tabs when using this setting.  You can also right-click anywhere on 
a tab to get additional options such as closing the tab or moving to another tab. 

An example of the “Standard” MDI Tabbed Style in use is: 

 

Main Window with the MDI Tabbed Style set to Standard 

1.3.3 Grouped 

The Grouped MDI style allows users to drag and drop tabs/views order in order to create 1 or more 
groups of tabs.  This makes it relatively easy to make comparisons of 1 or more view(s) vs another set of 
views.   This setting is the default setting in iDoctor. 

To drag and drop a tab simply left click on a tab and hold the mouse down and move the mouse pointer 
to the desired part of the window to create a new tabbed group in (top, bottom, left or right.)  Once in the 
correct location Windows will display a shaded rectangle around the area where the new tab will appear.  
At this point release the left mouse button and the tab will be moved to this location. 

Grouped mode does not allow users to Tile or Cascade the views shown within. 

An example of the “Grouped” MDI Tabbed Style in use is: 
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Main Window with the MDI Tabbed Style set to Grouped 

1.4 Report Visibility 
This option is used to control the level of detail shown in iDoctor in 3 ways: Basic, Detailed, Advanced.   
 
You can set this using the View -> Report visibility menu on both the Main Window and Data Viewer 
windows. 
 

 
 
Basic mode will show the fewest reports and Advanced will show all reports. 
For new users Intermediate is recommended. 
 
Note: You can tell which mode is in use by looking at the first word in the title bar of the Main Window or 
Data Viewer.   
 

 
 
If you cannot find a graph that another user can see, then the 1st thing to check is which report visibility 
mode you are using, and you may need to set this to Advanced in order to see the missing graph. 
 

1.5 Collections database 
The iDoctor collections database is built into the design of iDoctor and is used to improve performance in 
the GUI when listing the collections that exist on an IBM i.  It supports the following types of data: 

• PEX 

• Job Watcher (JW) 

• Collection Services (CSI) 

• Disk Watcher (DW) 
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The database resides in these tables in QUSRSYS. 

Table Description 

QAIDRLIBS Collections cache list of libraries. 

QAIDRCOLS Collections cache list of collections.    

These tables provide the ability to: 

1. Drill down in the overview graphs in CSI or Job Watcher to drill down into another component’s 
data for the same system in the same time period.  This is typically used to drill down from CSI to 
Job Watcher and/or PEX. 

2. Speeds up listing collections in libraries in iDoctor. 

Note: These tables are cleared after a reinstallation of the server builds and it is recommended that they 
be rebuilt after doing so.  Right-click the component icon and choose Collections database -> Refresh 
all to do this. 

1.5.1 Menu Options 

 

The following options are available under the Collections Database menu: 
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Menu Description 

Check for locks This opens the Object lock info Pane to check for any locks on the QAIDRCOLS 
table.  Typically, if any user has a CSI/JW Collection overview time signature graph 
open a lock will exist and these graphs and/or jobs will need to be closed before 
using the Delete or Full rebuild options. 

Refresh all This will submit jobs to rebuild the collections database for all 4 components PEX, 
DW, JW and CSI. 

Refresh <X> This will submit a job to rebuild the collections database for the current component. 

Schedule refresh This option allows you to schedule a daily refresh of the database.    

Full rebuild This option will delete and fully recreate the database.  Use the Check for locks 
option before using this or it will likely fail. 

View libraries  This will open the QUSRSYS/QAIDRLIBS table. 

View collections  This will open the QUSRSYS/QAIDRCOLS table. 

Clear all Removes all records from the QAIDRLIBS and QAIDRCOLS tables. 

Clear <X> Removes all collections from the QAIDRCOLS table for the current component only. 

Delete This will delete the QAIDRLIBS and QAIDRCOLS tables.  Use Check for locks before 
using.  If you use this option, you should do a full rebuild afterwards or some 
functions may no longer work correctly.   

1.5.2 Intra-component drill down support 

Some overview graphs in Job Watcher and Collection Services Investigator use the Collections database 
to identify and drill into other types of data.  If a drill down into another type of component is available a 
“widget” is shown on the graph which is special shape.  Then the menu option will contain options for the 
current component and an option for each available additional component you can drill into for this 
system and time period. 

In the following example CSI graph the plus sign (within the red box) indicates a drill down into PEX 
Analyzer is available and the normal drill downs into CSI are available under the CS menu.  The 
collection name for each is also listed in the menu. 

 

CSI Collection overview time signature showing intra-component drill down into PEX Analyzer. 

1.6 Record Quick View 
This window is shown when the Record Quick View menu is taken for the selected rows in a list or table 
view.  The Record Quick View tab shows all data for the selected rows in a vertical list.  This can make it 
easier to see all the data for a single record if many fields exist in the table.  You can also make 
comparisons between multiple rows by selecting them and using the Record Quick View menu. 
 
Tip: Access this window by double-clicking on any record in a table view in the Data Viewer or use the 
Record Quick View menu option from the Main Window’s View menu or popup menu on the desired 
folder in some cases. 
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View -> Record Quick View menu from the Main Window 
 

1.6.1 Viewing a single row 
To view a single row in a table, simple double-click the desired row: 
 

 
Record Quick View for 1 row 
 
Tip: Use the Hide all 0 or blank values checkbox to remove those values from the list 
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1.6.2 Comparing multiple rows 
Select multiple rows in the table, right-click and use the Record Quick View menu to do this: 
 

 
Record Quick View menu option 
 
This will show the rows side-by-side with an area on the right side of the screen which is used for the 
analysis checkboxes at the top of the screen. 
The Analysis options are: 
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Min, Max, Avg, Sum and All 
 

 
Comparing 2 rows  

 

 

Showing results for the Max and Sum options on 2 rows 

 

 



IBM iDoctor for IBM i  

2 The Main Window 

The Main Window displays the various component views as well as some additional views such as the 
IBM i Connections View.  Each of these views within the Main Window will be discussed in greater detail 
in the next sections.  This section will discuss the general use of the Main Window within IBM iDoctor for 
IBM i. 
 
The heart of the IBM iDoctor for IBM i application is the interface shown below.  All components are 
displayed within this GUI each within a separate "tree/list" view.  Each view can be resized, tiled or 
manipulated at runtime.  You can have as many component (a.k.a "tree/list") views up at one time as you 
wish. 
 

 
Main Window Example 

2.1 Toolbar 
This section covers the toolbar buttons shown on the Main Window.   

Note: Some of these options are only enabled depending on the current focus of the mouse pointer. 
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Add Connection (Alt+A) 
Opens the Add Connection window for either the IBM i Connections View or Power Connections 
View depending upon which view is open and has focus.  This option will only be enabled when 
one of the connection views has focus. 

 
Power Connections 
Shows or hides the Power Connections View.  This lets you work with the HMC or VIOS 
connections.   

 
IBM i Connections 
Shows or hides the IBM i Connections View. 

 
Open Knowledge Base 
This opens the Knowledge Base component on whatever system in the list of IBM I connections 
defined as the default system (with a checkmark icon next to it.)  This is a repository for storing 
your notes about performance data captured in iDoctor. 

 
Save to Knowledge Base 
This option is used to save the current information shown on the screen to the Knowledge Base. 

 
Remote Command Status View 
Shows or hides the Remote Command Status View.  This view will show the status of CL 
commands and program calls running on behalf of the GUI’s requests. 

 
Remote SQL Statement Status View 
Shows or hides the Remote SQL Statement Status View.  This view will show the status of SQL 
statements running on behalf of the iDoctor GUI’s requests. 

 
iDoctor Message View 
Shows or hide the iDoctor Message View.  This provides debug information and is used 
primarily if problems occur and you need to provide more details back to iDoctor support.  

 

New SQL Query 
Opens a new instance of an SQL Query View.  The SQL Query View is used to create a query 
using Structured Query Language (SQL).  The top portion of the view is an area where you can 
enter an SQL statement (also known as the SQL Editor) and the bottom portion is the result or 
output from the statement above.    

 

Open File 
This option allows you to open any library/file/member on the system using the Open File/SQL 
Table Window.  This window lets you browse for the file or SQL table you wish to open.    

 
Save As 
This option allows you to either save the contents of a table view to a file or if viewing a graph to 
a .jpg image.   
 
When using this option on a table the entire contents of the table are saved.  You can choose 
between rich text, comma separated, and tab separated text formats.  If you wish to 
include/exclude the header in the saved file, see the Preferences -> File tab. 

 
Objects 
Displays/hides the Objects Pane.  This is an interface like the WRKOBJ command.  This option 
lets you work with objects on the desired system and appears when the IBM i Explorer Objects 
or Libraries folders are used or when a search is performed results will go to the Objects folder 
in IBM i Explorer. 

 
Object lock info 
Displays/hides the Object lock info Pane.  This option lets you work with the any locks that exist 
on the specified object. 
 
This is an interface like the WRKOBJLCK command and appears automatically when the IBM i 
Explorer -> Work management -> Object lock info folder is used.  Search results will also go to 
that folder.   

 
IFS 
Displays/hides the IFS Pane.  This option lets you browse a directory on the IFS.   
This is an interface like the WRKLNK command appears automatically when the IBM i Explorer -
> IBM I Explorer -> IFS folder is used. 

 
Active jobs 
Displays/hides the Active Jobs Pane.  Unlike the command this view lets you work with active or 
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inactive jobs on the system (to view spool files of completed jobs.)  You can also graph some 
job statistics in limited ways.  

 
User profiles 
Displays/hides the User profiles Pane.  This lets you search/view/modify the user profiles found 
on the desired system.  This is an interface like the WRKUSRPRF command appears 
automatically when the IBM i Explorer -> System -> User profiles folder is used. 

 
Output queues 
Displays or hides the Output queues Pane.  This lets you view the output queues or expand 
them to view spool files within them.  This is an interface like the WRKOUTQ command appears 
automatically when the IBM i Explorer -> Work management -> Output queues folder is used. 

 
Spool files 
Displays/hides the Spool files Pane.  This lets you work with the spool files on the system.  This 
is an interface like the WRKSPLF command appears automatically when the IBM i Explorer -> 
Work management -> Spool files folder is used. 

 
Tables 
Displays/hides the Tables Pane.  This lets you search the desired system for physical files/SQL 
tables/views/etc.  This pane appears automatically when the IBM i Explorer -> IBM i Explorer -> 
Tables folder is used. 

 
Graphs 
Displays/hides the Graphs Pane.  This lets you search the iDoctor report database for graphs 
and reports of interest and determine where they exist, what releases they are available and 
what special files or PTFs are required for each. 

 
Copy (Ctrl+C) 
Copy the selected rows or cells from a list view to the clipboard in text format.  This allows you 
to quickly copy data shown in iDoctor list views into Notepad or other applications that work with 
text.   

 
Delete 
Deletes the selected objects (connections, libraries, collections, etc) 

 
Properties 
Displays the property pages for the selected object (library, collection, etc) 

 
Collection Search 
This option will open the Collection Search function for the currently selected performance 
collection.  (PEX, CS, DW, JW, etc)  
 
This will let you search for something specific within the desired collection such as a job name. 

 
Report Generator 
This option will open the Report Generator interface for the currently selected performance 
collection. 
 
This is used to build several graph/reports from the data at once and saving lists of reports into 
a reusable collection of favorites to be used repeatedly. 

 
Set Font 
Displays the Set Font window which allows you to control the font used in iDoctor tree and list 
views. 

 
Edit Preferences 
Displays the iDoctor Preferences interface. 

 
Window Manager 
This button will display the Window Manager which lets you work with a list of all tabs/views that 
are opened.  This lets you find and activate the desired view/window or close one or more views 
quickly. 

 
Refresh (F5) 
Refresh the selected list view or selected branch in a tree. 
 
Note: This is not the same as refreshing everything on the screen.  In some cases, you may 
need to click on the folder above the current one to refresh the desired objects. 

 
Data Viewer (Ctrl+N) 
Opens an empty Data Viewer for the system you are currently working with.  
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Set default time grouping 
Toggles the default time grouping shown on graphs.  The iDoctor default value for this is 1-
minute intervals.  This setting is changeable in the Data Viewer after the graph is opened using 
the clock icon there.  The larger the interval size, the smaller number of bars produced in the 
graph and the more time that can be shown on a single graph page. 
 
This applies to all components that show data over time. 
  
Note: If the data was collected at an interval size greater than the current default time range 
interval size specified, (such as 15-minute intervals in Collection Services) the data will be 
shown at the collected interval size since it cannot be broken down further. 

 
Enable/disable Situations 
This button enables or disables the Situational Analysis background colors across all 
graphs/components. 
 
If graphs are currently open, you may need to click on the desired graph after toggling this 
button on/off in order to see the change take effect on the graph. 

 
About 
This option displays the properties for iDoctor. This button performs the same action as the Help 
-> About menu. 

 

2.2 Menu Options 

 
The tables below outline the different types of menu operations that may be performed within the Main 
Window of the iDoctor GUI. 
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2.2.1 File 
File Menu  Description 

Add Connection This option will display the Add Connection window to add a new IBM i or Power 
connection depending on which view (IBM i connections or Power Connections) is 
currently active.  If neither is active then this menu option will be disabled. 

New SQL Query Opens a new instance of an SQL Query View.  The SQL Query View is used to 
create a query using Structured Query Language (SQL).  The top portion of the view 
is an area where you can enter an SQL statement (also known as the SQL Editor) 
and the bottom portion is the result or output from the statement above.    

Open Knowledge 
Base 

This opens the Knowledge Base component on whatever system in the list of IBM I 
connections defined as the default system (with a checkmark icon next to it.)  This is 
a repository for storing your notes about performance data captured in iDoctor. 

Open File/Member This option allows you to open any library/file/member on the system using the Open 
File/SQL Table Window.  This window lets you browse for the file or SQL table you 
wish to open.    

Open New Data 
Viewer 

Opens an empty Data Viewer. 

Save -> View As... This option allows you to save the contents of a list view to a file.  When using this 
option, the entire contents of the table are saved.  You can choose between rich text, 
comma separated, and tab separated text formats.   

Save -> Selection 
As… 

The option allows you to save the selected contents within a list shown in the GUI to 
a file.  When using this option only the selected records or block of cells are written to 
the file. 
 
When using this option, you can choose between rich text, comma separated, and 
tab separated text formats.  This option is not available for graph views. 

Save to Knowledge 
Base 

This option is used to save the current information shown on the screen to the 
Knowledge Base. 

Close This will close the active view within the Main Window. 

Set User-Defined 
Reports Database 

This option allows a user to load/use another user’s iDoctor user-defined 
reports/graphs that they have previously created.  When saving user-defined reports 
these are saved into the specified database.  This can either be an IBM i library or a 
local database on the PC (MDB file).   
 
To find the current user-defined reports DB settings, either use this menu option or 
see the application properties (Help -> About menu) and then look for the “User-
defined reports DB” location.  

Exit Exits the application.  All open windows including Data Viewers will be closed. 
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2.2.2 Edit  
Edit Menu Description 

Copy Copies the current selection from the active view to the clipboard.  This is only 
enabled when the active view is a list view or text in a textbox. 

Delete Deletes the current selection. 

Select all If the current view is a list view or text box, this option will select the entire contents.  

Find This option displays the Find Window which can be used to find the next or previous 
text in a list view. 

Find Next Use this option (or press F3) to look for and select the next occurrence of the text last 
entered on the Find Window. 

Find Previous Use this option (or press Shift+F3) to look for and select the previous occurrence of 
the text last entered on the Find Window. 

Search This option will open the Collection Search function for the currently selected 
performance collection.  (PEX, CS, DW, JW, etc)  
 
This will let you search for something specific within the desired collection such as a 
job name. 

Generate Reports This option will open the Report Generator interface for the currently selected 
performance collection. 
 
This is used to build several graph/reports from the data at once and saving lists of 
reports into a reusable collection of favorites to be used repeatedly. 

Set Font Displays a window allowing you to change the font used for the interface currently 
open.  The font change will also be used in other interfaces of the same type. 
 
The fonts used in lists/trees is different than the fixed-width font used in editors, 
property sheets and text file output and can be controlled more directly under 
Preferences -> Display - Advanced. 

Preferences This interface allows you to work with many user-definable settings in iDoctor.  These 
settings are stored in the Windows registry. 

Wait Bucket 
Preferences 

Displays a window letting you work with preferred colors, patterns and wait buckets 
to show in iDoctor wait bucket graphs.    

Column Search This option allows a user to search all of the iDoctor graph/report databases (.mdb 
files) at once for a specific column name in any of the reports. 
 
Note: This typically is for IBM internal use only.   

Clear iDoctor cache This option clears most data structures loaded into the GUI’s memory cache.  This 
includes things like report information, graph definitions, stored procedure versions, 
column descriptions, etc. 

Migrate user-
defined reports DB 

This is available to assist any long-time user migrate their user-defined iDoctor 
reports to the latest format.  This only works if the file was created after November 
2012. 

Restore Field 
Selection Settings 

This option resets all field selections in the component views to the defaults.  These 
can be changed by the user on some folders using the Select Fields… menu option. 

Increase Windows 
GDI limit  

This option will allow a user to open more graphs (4X) than you would normally be 
able to before running out of Windows (GDI) objects (a type of memory structure).  
This is highly recommended.  
 
As a work-around you can also try opening multiple instances of iDoctor 

Restore Windows 
GDI limit 

This option will restore the Windows GDI limit to the Windows default of 10,000.   
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2.2.3 View 
View Menu Description 

MDI Tabbed Style Use this option to change the current MDI tabbed style being used.  There are 3 
styles of MDI tabs available in iDoctor: 
1) None – this is a classic Windows MDI without tabs 
2) Standard – allows users to tile and cascade but you cannot create groups of MDI 

tabs to compare with other tabs. 
3) Grouped – Tabs cannot be tiled or cascaded but you can create groups of MDI 

tabs in order to make comparisons. 

Report Visibility This option is used to control the level of detail in the list of reports in 3 ways: Basic, 
Detailed, Advanced.   

Record Quick View  

Toolbar This will either show or hide the tool bar.   

Status Bar This will either show or hide the status bar.   

Refresh 

 

This menu will refresh the currently selected portion of a tree/list view.   
F5 can also be used to do this action. 
 
If a tree item is selected and this menu is clicked, everything underneath the tree 
item, including the tree item will have its data refreshed.  If the list has focus and this 
menu is clicked, the entire list will be refreshed.  

Resize Column 
Widths 

This option will resize the columns shown in the currently show list view.   
F8 can also be used to do this action. 
 
This is mostly useful in situations where new data has arrived, and the columns are 
truncating some of that data.   

Power Connections Shows or hides the Power Connections View.   

IBM i Connections This menu will either show or hide the IBM i Connections View.   

Remote Command 
Status 

This menu will either show or hide the Remote Command Status View.   
 
This view displays the status of long running remote commands such as copying a 
collection or sending a collection to another system.  It can also be used to run CL 
commands against one or more systems at once. 

Remote SQL 
Statement Status 

This menu will either show or hide the Remote SQL Statement Status View.   
 
This view executes SQL statements ran by the GUI or user.  It can also be used to 
run user-defined SQL statements against one or more systems. 

iDoctor Messages Shows or hide the iDoctor Message View.  This provides debug information and is 
used primarily if problems occur and you need to provide more details back to 
iDoctor support. 

Objects Displays/hides the Objects Pane.  This is an interface like the WRKOBJ command.  
This option lets you work with objects on the desired system and appears when the 
IBM i Explorer Objects or Libraries folders are used or when a search is performed 
results will go to the Objects folder in IBM i Explorer. 

Object lock info 
 

Displays/hides the Object lock info Pane.  This option lets you work with the any 
locks that exist on the specified object. 
 
This is an interface like the WRKOBJLCK command and appears automatically when 
the IBM i Explorer -> Work management -> Object lock info folder is used.  Search 
results will also go to that folder.   

IFS 
 

Displays/hides the IFS Pane.  This option lets you browse a directory on the IFS.   
This is an interface like the WRKLNK command appears automatically when the IBM 
i Explorer -> IBM I Explorer -> IFS folder is used. 

Active jobs 
 

Displays/hides the Active Jobs Pane.  Unlike the command this view lets you work 
with active or inactive jobs on the system (to view spool files of completed jobs.)  You 
can also graph some job statistics in limited ways.  

User profiles Displays/hides the User profiles Pane.  This lets you search/view/modify the user 
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profiles found on the desired system.  This is an interface like the WRKUSRPRF 
command appears automatically when the IBM i Explorer -> System -> User profiles 
folder is used. 

Output queues Displays or hides the Output queues Pane.  This lets you view the output queues or 
expand them to view spool files within them.  This is an interface like the WRKOUTQ 
command appears automatically when the IBM i Explorer -> Work management -> 
Output queues folder is used. 

Spool files 
 

Displays/hides the Spool files Pane.  This lets you work with the spool files on the 
system.  This is an interface like the WRKSPLF command appears automatically 
when the IBM i Explorer -> Work management -> Spool files folder is used. 

Tables Displays/hides the Tables Pane.  This lets you search the desired system for 
physical files/SQL tables/views/etc.  This pane appears automatically when the IBM i 
Explorer -> IBM i Explorer -> Tables folder is used. 

Graphs Displays/hides the Graphs Pane.  This lets you search the iDoctor report database 
for graphs and reports of interest and determine where they exist, what releases they 
are available and what special files or PTFs are required for each. 

Properties This action displays the properties for the selected item in the current interface with 
focus. 
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2.2.4 IBM i 
IBM i Menu Description 

Objects Displays/hides the Objects Pane.  This is an interface like the WRKOBJ command.  
This option lets you work with objects on the desired system and appears when the 
IBM i Explorer Objects or Libraries folders are used or when a search is performed 
results will go to the Objects folder in IBM i Explorer. 
 
Additional options also appear here to access the iDoctor libraries QIDRGUI, 
QIDRWCH, QIDRPA, QMGTOOLS and QIDRTMP. 

Object lock info 
 

Displays/hides the Object lock info Pane.  This option lets you work with the any 
locks that exist on the specified object. 
 
This is an interface like the WRKOBJLCK command and appears automatically when 
the IBM i Explorer -> Work management -> Object lock info folder is used.  Search 
results will also go to that folder.   

IFS 
 

Displays/hides the IFS Pane.  This option lets you browse a directory on the IFS.   
This is an interface like the WRKLNK command appears automatically when the IBM 
i Explorer -> IBM I Explorer -> IFS folder is used. 

Active jobs 
 

Displays/hides the Active Jobs Pane.  Unlike the command this view lets you work 
with active or inactive jobs on the system (to view spool files of completed jobs.)  You 
can also graph some job statistics in limited ways.  

User profiles Displays/hides the User profiles Pane.  This lets you search/view/modify the user 
profiles found on the desired system.  This is an interface like the WRKUSRPRF 
command appears automatically when the IBM i Explorer -> System -> User profiles 
folder is used. 

Output queues Displays or hides the Output queues Pane.  This lets you view the output queues or 
expand them to view spool files within them.  This is an interface like the WRKOUTQ 
command appears automatically when the IBM i Explorer -> Work management -> 
Output queues folder is used. 

Spool files 
 

Displays/hides the Spool files Pane.  This lets you work with the spool files on the 
system.  This is an interface like the WRKSPLF command appears automatically 
when the IBM i Explorer -> Work management -> Spool files folder is used. 

Tables Displays/hides the Tables Pane.  This lets you search the desired system for 
physical files/SQL tables/views/etc.  This pane appears automatically when the IBM i 
Explorer -> IBM i Explorer -> Tables folder is used. 

Delete all Spool 
Files for current 
user 

This option will prompt you and then if confirmed, remove all spool files for the 
currently signed on user profile for the current system. 
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2.2.5 Window 
Window Menu Description 

Cascade Use this menu to rearrange all views in the Main Window in an overlapping sequence 
starting in the upper left corner of the window.  
 
Note: This option is not shown when the MDI tabbed style is set to Grouped. 

Tile Horizontally Use this menu to rearrange all views in the Main Window such that each view will 
have an equal distribution of the available height in the Main Window.  The views will 
not overlap each other. 
 
Note: This option is not shown when the MDI tabbed style is set to Grouped. 

Tile Vertically Use this menu to rearrange all views in the Main Window such that each view will 
have an equal distribution of the available width in the Main Window.  The views will 
not overlap each other. 
 
Note: This option is not shown when the MDI tabbed style is set to Grouped. 

Close All This option will close all open tabs/views. 

 
Note: The Window menu also dynamically contains a list of all open views within the Main Window for 
easy access to them.  Clicking on a view name will take the user to it. 
 

2.2.6 Help 
Help Menu Description 

Update History Shows the Update History window. 

Update Summary Opens the iDoctor Update Summary PDF document.  This is a much-less verbose 
version of the Update History.  

FAQs This open the iDoctor Frequently Asked Questions document. 

iDoctor Videos Launches your web browser and takes you to iDoctor videos on IBM MediaCenter . 
 

IBM i Support 
Center Videos 

Launches your web browser and takes you to the IBM i Systems Support 
MediaCenter page 

Tips Additional PDF documents covering different topics are accessible under this menu. 

iDoctor website Launches your web browser and takes you to the iDoctor website. 

iDoctor downloads Launches your web browser and takes you to the iDoctor download page. 

iDoctor 
documentation 

Launches your web browser and takes you to the documentation. 

About IBM iDoctor 
for IBM i 

This displays version information for the iDoctor client.   

2.3 Update History 
This window is displayed when iDoctor is started by default to show all the recent changes. 

https://mediacenter.ibm.com/channel/iDoctor/200077473
https://mediacenter.ibm.com/category/IBM+i/172218552
https://mediacenter.ibm.com/category/IBM+i/172218552
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The window provides a find textbox that lets you search for the iDoctor function of interest.  You may also 
click the “do not show this screen again checkbox”.  If you click that checkbox and then want to see the 
Update History window again later, use the Help -> Update History menu to reopen it. 

2.4 IBM i Connections View 
The IBM i Connections view allows you to work with all the connections defined to IBM i systems created 
via IBM i Access Client Solutions or iDoctor.  The primary purpose of this view is to provide a quick and 
easy way to launch the iDoctor components for any system desired. 
 
The list of connections shown is for the currently active “environment”.  Each environment can contain 1 
or more systems.  You can change the currently active environment by right-clicking on the list and 
choosing the Change Environment... menu.   
 

 
IBM i Connections  
 
Double-click a system to connect to it.  Right-click a system and use Edit to change the settings for a 
system. 
 

2.4.1 Fields 
The list contains several columns.  NOTE:  All values shown are based on the last checked values and 
may not reflect current values.  Some of the less obvious fields in the list are described below: 
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Column  Description 

Default user mode This indicates how the username is determined when making connections.   
The possible values are: 
1) Use Windows ID 
2) Set specific user ID (indicated by the User column) 
3) Prompt every time 

ASP group The name of the IASP group to use when making the connection.  This is a required 
field if you wish to work with libraries created on IASPs.  
 
The value given should match the value supplied after running the command: 
WRKDEVD DEVD(*ASP) 

Relational database 
name 

The name of the relational database to use when making the connection to the 
system.  This is primarily used when connecting to a system with an IASP (in the 
ODBC connection for the QZDASOINIT job).  The value may or may not be same as 
the ASP group value depending on how the system is configured.  The relational 
database name is listed in the Database component of IBM i Navigator. 

Transfer method This indicates how files will be transferred to/from the system. 
 

SSL  Indicates if the ACS setting to use SSL on the connection is set.  It does not apply to 
the Transfer method SSL option. 

IP Address The last known IP address of the system.  To update this right-click the list and use 
the Check -> IP Address popup menu. 

 

2.4.2 Menu options 
Right-click a system for several options.  The less obvious options are described below: 
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Popup Menu  Description 

Terminal Sessions 
– Launch ACS 

This allows you to launch an IBM i Access Client Solutions terminal session to the 
selected system. 
 
Note: This option only works when the Preferences > Terminal Session -> Sessions 
Directory value specifies the directory where the ACS .ws files are stored and the file 
name matches the connection name exactly (minus the .ws).   
 
This currently doesn’t support .hod files 

Terminal Sessions 
– Launch PCOMM 

This allows you to launch an IBM Personal Communications terminal session to the 
selected system. 
 
Note: This option only works when the Preferences > Terminal Session -> Sessions 
Directory value specifies the directory where the ACS .ws files are stored and the file 
name matches the connection name exactly (minus the .ws).   

Terminal Sessions 
– Launch Putty 
(SSH) 

This launches a putty (SSH) session to the system. 
 
This only works if Preferences -> Power -> Putty install directory setting correctly 
specifies a directory where Putty has been installed. 
 
Note:  You may need to run this command on the IBM i before being able to use this 
option by starting the SSHD server.  QSYS/STRTCPSVR SERVER(*SSHD)   

Terminal Sessions 
– Launch Putty 
(Telnet) 

This launches a Putty telnet session to the system. 
 
This only works if Preferences -> Power -> Putty install directory setting correctly 
specifies a directory where Putty has been installed. 
 
Note:  You may need to run this command on the IBM I before being able to use this 
option by starting the Telnet server.  QSYS/STRTCPSVR SERVER(*TELNET)   

Terminal Sessions 
– Open Sessions 
Directory… 

This opens the Preferences -> Terminal Sessions -> Sessions Directory folder in 
Windows Explorer. 

 

Enable SSH key-
based 
authentication 

The GUI will attempt to setup SSH key-based authentication on this LPAR.  It won’t 
always work.  See the FAQ section 2.13 for more information on what it does and 
additional resources for setting this up. 

 
  
 

https://public.dhe.ibm.com/services/us/igsc/idoctor/html/iDoctorFAQs.pdf
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Check – 
QMGTOOLS 
version 

This option will determine the build date of QMGTOOLS for each of the selected 
systems.  You will be prompted to signon for any system where this is necessary, 
and the password is not cached already in ACS. 
 
Note: This requires build 1633+. 
 

 
Check – Expiration 
Dates 

This will check the dates the access codes expire on all selected systems then 
update the PEX Analyzer access expires and Job Watcher access expires 
columns in the list.  The default signon is used to access each selected system. 

Check – PTFs This checks the required PTF levels for all performance related components on the 
desired system(s).   The Performance Group PTF level will be checked as well as the 
required PTFs for Job Watcher, PEX, Collection Services and Disk Watcher. 
 

 
Check – PTF 
Search 

This option allows the user to type in a specific PTF name or a generic PTF name 
against a system to check the status of a PTF.  This uses the QSYS2/PTF_INFO 
view.  Tip: Enter a value of * to see a list of all PTFs. 
 
Only works against 1 system at a time. 
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Check – Cache 
battery status 

This runs program QSMBTTCC to check cache battery status on the selected 
system(s). 
 

 
Check – Transfer 
Methods 

This will test each type of possible transfer method (FTP/SSH) connection method on 
the system and show the results. 
 
Only works against 1 system at a time. 

Check – 
Connection 

This runs the windows ping command against the selected system(s). 

Check – IP Address This will attempt to determine the IP address for all selected systems, then update 
the listing. 

 



IBM iDoctor for IBM i  

Record Quick View Displays a vertical list of fields for the selected rows in a new window.  You can use 
this to make comparisons. 

Set default user 
mode 

Use this option to more quickly set the default user mode to a specific user id of 
your choice on all systems or only the selected systems. 

Set as default 
system  

This sets the desired LPAR to be the default one in Access Client Solutions.  This 
system will be shown with a checkbox icon in this interface.  This means this system 
is the Knowledge Base system used by the GUI. 

Apply Keys This option is used to apply access codes to one or more LPARs using the email 
sent by the iDoctor team. 

Clear Password 
Cache 

This option is sometimes useful to ensure that iDoctor does not try to use an 
old/expired password after changing your password on a system. 

Open Digital 
Certificate Manager 

This opens the Digital Certificate Manager web page for the current system. 

Download 
Certificates 

This launches the cwbcossl ACS tool for downloading certificates from the current 
system to the PC. 

 
  

Export Connections Use this option to create a Windows registry file that contains a list of all your IBM I 
connections.  This file can be used to restore your connections later, or move them to 
another PC.   

Export GUI 
Preferences 

Added in 1562+, this option creates a Windows registry file that contains all iDoctor 
preferences (except for your connections).   
This file can be used to restore your desired preferences later or move them to 
another PC.   

Uninstall iDoctor This option removes all iDoctor related libraries and objects on the system.  After 
running this option, you can view the results (job log) from the Remote Command 
Status View. 
 
If you wish to run this process outside of the GUI then execute the following 
commands: 
 

CRTDUPOBJ OBJ(QIDRUNINST) FROMLIB(QIDRGUI) OBJTYPE(*PGM) 
TOLIB(QTEMP)  
 
CALL PGM(QTEMP/QIDRUNINST)   

 
Note: No performance data created by iDoctor is deleted using this option.  If this is 
desired, delete the desired performance data from the system first before uninstalling 
iDoctor. 
 
Also, it is normal for some objects to be missing and show errors during the uninstall 
process.  If you encounter objects created by iDoctor but not removed, you can 
report this to idoctor@us.ibm.com so we can update this program appropriately. 

Change Connection 
Environment 

A connection environment is a set of 1 or more connections which can be defined in 
both iDoctor and ACS.  By changing your connection environments the IBM i 
Connections view will update to show the connections within that environment. 
 
You can also define new connection environments or delete one within this interface. 

 

2.4.3 Add/Edit IBM i Connection 
This window allows a user to add or edit a connection. 
 
Provide the system name or IP address, the default user mode and user ID if applicable, an optional 
description and click OK to register the system on your PC and add it to the list of IBM i Connections.   
 
An example of this interface is: 

mailto:idoctor@us.ibm.com
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Add IBM i Connection 
 

2.4.3.1 Interface 

The less obvious options available on this screen are described in the following table: 
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Option Description 

System alias 
(optional) 

This option (if specified) will display this value as the system name in graph titles or 
report titles in the Data Viewer. 

Default user mode Indicates how the user name when making connections to this system will be 
determined.  The choices are: 
 
Use Windows ID 
Set specific user ID (a text box will appear where you can enter this value) 
Prompt every time 

Port lookup mode This is an ACS setting indicating how the host server port lookup will occur.   
More information on the API used is here. 

Auxillary storage 
pool group 

The name of the IASP group to use when making the connection.  This is a required 
field if you wish to work with libraries created on IASPs.  
 
The value given should match the value supplied after running the command: 
WRKDEVD DEVD(*ASP) 

Relational DB 
name 

The name of the relational database to use when making the connection to the 
system.  This is primarily used when connecting to a system with an IASP (in the 
ODBC connection for the QZDASOINIT job).  The value may or may not be same as 
the ASP group value depending on how the system is configured.  The relational 
database name is listed in the Database component of IBM i Navigator. 

File transfer 
method 

This option lets you pick which method is preferred when connecting to this system 
for the purpose of sending or receiving files.    The choices are: 
 
- WININET - This is an unsecure FTP connection, but the fastest option. 
- SSL (passive) - This is recommended if needing a secure connection.  Use the 

SSL protocol Tls12 value in most cases. 
- SSL (active) - This option has not been well tested and may not work. 
- SSH (using Windows SSH support) - This option has not been well tested and 

may not work. 
- DISABLED (If you want to be sure no FTP connections are attempted but 

certain functions will fail however with this set.) 
 

The Port value defaults to 0 but this just means the default port for the type of 
connection will be used.  For example, the default port for WININET is 21, SSL 
(passive) is 990, etc.   

 

2.5 iDoctor IBM i Components Window 
The components window provides the status of the iDoctor components installed on the system selected 
from the IBM i Connections View.   
 

https://www.ibm.com/docs/en/i/7.3?topic=apis-cwbco-setportlookupmode
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iDoctor IBM i Components Window 
 
This window allows a user to launch a component, change the user signed on to the system or apply an 
access code.  After applying an access code, the component list will refresh to indicate any changes in 
status (i.e. Not Authorized -> Available) 
 
Note on applying accessing codes:  The serial number listed here is for your convenience and 
verification.  If the system serial number has changed, use the “Refresh” button to update the value 
shown.  This button will also refresh the processor group value shown from its last retrieved value. 

2.5.1 Interface 
The less obvious options on this screen are described in the following table: 
 

Option Description 

Access code The access code can be entered into this box and then press the Apply button to 
have it take effect.  Do not copy the serial number into this box.  You should 
immediately see the status and expiration date change for the component(s) the 
access code applies to. 
 
Note:  The Access code will only be correct and work if the system serial number 
supplied to IBM is correct and the appropriate release of iDoctor on the server is 
installed and it must match the OS (IBM i) release.   

System serial 
number  

This value is the result given by the DSPSYSVAL QSRLNBR command.  On IBM i 
cloud systems this is the virtual serial number (VSN).  In that case, 2 serial numbers 
are listed.  The 1st is the physical serial number and the second is the (VSN). 

 

2.6 Power Connections View 
The Power Connections view allows you to work with all connections defined to non-IBM i systems.  
Currently this view will only work with HMC or VIOS type connections.   
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Main Window displaying the Power Connections View 
 
The top level of the tree/list contains several columns that represent settings for each connection.  The 
data supplied is based on the last known connection made to the system and may not reflect current 
system settings. 
 
Unlike the IBM i Connections View, this interface consists of a tree and list with expandable connections. 
The top level of the tree contains a list of all your Power connections.   
 
Power Connections is documented on our website here. 

2.7 Remote Command Status View 
The Remote Command Status view shows you the status of certain remote commands being executed 
on a system.  This allows you to perform lengthy operations like copy objects or delete files without tying 
up the GUI. 
 
Depending on the function being used you will see one or more commands in the remote command 
status view.  As each command completes you will see its result or error message in the view.   
 
You can also close this window and reopen it later while commands are being executed to periodically 
check the status of the commands issued.  Use the View -> Remote Command Status menu on the Main 
Window or the toolbar button to reopen it. 
 
Note: This will only execute 1 command at a time. 
 

 
Remote Command Status View  
 

2.7.1 Fields 
 

https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_Power.pdf
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Column  Description 

Submitted The time the command was added to the view. 

Completed The time the command completed. 

System   

Status  Shows either Running, Waiting or the result of the operation.   

Command Lists the command string executed.   
 
Note: In some cases, these are not IBM i commands but apply to iDoctor/Windows 
operations.  Examples: 
get - download a file. 
put - upload a file from the PC to the i. 
explorer - opens Windows Explorer at the path indicated. 

Job Indicates the job on the i that is running or ran this command if it occurred in the past. 
 
Note: This does not apply if this view is showing operations to HMC or VIOS or 
Windows. 

 

2.7.2 Menu options 
The following actions may be taken in the Remote Command Status View by selecting one or more 
entries and then right-clicking: 
 

Menu  Description 

Display Job Log Shows the job log for the selected system.    
Tip: This is the default action if double-clicking a row. 

Show History Log Opens notepad with a listing of all commands and results for the entire view. 

Active job options These options let the user view or search job logs, end jobs and more. 

Copy Selected 
Commands to 
Clipboard 

Copies all command strings listed in the entries selected to the Windows 
Clipboard. 

Rerun commands Allows you to rerun the selected command(s) either on the same LPAR or other 
LPAR(s).   
 
Note: This can’t be used on things like Windows commands or file transfers, only 
IBM i commands. 

Add Command(s)… Displays a window where you can provide your own CL command(s) to run on this 
system (and/or other systems.) 

Cancel Cancels the running command by ending the QZRCSRVS job if applicable. 

Remove Selected Removes selected remote command entries from the view.   
 
Note: Does not apply to commands that are running, use Cancel instead. 

Remove All Use this menu to remove all remote command entries from the view.   
 
Note: Does not apply to commands that are running, use Cancel instead. 

 

2.8 Remote SQL Statement Status View 
The Remote SQL Statement Status view shows you the status of SQL statements running on the system. 
 
Depending on the function being used you will see one or more statements in this view.  As each 
statement completes you will immediately see its result in the view.   
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You can also close this window and reopen it later while commands are being executed to periodically 
check the status of the statements issued.  Use the View -> Remote SQL Statement Status View menu 
on the Main Window to reopen it. 
 

 
Remote SQL Statement Status View displaying the status of collections being deleted in Job Watcher. 
 

2.8.1 Fields 
 

Column  Description 

Submitted The time the statement was added to the view. 

Completed The time the statement completed. 

System   

Status  Shows either Running, Waiting or the result of the operation.   

SQL Statement Lists the SQL Statement 

Job Indicates the job on the i that is running or ran this SQL statement if it occurred in the 
past. 

 

2.8.2 Menu options 
The following actions may be taken in the Remote SQL Statement Status View by selecting one or more 
entries and then right-clicking: 
 

Menu  Description 

Display Job Log Shows the job log for the selected system.    
Tip: This is the default action if double-clicking a row. 

Show History Log Opens notepad with a listing of all SQL statements and results for the entire view. 

Active job options These options let the user view or search job logs, end jobs and more. 

Copy Selected SQL 
Statements to 
Clipboard 

Copies all SQL statements for the entries selected to the Windows Clipboard. 

Rerun SQL 
statements 

Allows you to rerun the selected statements either on the same LPAR or other 
LPAR(s).   

Add SQL 
Statement(s)… 

Displays a window where you can provide your own SQL statements to run on this 
system (and/or other systems.) 

Cancel Cancels the running SQL statement if applicable. 

Remove Selected Removes selected SQL statement entries from the view.   
 
Note: Does not apply to statements that are running, use Cancel instead. 

Remove All Use this menu to remove all SQL statement entries from the view.   
 
Note: Does not apply to statements that are running, use Cancel instead. 

 

2.9 iDoctor Message View 
This interface provides debug and informational messages to the user when it is enabled.   Many different 
types of messages will appear here including those related to SQL statements, IBM i Access Client 
Solutions API calls and more.   
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The amount of detail shown in this view can be increased by using Preferences -> Misc -> Enable debug 
logging to C:\temp and the options for logging SQL statements. 

All QZRCSRVS and QZDASOINIT job commands performed are tracked in this view.  Additional options 
are available by right clicking any of the messages. 

An example of this view is: 

 

iDoctor Message View  

2.9.1 Fields 
Column  Description 

Type Info, Warning or Error based on the severity of the message. 

Time Time of the operation 

System  GUI, REGISTRY or an IBM i system name 

Job Indicates the job on the i that is running or ran this operation if it occurred in the past. 

Message Details about the operation. 

 

2.9.2 Menu options 
Popup Menu  Description 

Display Job Log Shows the job log for the selected system and job.    
Tip: This is the default action if double-clicking a row. 
 
Only applies if a job name is listed. 

Active job options These options let the user view or search job logs, end jobs and more. 
Only applies if a job name is listed. 

Copy Copies all selected rows to the clipboard. 

Copy Message(s) Copies just the Message column for all selected rows to the clipboard. 

Select All Selects all rows. 

Export All This will create a file with the entire contents of the message view. 

Clear Removes everything from the view. 

 

2.10 Objects Pane 
This pane is a bit like the WRKOBJ (Work with Objects) command and is accessible by clicking this 

button  in the toolbar on the Main Window.  When pressing this button, the pane will appear near the 
top of the Main Window.  Pressing the toolbar button again will dismiss the pane.     

Tip: When using the Objects and Libraries folders under IBM i Explorer, this pane appears automatically. 
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It allows you to browse the objects and libraries on an IBM i based on the search criteria of your choice.   

Pressing Search will open and navigate to the IBM i Explorer -> Objects folder if not already looking at it.  
If focus is on the Libraries folder instead, then the results will be shown there when pressing Search. 

 

Objects Pane and Objects Folder example  

Some object types provide additional functionality, and you will be able to drill down further and find more 
details about an object using the Properties menu. 

For example, physical files can be expanded to view the members within them. And the members can be 
opened as a new report in the Data Viewer. 

When clicking the Libraries folder the (library) description column will tell you the number of objects in the 
library matching your filter. 
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Libraries folder showing number of objects matching the filter  

The Filters text box acts like a where clause in an SQL statement and syntax must be correct when used 
or the view will fail to produce data   To determine the available fields, right-click the Objects folder and 
use Select fields… menu.  Some examples can be found using the Help button as well. 
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2.10.1 Interface 
Option Description 

System (IBM i) The name of the IBM i system to perform a search on.  The values in the drop-down 
list is built from the list of systems within the IBM i Connections View. 

Object This can be *ALL (or blank), a specific name, or generic object name. 

Object type This is the type of object and can be *ALL or a specific object type. 

Library This is the library the object is located in and can be *ALL, a specific name or generic 
name. 

Create new results 
view 

Check this box if you want the results to be created in a new view upon clicking 
Search.   
 
Note: Changing the system name will force this checked temporarily. 

Order by This is the sort order for the results based on the most used field names. 
Only applies to the Object folder. 

Filter This is where clause used on the SQL statement to further reduce the results in 
addition to the other values already defined.  If SQL syntax is not correct, the view 
will produce no data. 
 
Examples: 
OBJNAME = 'QAPYJWDFN' 
OBJATTR = 'PF' 
OBJTEXT LIKE '%SQL FUNCTION%' 
OBJOWNER = 'MCCARGAR' 
OBJTYPE IN('*PGM', '*SRVPGM') 
KBSIZE > 1 

Help This shows examples for the Filter textbox. 

Reset This clears all filters, sets them to the IBM shipped default values (QAIDR* files in 
QUSRSYS) and performs a search. 

Search This will perform the search and show results in the Objects folder unless the 
Libraries folder is currently being used. 

2.11 Object lock info Pane 
This pane is like the WRKOBJLCK (Work with Object Locks) command and is accessible by clicking this 

icon  in the toolbar of the Main Window.  It allows you to see the jobs that have locks on the specified 
object and perform actions against those jobs.   When pressing the button, the pane will appear near the 
top of the Main Window.  Pressing the toolbar button again will dismiss the pane.     

Tip: When using the Object Lock Info folder within IBM i Explorer -> Work management, this pane 
appears automatically. 

Pressing Search will open and navigate to the IBM i Explorer -> Work management -> Object lock info 
folder if not already open.  

 

Object Lock Info Pane  

A user can specify the system, object, library as well as the object type to check.  The member name (for 
files) and/or ASP may also be specified.  Clicking search will display the results in a view below the pane.   
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Object lock info folder 

Users can work with these jobs to drill-into them for more information or end them.  

For more information on the options available when working with search results for this pane see the 
Object lock info section. 
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2.11.1 Interface 
Option Description 

System (IBM i) The name of the IBM i system to perform a search on.  The values in the drop-down 
list is built from the list of systems within the IBM i Connections View. 

Object This can be *ALL (or blank), a specific name, or generic object name. 

Object type This is the type of object and can be *ALL or a specific object type. 

Library This is the library the object is in and can be *ALL, a specific name or generic name. 

Create new results 
view 

Check this box if you want the results to be created in a new view upon clicking 
Search.   
 
Note: Changing the system name will force this checked temporarily. 

Filter This is where clause used on the SQL statement to further reduce the results in 
addition to the other values already defined.  If SQL syntax is not correct, the view 
will produce no data. 
 
Examples: 
JOBNBR = '303113' 
JOBUSER = 'FRED' 
JOBNAME LIKE 'QZ%' 

Help This shows examples for the Filter textbox. 

Member This is the member name to use if applicable.   
 
Can be blank, a specific name or generic name. 

ASP This is the ASP device name and should be 1 of these values: 
 
* - The ASPs that are currently part of the thread's library name space will be 
searched to locate the object.  This includes the system ASP (ASP number 1),  
all configured basic user ASPs (ASP numbers 2-32), and, if the thread has an ASP 
group, all independent ASPs in the ASP group.                                 
 
*SYSBAS - The system ASP and all basic user ASPs will be searched to locate the 
object.  No independent ASPs will be searched, even if the thread has an ASP 
group. 
 
Name - The device name of the independent ASP to be searched to locate the 
object.  The independent ASP must have been activated (by varying on the ASP 
device) and have a status of 'Active' or 'Available'.  The system ASP and basic user 
ASPs will not be searched.                

Reset This clears all filters, sets them to the IBM shipped default values (QIDRGUI library) 
and performs a search. 

Search This will perform the search and show results in the Object lock info folder. 

 

2.12 IFS Pane 
This pane is a bit like the WRKLNK (Work with Object Links) command and is accessible by clicking this 

icon  in the toolbar of the Main Window.  It allows you to browse the directories and files in the IFS that 
exist in the location you specify.  When pressing the button, the pane will appear near the top of the Main 
Window.  Pressing the toolbar button again will dismiss the pane.     

Tip: When using the IFS folder within IBM i Explorer, this pane appears automatically. 

Pressing Search will navigate to the IFS folder if not already open and show the results. 
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IFS Pane  

A user can specify the system and the object (IFS path) to search.  Advanced users can use the Filter 
option to perform SQL like filtering to include the SQL statement that runs that produces the results. 

Clicking search will display the results in a new window.   

 

IFS folder 

From this view a user can work with the files and directories shown in several ways.  Files may be 
downloaded or opened/viewed.  You may also upload additional files to the system by right-clicking one 
of the folders and using the Upload… menu. 

See the IFS folder for more information on the options available when working with the results of the IFS 
Pane. 
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2.12.1 Interface 
Option Description 

System (IBM i) The name of the IBM i system to perform a search on.  The values in the drop-down 
list is built from the list of systems within the IBM i Connections View. 

Object This is the IFS path and/or specific file name to use as the filter.   
 
Note: This does not support values like *.txt. 

Create new results 
view 

Check this box if you want the results to be created in a new view upon clicking 
Search.   
 
Note: Changing the system name will force this checked temporarily. 

Filter This is where clause used on the SQL statement to further reduce the results in 
addition to the other values already defined.  If SQL syntax is not correct, the view 
will produce no data. 
 
Examples: 
PATH2 LIKE '%6671D6%' 
DATA_SIZE > 1024 
OBJECT_TYPE = '*DIR'  
OBJECT_TYPE = '*DIR' AND UPPER(PATH2) LIKE '%6671D6%'  
OBJECT_TYPE <> '*DIR' AND UPPER(PATH2) LIKE '%AAAAF%' 
TEXT_DESCRIPTION LIKE '%test%' 

Help This shows examples for the Filter textbox. 

Reset This clears all filters, sets them to the IBM shipped default values (root folder /) and 
performs a search. 

Search This will perform the search and show results in the IFS folder. 

 

2.13 Active Jobs Pane 
This pane is like the interface for WRKACTJOB to show the active jobs on the system but also provides 
the capability to view the job logs or spool files for jobs that have ended.  For active jobs you can view the 
threads within each job and the call stacks for each thread.   Options are also available to kick off 
performance collections or define definitions based on the selected active jobs.  

The interface is accessible by clicking this icon  in the toolbar of the Main Window or in a Data Viewer.   

 

Active jobs Pane Example 

Results are shown in either the Main Window or Data Viewer.  If a graph is desired, then the results are 
required to be shown in the Data Viewer. 
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Active jobs folder in the Main Window 

Tip: This interface collects performance statistics for active jobs only.  Each refresh or press of the search 
button will update these metrics.  To reset the performance statistics counters then right-click the Active 
jobs folder and use the Reset Statistics menu option. 

For more information on working with the jobs shown in search results, see the Active jobs folder. 

2.13.1 Interface  

 



IBM iDoctor for IBM i  

Option Description 

System (IBM i) The name of the IBM i system to perform a search on.  The values in the drop-down 
list is built from the list of systems within the IBM i Connections View. 

Name This is the job name or generic job name or *ALL to perform the search on.   

User This is the user name or generic user name (or *ALL) to use when performing the 
search.    

Number The exact 6-digit job number to include in the results or blank (or *ALL) for all. 

Current User The exact current user profile to include in the results or blank (or *ALL) for all. 
 
Note:  This option only appears if the Job Status drop down value is *ACTIVE. 

Job Status This option allows you to indicate the types of jobs to include in the results based on 
their status.  The option used effects the columns returned in the list.  
 
*ACTIVE – Only active jobs are returned.  This will include some performance 
metrics. 
*ALL – All jobs, active or not will be returned in the list.   
*JOBQ – Only jobs waiting on a job queue will be shown in the list. 
*OUTQ – Only completed jobs containing spool file output are shown.  You can 
expand these jobs to view these spool files. 

Active Status This indicates the type of active job status to further filter the results.  You can pick 
one and only of these types in the list.   
 
For more information see the help text for the WRKACTJOB command’s Status 
column. 
 
Note: This option will only appear if Job Status is *ACTIVE or *ALL. 

Min CPU % This is the desired minimum CPU % to use for filtering the results in the list.  Only 
jobs having a “CPU %” column value greater than or equal to this number will be 
shown. 
 
Note:  This option only appears if the Job Status drop down value is *ACTIVE. 

Min Disk IO This is the desired minimum Disk IO value to use for filtering the results in the list.  
Only jobs having a “Disk IO” column greater than or equal to this number will be 
shown. 
 
Note:  This option only appears if the Job Status drop down value is *ACTIVE. 

Subsystem This is the subsystem name to use to filter the results by. 
 
Note:  This option only appears if the Job Status drop down value is *ACTIVE. 

Open in Data 
Viewer 

Check this box if you want to see results as an SQL report in the Data Viewer instead 
of the default under Work management -> Active jobs in the Main Window. 

Create new results 
view 

Check this box if you want the results to be created in a new view upon clicking 
Search.   
 
Note: Changing the system name will force this checked temporarily. 

Perspective This setting controls the information displayed in the results. 
These options are available: 
- Basic 
- Detailed 
- CPU 
- IOs 
- Interactive 
- Temp storage 
- Locks 
- SQL (all) 
- SQL client 
- SQL cursor  
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- SQL server 
- Advanced 
- JVM 

SQL statement 
contains 

For some types of perspectives, this option lets you filter the results based on 
something matching in the SQL statement captured. 

Graph The results can be graphed in the Data Viewer if desired.  The graphs available will 
vary based on the Perspective. 
 

Count This indicates if an extra SQL statement will be ran to count the number of jobs 
returned in the results.  If this is done the results will take longer to appear, but the 
scrollbar showing the number of jobs will be accurate.  In some cases, especially at 
older releases and/or when job status is set to *OUTQ, the results can take a while to 
return due to limitations in IBM i SQL Services so this option can help in those 
situations.   

Reset This clears all filters, sets them to the IBM shipped default values (QZD* active jobs) 
and performs a search. 

Search This will perform the job search based on the filters given on this pane. 
 
If job status is *ACTIVE then clicking this button multiple times will update the 
performance statistics each time the button is pressed. 

 

2.14 User Profiles Pane 
This pane is an interface for the WRKUSRPRF (Work with User Profiles) command and is accessible by 

clicking this icon in the toolbar of the Main Window.  It allows you to browse the user profiles that 
exist on the IBM i and make some modifications as needed.   When pressing the button, the pane will 
appear near the top of the Main Window.  Pressing the toolbar button again will dismiss the pane.     

Tip: When using the User Profiles folder under System, this pane appears automatically. 

 

After specifying the system name and user name criteria, clicking search will display the results in the 
User Profiles folder under System. 
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From this view an administrator may create additional user profiles, change, delete or copy user profiles.  
Right-click a user profile for more options. 

2.14.1 Interface 
Option Description 

System (IBM i) The name of the IBM i system to perform a search on.  The values in the drop-down 
list is built from the list of systems within the IBM i Connections View. 

Create new results 
view 

Check this box if you want the results to be created in a new view upon clicking 
Search.   
 
Note: Changing the system name will force this checked temporarily. 

User This is the user name or generic user name (or *ALL) to use when performing the 
search.    

Filter This is where clause used on the SQL statement to further reduce the results in 
addition to the other values already defined.  If SQL syntax is not correct, the view 
will produce no data. 
 
Tip: Right-click the User Profiles folder and use the Select fields… menu to see the 
possible field names. 
 
Examples: 
AUTHORIZATION_NAME = 'QSECOFR' 
SIGN_ON_ATTEMPTS_NOT_VALID > 0 

Help This shows examples for the Filter textbox. 

 

2.15 Output Queues Pane 
This pane is an interface for the WRKOUTQ (Work with Output queues) command and is accessible by 

clicking this icon in the toolbar of the Main Window.  It allows you to view the output queues that exist 
on the IBM i.   When pressing the button, the pane will appear near the top of the Main Window.  Pressing 
the toolbar button again will dismiss the pane.     

Tip: When using the Output Queues folder under Work management, this pane appears automatically. 
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After specifying the system name and the desired filters, clicking search will display the results in the IBM 
i Explorer -> Work management -> Output queues folder below the pane. 

 

From this view, the user may double-click an output queue to view the spool files within it. 
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2.15.1 Interface 
Option Description 

System (IBM i) The name of the IBM i system to perform a search on.  The values in the drop-down 
list is built from the list of systems within the IBM i Connections View. 

Create new results 
view 

Check this box if you want the results to be created in a new view upon clicking 
Search.   
 
Note: Changing the system name will force this checked temporarily. 

Output queue The name of the output queue.  This can be *ALL a specific name or a generic name. 

Library The name of the output queue library.  This can be *ALL a specific name or a generic 
name. 

Reset This clears all filters, sets them to the IBM shipped default values (*ALL output 
queues) and performs a search. 

Search This will perform the search based on the filters given on this pane and show the 
results in the Output queues folder. 

 

2.16 Spool Files Pane 
This pane is an interface for the WRKSPLF (Work with Spool Files) command and is accessible by 

clicking this icon  in the toolbar of the Main Window.  It allows you to view the spool files that exist on 
the IBM i matching the filters you provide.   When pressing the button, the pane will appear near the top 
of the Main Window.  Pressing the toolbar button again will dismiss the pane.     

Tip: When using the Spool files folder under Work management, this pane appears automatically. 

After specifying the system name and the desired filters, clicking search will display the results in the 
Spool files folder within Work management.  
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From this view, the user may view spool files, download them as PDFs and view them on the PC.   

See the Spool files section for more information.  
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2.16.1 Interface 
Option Description 

System (IBM i) The name of the IBM i system to perform a search on.  The values in the drop-down 
list is built from the list of systems within the IBM i Connections View. 

Output queue The name of the output queue.  This can be *ALL or a specific name or generic 
name. 

User name The user name that created the spool file.   
This can be *CURRENT, *ALL, or a specific name or a generic name 

User data  This a user defined data tab associated with the spool file.  Often this will be a job 
name.  This can be *ALL or a specific name or generic name. 

Library The name of the output queue library.  This can be *ALL, a specific name or generic 
name. 

Create new results 
view 

Check this box if you want the results to be created in a new view upon clicking 
Search.   
 
Note: Changing the system name will force this checked temporarily. 

Last 24 hours If checked, this option is used to reduce the results to show spool files created within 
the last 24 hours only. 

Job name The job name that created the spool file.  This can be *ALL or a specific name or 
generic name. 

Job user The job user that created the spool file.  This can be *ALL or a specific name or 
generic name. 

Job number The job number that created the spool file.  This can be *ALL or a specific name or 
generic name. 

Spool file The name of the spool file.  This can be *ALL or a specific name or generic name. 

Reset This clears all filters, sets them to the IBM shipped default values and performs a 
search. 

Search This will perform the search based on the filters given on this pane and show the 
results in the Spool files folder. 

 

2.17 Tables Pane 
This pane allows you to browse the IBM i physical files, logical files and/or SQL tables that exist on the 

system.  Click the  icon in the toolbar of the Main Window to display the pane near the top of the 
Main Window.  Pressing the toolbar button again will dismiss the pane.     

Tip: When using the Tables folder under IBM i Explorer, this pane appears automatically. 

 

A user may specify the system, library, and generic table name to search.  The type of objects returned 
may also be specified (SQL tables, physical files, logical files, aliases, or views.)  

After specifying the system name and the desired filters, clicking search will display the results in the 
Tables folder. 
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2.17.1 Interface 
Option Description 

System (IBM i) The name of the IBM i system to perform a search on.  The values in the drop-down 
list is built from the list of systems within the IBM i Connections View. 

Library name This is the library name to look for tables name.  This can be *ALL or blank to search 
all libraries or a specific name or generic library name. 

File/table name This is a specific name, generic name or *ALL/blank for the table name. 

Create new results 
view 

Check this box if you want the results to be created in a new view upon clicking 
Search.   
 
Note: Changing the system name will force this checked temporarily. 

SQL tables Check the box to include these. 

Physical files Check the box to include these. 

Logical files Check the box to include these. 

Aliases Check the box to include these. 

Views Check the box to include these. 

Reset This clears all filters, sets them to the IBM shipped default values and performs a 
search. 

Search This will perform the search based on the filters given on this pane and show the 
results in the Tables folder. 

 

2.18 Graphs Pane 
This pane allows you to browse or search the iDoctor report databases for graphs or reports of interest.  
This provides information such as the folder in which the graph or report is located, the VRMs of IBM i 
where the report will exist as well as any required files or PTFs needed for the report to appear. 

Click the  icon in the toolbar of the Main Window to display the pane near the top of the Main 
Window.  Pressing the toolbar button again will dismiss the pane.     

 

Graph Search Pane Example 

A user may specify the report name filter, the VRM or specify something to look for in an SQL statement 
like a filename.  You can also specify options such as which components to search.    

Clicking search will display the results either in a new window or an existing one depending on if the 
“create new results view” checkbox is checked. 

2.18.1 Interface 
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Option Description 

Report name 
contains 

This is a substring to use when searching for a report or graph name. 

VRM The numeric IBM i OS VRM such as 710, 720, 740, etc. 

Category Within the iDoctor .mdb databases is a SQRYCAT field containing a 3-character 
identifier for the location within iDoctor that the graph or report appears in.  One of 
these values can be entered into this field to filter on this column. 
 
- SUM - Graphs and tables under the collection. 
- CPS – Collection Services Investigator - Graph History graphs 
- DDG – Collection Services Investigator – disk graphs over time 
- EDG – Collection Services Investigator – external storage disk graphs over time 
- JB* – Job Summary (JW, CSI) 
- JSM – Job Summary (JW, CSI) 
- JFB – Collection search browse options (JW, PC, CSI) 
- JFD – Collection search results (JW, PC, CSI) 
- ODF – Job statistics selection over time (flattened) 
- ODG – Job statistics selection over time 
- COL – These are either iDoctor collection properties SQL statements or used in 

Interval Details, or Interval Summary interfaces 
- DTL – Detail reports drill down tables 
- CS1 – Job Watcher call stack search  
- ASM – PEX Netsize related reports 
- DT* – PEX selection over time graphs and reports 
- SRC - Collection search examples 
- XXX – PEX Taskswitch 

SQL contains Use this to only show reports whose SQL statement contains something specific 
(such as a filename.) 

Category SUM only This will only show reports that have SUM for the category value. 

Graphs Check this box to include graphs in the output. 

Reports  Check this box to have table reports included in the output. 

JW If checked, then Job Watcher reports are included in the results. 

CSI If checked, then Collection Services Investigator reports are included in the results. 

PEX If checked, then PEX Analyzer reports are included in the results. 

Hidden ONLY Some reports have been removed from IDoctor.  This option lets you view their 
information if they still exist.  If you want them restored, contact iDoctor support. 

DW If checked, then Disk Watcher reports are included in the results. 

PC If checked, then Plan Cache Analyzer reports are included in the results. 

2.18.2 Graph Search Folder 

An example of graph search folder is shown below: 

 

This list includes the following columns described in the table below: 
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Column Description 

Location Indicates where in iDoctor you can find this graph or report.   The location description 
maps to a category and component.   
For example, category “CPS” is location “CS Graph History”. 
 
In some cases, graphs or reports are only found by drilling down from another graph 
and this will be noted here if this is required. 

Hide An X in this column means the report is hidden from view. 
 
Note: This can’t be modified by the user. 

Report name The graph or report name 

Folder The folder name and sometimes sub folder as well to find this graph or report in. 

Min VRM The minimum IBM i release in nnn format such as 710, 720, 730, etc where this 
report will appear.   

Max VRM The maximum IBM i release in nnn format this report should appear at. 
Use a value of 0 if no max. 

Tables needed A list of critical tables needed for the graph or report to appear.  The core files of the 
component are also needed but not included here for simplicity. 

Analyses required This column indicates if any iDoctor analyses must be ran before this graph or report 
will appear. 

Category Identifies the folder within the component that this graph or report appears in (within 
the .mdb iDoctor databases such as iDocCS.mdb.)   See the QAIDRCATS table 
within the .mdb file.  

Sub-category Identifies the sub folder within the component that this graph or report appears in 
(within the .mdb iDoctor databases such as iDocCS.mdb) 

Graph ID Identifies the unique identifier for this graph within table QAIDRGPH in the iDoctor 
reports database. 

SQL ID Identifies the unique identifier for the SQL statement behind this report in table 
QAIDRSQL in the iDoctor reports database. 

SQRYVER This internal identifier is used to tell the GUI which file(s) are needed in order for this 
graph or report to appear.   

Double-click a report in this list will display additional Properties.  Because these are iDoctor-defined 
reports, the properties are read-only. 

2.19 Find Window 
This window is shown whenever a user does a Find operation on an active list or table view. 

Use the Edit -> Find menu (or Ctrl+F) to show this option. 

 

Find Window 

After providing a search term to look for you can close the window and use the Edit -> Find Next (F3) or 
Edit -> Find Previous (Shift+F3) menu to look for the next/previous occurrences without needing to have 
this window visible. 
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2.20 Set Font 
Another feature of iDoctor is the ability to customize the font used in many of the interfaces.  The Set Font 
dialog provides the user with this flexibility.  To change the font, use the Edit->Set Font menu from the 
Main Window or Data Viewer (or right-click on an active Table View and use the Set Font... menu).    
 

 
Font window  
 
This window is also accessible in Preferences -> Display – Advanced at the bottom and there are two 
types of interfaces that can have different fonts: 
 

 



IBM iDoctor for IBM i  

Preferences -> Display – Advanced 

Note: The set font window when used from the main window or toolbar button will change the font based 
on the view currently open and with focus (either lists/trees or the font for editors/logs) 

 

2.21 Wait Bucket Preferences 
The Wait Bucket Preferences window allows a user to work with desired colors and patterns to use when 
graphing the wait buckets in iDoctor.  The Wait Bucket Preferences are accessible via the Edit -> Wait 
Bucket Preferences menu from the iDoctor Main Window.   
 
Note:  Any changes made to this interface will not immediately take effect on already open graphs.  You 
must first refresh the list of collections within the desired collection library and then open the desired 
graph to see any changes made to the Wait Bucket Preferences. 
 
See the next sections for information on each page in this interface. 
  

2.21.1 Colors 
The Colors page allows the user to change the default colors for any desired wait bucket.  In some cases, 
the wait bucket description only applies to a specific OS VRM and this VRM is listed in the 1st column.   
 
This panel also allows a user to specify the pattern to use if the Display patterns preference is enabled. 
 
An example of this interface is shown below: 
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The options available on this page are summarized below: 
 

Options Description 

Color… button Allows you to modify the color for the selected wait bucket. 

Pattern… 
button 

Allows you to modify the pattern/hatching for the selected wait bucket.   
 
Note: These are only visible if the Preferences -> Display – Patterns checkbox is 
checked. 

Restore button This button will discard any changes made to the wait bucket colors, patterns and waits 
of interest.  The IBM-supplied defaults will be used. 

List of buckets List of wait buckets and the VRM, color and pattern that currently applies to it. 

 

2.21.2 Waits of Interest 
The Waits of Interest page lets you pick which wait buckets to display on the wait bucket graphs in 
iDoctor.  It’s important to only add wait buckets that will be helpful in solving performance problems.  
Therefore, it is unwise to add wait buckets to the list where jobs are frequently spending most of their time 
idle.  
 
An example of this interface is shown below: 
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Note: Keep in mind that not all of these waits will be displayed in the graph’s legend, because the graph 
legend (in the Y-axis) only contains buckets that experienced values greater than zero. 
 

2.22 Set User-Defined Reports Database 
This window allows the user to specify the database where iDoctor user-defined graphs and tables are 
located.  This allows for multiple users to potentially access the same user-defined reports. 
 
The database used can be either an IBM i library or an MS Access database file residing on the PC or a 
shared network drive.   
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Set User-Defined Reports Database window with a local database selected 

 

 

Set User-Defined Reports Database with an IBM i library selected 

 

The easiest way to share your reports with other users is to use the same library on a shared IBM i.  If all 
users configure their Set User-Defined Reports database, then those users will be able to share the same 
reports that they create with iDoctor. 

 
When the window is first opened the current setting for the user-defined reports DB will be shown.   
 
If using an IBM i library as the database, these are the tables that will exist on the library making up the 
database.   
 
COLUM00001   - This is the COLUMNDESCS SQL table which is typically named COLUM0001. 
QAIDRCATS    - This defines the folders 
QAIDRGPH       - Graph definitions 
QAIDRRGEN    - Report generator lists 
QAIDRSQL       - SQL statements (for graphs and/or reports) 
 
You can move these tables to other libraries/systems to backup or reuse them as needed. 
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2.23 Window Manager 

The Window Manager is an option found by pressing the  button on the Main Window or Data 
Viewer toolbars.  The window allows a user to see a list of all windows (or views) open and to pick the 
desired one to activate.  

 

Tip:  You can double-click a window in the list to activate it.  

 

Window Manager 

2.24 Set default time grouping (clock icon) 
The clock icon on the Main Window toolbar allows a user to modify the default time grouping on all 
iDoctor time-based graphs.  Many groupings are available and make it easier to get a summarized view 
over larger volumes of data.  It is often not feasible to scroll through many pages of data or try to graph 
thousands of points on a single screen. 

 

To enable this option, press this  button and a list of options will be shown.  Picking the desired 
grouping will change the current default value for the time interval size.   The current default setting will be 
shown in bold font. 
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Clock icon menu  

Note:  This same preference may also be set using the Preferences -> Display -> Default time 
grouping setting. 

 

Preferences -> Display -> Default time grouping 

2.25 SQL Tables  
The SQL tables folder in iDoctor is used to manage and work with the SQL tables generated by iDoctor 
analyses.  This view organizes each type of SQL table into its own folder called "Analysis Output".  This 
allows the user to more easily merge, graph and compare results from these tables by selecting the ones 
of the same type across different libraries and collections. 
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Some analyses such as the Collection Summary, generate more than one SQL table.  In those cases, 
you may see an Analysis Output folder for each SQL table generated by the analysis. 

The SQL tables interface is also available under each library shown, and under each collection.  This 
filters down the SQL tables to only include those in the current library (and/or collection.) 

2.25.1 Analysis Output 

Within each analysis output folder will be a list of SQL tables found on the system that match the output 
folder you are working with.   

 

Double-click a table to view it.   

Right-clicking one or more SQL tables shows the following menu options: 

Menu Description 

Open Table(s) Opens the desired SQL tables in the Data Viewer. 

Record Quick View Lists the information about the selected SQL tables vertically in a new window. 

Open merged table This option will be a report that combines all the selected table's data into 1 report.  
The data is simply UNIONed together and is not summarized. 

Create merged 
table… 

This option allows you to build a new table from the contents of all selected tables.  
You will be prompted for the name and library for the new table. 

Edit comment This option allows the user to modify the comment for the given SQL table. 

Delete This option lets the user delete the selected SQL table(s). 

Properties Displays property information for the SQL table. 
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2.25.2 Deleting 

The SQL tables can be cleaned up (deleted) if desired by right-clicking the selected analysis output 
folders and using the Delete... menu.   You can also select multiple folders when doing this action if 
desired. 

 

Tip: To delete all iDoctor created SQL tables on a system, right-click the SQL tables folder itself under the 
Root Folder and use the Delete… option. 
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3 Component Views 

Component views are the primary means of working with any of the iDoctor components.  You can have 
as many component views open within a Main Window as desired. 
 

 
Job Watcher Component View 
 
Component views look and feel consistently across the various components.  The tree represents the 
hierarchy of options available within the component you are using.   
Under the libraries folder, you will find all libraries on the system that contain data for the component you 
are working with.  Under libraries you can find collections, and the reporting options available within.  
Your current selection in the tree is always displayed in the list portion of the tree/list. 
 
Tip: Because of the tendency to deal with large amounts of data and a desire to have the client perform 
optimally (reduce network traffic, etc.), refresh has been implemented in a way unlike most other 

applications.  The refresh toolbar button   or menu will refresh only the contents of the selected tree 
branch.  For example, if a library is selected in the tree, only the contents of the library will be refreshed, 
not the list of libraries in the tree.  Refreshing the list of libraries would require selecting the folder above 
the list of libraries (typically the Libraries folder.) 
 

3.1 Menu Options 
The menu options for an IDoctor component includes: 
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Menu  Description 

Explore This expands the component and shows the available options. 

Active Data The Active data menu provides the ability to access commonly used graphs or other 
functions for the currently running Job Watcher monitor collection or Collection 
Services collection. 

Open Knowledge 
Base 

This opens the Knowledge Base component on whatever system in the list of IBM I 
connections defined as the default system (with a checkmark icon next to it.)  This is 
a repository for storing your notes about performance data captured in iDoctor. 

Open new Data 
Viewer 

Opens an empty Data Viewer. 

Find Collections… This option displays the Find Collections interface which provides the ability to look 
for collections matching user-defined characteristics.  Example SQL statements are 
provided.  
 
The results of these queries are available under the IBM i Explorer -> Find 
collections results folder. 

Set User-Defined 
Reports Database 

This option allows a user to load/use another user’s iDoctor user-defined 
reports/graphs that they have previously created.  When saving user-defined reports 
these are saved into the specified database.  This can either be an IBM i library or a 
local database on the PC (MDB file).   
 
To find the current user-defined reports DB settings, either use this menu option or 
see the application properties (Help -> About menu) and then look for the “User-
defined reports DB” location.  

Clear GUI Cache This option deletes most temporary data loaded in the GUI’s memory.  This includes 
things like preferences, column orderings, reports and graph definitions, stored 
procedure information and more. 

Work with iDoctor 
scheduled jobs 

This option will navigate to the Work management -> Scheduled jobs folder under 
IBM i Explorer. 

Collections 
Database 

These functions allow you to work with the Collections Database which is used to 
keep track of collections on the system. 

Properties Displays basic information about the component including build level information. 

Note: Additional options will also appear but are discussed in the documentation for the component you 
are working with. 

3.2 Active Data  
These options allow you to work with the currently running Job Watcher collection if using STRJWMON 
to collect data or the current Collection Services collection if CS is active. 

Note: These options will fail with an error if JW and/or CS is not running. 

The Active data menu options will vary if currently using Job Watcher or Collection Services Investigator 
and shows the options for the current component being used first. 

 

https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_JW.pdf
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_CSI.pdf
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If not using either, then a Job Watcher or Collection Services submenu appears with each set of identical 
options. 

 

Tip: These functions are described in more detail in the documentation for Job Watcher or Collection 
Services Investigator. 

 

Menu  Description 

Collection overview 
time signature 

This option will open the Collection overview time signature graph for the actively 
running collection in either JW or CSI. 

Dispatched CPU 
rankings by thread 

This option will graph the jobs in the currently active collection showing the ones 
using the most CPU first. 

Graph Job(s) The Graph jobs function is used to select a job from the currently active collection 
and then pick and graph from any graph available the job’s data over time.  See the 
documentation for Job Watcher or Collection Services Investigator for more details. 

Search The Search function is used to find something of interest in the currently active JW 
or CS collection. 

General reports This function is used to produce a report by choosing which graphs or reports to run 
against the active collection and then a single HTML or PDF output file is created. 

 

3.3 Properties 
The Properties for the component have a similar interface for each of the iDoctor components.  This 
interface contains high-level configuration settings such as: the build levels, configuring iDoctor job run 
priorities or listing any missing PTFs.  Access this interface by right-clicking the component icon (root 
folder) and using the Properties menu. 

https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_JW.pdf
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_CSI.pdf
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_CSI.pdf


IBM iDoctor for IBM i  

 

3.3.1 General 
An example of the General property page for Job Watcher is shown below: 
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3.3.1.1 Interface 

The following information is supplied within the General tab of this window: 
 

Client Version 
Information 

Description 

Client Cnnnnn The client build number installed is listed near the top of this window. 

Build timestamp The date/time the build was produced.   

IBM i access The installed VRM and service pack level for IBM i Access Client Solutions with the 
windows application package! 

.NET version The version of .NET installed.  If not updated to the required levels, then some of the 
FTP functions will not work. 

Java version Information about the level of Java installed.  If not installed, then the user will be 
unable to use the SSH connections required in the Power Connections component. 

iDoctor exe location The directory and filename for the iDoctor GUI application. 

iDoctor temp 
directory 

The directory where temp files and some log files created by iDoctor are stored. 

iDoctor application 
data directory 

Files needed by iDoctor are stored in this directory.   

User-defined 
reports DB 

This value displays the location of the user-defined reports database.   

Copy Info This option will copy the data on this window to the clipboard as text. 

System Info This option will display the Windows System Information utility. 

iDoctor GUI install 
history 

A list of all iDoctor builds installed on the PC.  This can be used to tell which build 
level was previously installed.  This information is only removed if the user presses 
the Wipe install info button. 

Wipe install info This will remove information from the Windows registry that provides the iDoctor GUI 
install history. 

Report problem This will open the default email program on the PC to send an email to 
idoctor@us.ibm.com for support purposes.  This provides debug information 
automatically in the email generated and is recommended! 

 
 

Server Version 
Information 

Description 

LPAR name The system that the current component view is connected to. 

IBM i The version and release of IBM i on the system. 

Type-model The type and model of the system. 

Processor Group The processor group of the system. 

Build  Build number of this component installed on the server side. 
 
Note: We now prefer to reference server builds by date instead of build number when 
contacting support. 

Build timestamp The date/time the server build was produced.  This value is shown in yyyy-mm-dd-
hh.mm.ss format. 

PEX access code The last PEX Analyzer access code applied on this system. 

JW access code The last Job Watcher access code applied on this system. 

PTF levels This lists information about the JW PTFs installed (if working with Job Watcher), or 
the PEX PTFs installed (if working with PEX Analyzer). 

Stored procedure 
versions 

This provides a list of iDoctor stored procedures and their versions installed in the 
QIDRGUI library. 

 

3.3.2 iDoctor Client Jobs 
The following is an example of the iDoctor Client Jobs interface: 
 

mailto:idoctor@us.ibm.com
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Job Watcher Properties – iDoctor Client Jobs  
 
This page lets you set the run priority and CPU time slice of all iDoctor client jobs.  You can increase the 
run priority of the jobs that execute SQL statements that perform real-time analysis using the iDoctor GUI.  
This should only be set by advanced users and does require that the user profile you are connecting to 
the system with has *JOBCTL special authority.  You must shut down the client and restart for any 
changes made on this screen to take effect. 

3.3.2.1 Interface 

 

Client job settings Description 

Run priority Effects the run priority of all QZDASOINIT and QZRCSRVS jobs created by the 
iDoctor GUI. 
After the connections are started, the client will attempt to issue a CHGJOB 
command to adjust its run priority. 

CPU time slice Specifies the maximum amount of processor time (in milliseconds) given to each 
thread in the job before other jobs on the system are given an opportunity to run.   

CCSID The CCSID the job(s) should run under.  Typically this should be set to 37 for best 
results.   

Log CL commands Indicates if CL commands should be logged to the job log or not (when possible.) 

Remove libraries 
above QSYS in the 
library list 

Use this option if you have other libraries above QSYS that have unexpected 
implementation of IBM i commands causing the GUI functions to fail.  This option 
requires *ALLOBJ authority. 

 

3.3.3 Server configuration 
The following is an example of the Server configuration page. 
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Job Watcher Properties – Server configuration  
 
The subsystem and job queue used for batch jobs created by iDoctor is shown on this page.    
 
If any of the required PTFs are not installed, they will be listed on this screen at the bottom.  It’s not 
recommended to run collections until these PTFs are installed. 
  
The default run priorities used when running collections and analyzing collections are shown and may be 
modified if desired from this page.     
 
Note: The analyzing collections value only applies when running the analyses in batch instead of a 
QZDASOINIT client job.  Use the iDoctor client jobs tab to affect the priority of the analysis process at 
those releases. 

3.4 Field Selection Window 
The Field Selection Window is a generic way to work with the fields shown in the list portion of a tree/list 
view.  This window is available via the 'Select fields...' menu from any objects that has field selection 
enabled.  Not all folders in the tree have field selection enabled. 
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Field Selection Window 
 
Any changes you make are saved to your PC's registry and reused the next time you open the view you 
are working with.  To restore to the iDoctor-ship default ordering click the "Default" button.  The "Toggle 
Selected" button is a fast way to toggle the show checkbox for several selected fields in the list at once.  
To select multiples, hold down the ctrl or shift key while clicking your mouse on entries in the list. 
 

3.4.1 Interface 
Option Description 

First field Lists the first field in the list.  It cannot be removed or changed. 

Default button Discards all changes and reorders the list of fields to the IBM-shipped defaults. 

Toggle Selected 
button 

Hides or shows the selected fields in the list by toggling the checkbox. 

Additional fields list List of available fields to include.  You can press the space bar or click the Toggle 
Selected button to check/uncheck the box for the selected fields. 
Use drag and drop to reorder the fields in the list. 

 

3.5 Libraries Folder 
Most components in iDoctor contain the Libraries folder.  This folder displays all libraries on the system 
that contain applicable data for the component you are working with.   
 
Use the Filter Libraries Pane at the top of the interface to control which libraries appear in the listing.  
Several options are available to filter by partition name, library name or library description. 
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3.5.1 Filter Libraries Pane 

This interface automatically appears whenever working with the Libraries folder to control filtering of the 
data shown.   

 

Tip: All values will accept blank as an alternative to using *ALL or use the Reset button to clear all filters. 

This interface will appear automatically when using most folders in iDoctor that either lists libraries or offer 
library filtering except for the IBM i Explorer -> Libraries folder.  

3.5.1.1 Interface 

The options on this pane are described below: 

Option Description 

System This is the system you are currently working with.  You can change this value to 
another, but then a new results view will need to be used when pressing Search. 

Component This is a way to switch from one component to another, but when doing so, a new 
results view will be used to show the results. 

Libraries This is a library name filter that is either *ALL or a comma separated list of library 
names and/or generic library names.  Press the … button to use that filter and open 
the Browse Libraries window to see all libraries on the system matching the filter 
supplied. 

Create new results 
view 

This indicates if a new view is launched each time a Search is performed.  
Changing the System or Component will force this to be checked temporarily. 

Description contains This is a case sensitive filter against the library description. 

Owner This is a filter on the owner of the *FILE object used to perform the search.  In CSI, 
this is QAPMCONF.  In JW it is QAPYJWRUNI, DW is QAPYDWRUNI and PEX is 
QAYPERUNI.  The value can be *ALL, a specific name, or a generic name. 

Partition collected on This is a filter on the partition name where the data was collected.  The value can be 
*ALL, a specific name, or a generic name. 

Reset Clears all filters and refreshes the listing to show all libraries. 

Search Uses the current filters to rebuild the Libraries folder. 

3.5.1.2 Browse Libraries 

This window shows all libraries matching the libraries filter provided on the pane.  This may include 
libraries that do not have any data for the component you are working with. 
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Interface 

Option Description 

Library name filter This is the Libraries filter provided from the Filter Libraries pane or you can change 
it here. 

Apply Press this button to update the list of libraries matching the filter. 

Libraries matching 
the filter. 

You can select a library to modify its description using the text box at the bottom 
and Update button.  Or select up to 25 libraries and press OK to display those 
libraries in the GUI (if they also contain performance data for the component you are 
using). 

Description This text box allows the library description to be modified. 

Update Use this to update a library description for the one selected in the list. 

 

3.5.2 Menu Options 
The Libraries folder (when right-clicked) provides the following menu options: 
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Menu  Description 

Find Collections… This option displays the Find Collections interface which provides the ability to look 
for collections matching user-defined characteristics.  Example SQL statements are 
provided.  
 
The results of these queries are available under the IBM i Explorer -> Find 
collections results folder. 

Select fields… This option allows you to modify the columns shown in this folder.  

Upload… This allows data to be sent to the IBM i (typically a SAVF containing performance 
data.) 

 

3.5.3 Fields 

This section discusses the columns shown within the Libraries folder.   

The columns with a (*) are shown by default.  The other columns can be added by right-clicking the 
Libraries folder and using the Select Fields… menu. 

Tip: If many fields are shown blank, then the collections database should be refreshed using the 
Collections database -> Refresh all menu from the root folder in the component view interface.  This 
database is cleared after each reinstall of the server builds.   
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Field Description 

Library name (*) Library that contains performance data matching the component you are using. 

Description (*) Library description 

Owner (*) Note: This is the owner of the table being searched (i.e. QAPMCONF for CS, or 
QAPYJWRUNI for JW) and not the library *LIB object in QSYS. 

Collections (*) Number of collections in the library (as of last refresh.) 

Collection types (*) This is a comma separated list of collection types found in the library. 
 
JW – Job Watcher 
CS – Collection Services 
DW – Disk Watcher 
PA - PEX 

Partition collected on 
VRM (*) 

The VRM of the system where the data was captured.  

Partition collected on 
(*) 

The name of the system where the data was captured.  This is a max value and if 
data exists from multiple libraries, then only the 1 value is shown. 

Start time (*) The start time of the oldest collection in the library. 

End time (*) The end time of the newest collection in the library. 

Collection desc 
(max) (*) 

The max collection description value from the list of collections in the library. 

Collection status 
(max) (*) 

The max status from the list of collections in the library.  This indicates if any critical 
data is missing, and putting your mouse of a value in this column will shown if any 
non-critical files are also missing. 

Data ready (max) (*) This column indicates which types of data has been captured and in some cases it 
indicates which iDoctor analyses have been ran.  For more information about the 
values shown, use a flyover which will translate the codes into a more meaningful 
description. 

 
ASP (*) This identifies the ASP information applicable for each library. 

Created by The user profile that originally created the library. 

 

3.6 Library Folders 
Each library folder in iDoctor has a set of common menu options available which are described in more 
detail in this section. 



IBM iDoctor for IBM i  

3.6.1 Menu Options 

 
Library menu in Job Watcher 
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Menu Description 

Explore Show the collections within the library. 

Find Collections… Displays the Find Collections interface and presets the library filter to match the 
current one. 

Analyses Provides a list of analyses you can run against all collections in the selected 
libraries.   
 
Note: In some cases, this will show analyses that do not apply to the data found in 
the library and won’t produce usable data. 

Select fields... Displays the Field Selection Window.  This allows you to configure and reorder the 
fields that are displayed when showing the list of collections within a library. 

Download… This is used to save the selected library to a save file then download it to the PC. 

Upload… This option is used to upload a save file to a library.  

Copy URL Creates a reusable URL to the component and library.   

Copy... Allows you to copy the library's contents into a new library or into an existing one.   

Save... This option lets you save the library's contents into a save file on the server. 

Transfer to an IBM 
i... 

Allows a user to transfer one or more libraries to another IBM i. 

Clear This option clears a library (deletes all objects in the library). 

Clear Server Cache This option clears the iDoctor cache that keeps track of collections.  It is sometimes 
helpful to use this if the collections show incorrect status information such as 
missing files or analyses data is not being displayed correctly. 

Delete Deletes the library. 

Rename Renames the library. 

Locks This provides options to view the jobs locking the library or all object locks in the 
library. 

Properties Displays the property pages for the library. 

 
Depending on the component, library folders may have additional options. 

3.6.2 Find Collections 

This option appears in Job Watcher, Collection Services Investigator, Disk Watcher and PEX Analyzer.  
Access it by right-clicking the component icon (or library) and choosing the Find Collections menu.  It 
provides the ability to search a system or specific libraries for performance data of interest based on user-
defined criteria.  Example SQL statements are provided and cover the most needed scenarios. 

This interface creates a single member SQL table in the Output library specified.  These results are 
shown within the IBM i Explorer -> Find collections results folder and will be executed in the Remote SQL 
Statement Status View.   

Note: Depending on the number of collections on the system, this option could run for several minutes or 
even hours. 

 



IBM iDoctor for IBM i  

 

3.6.3 Download 

The download option when used for the selected libraries will show the Transfer Library(s) window. 
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3.6.3.1 Interface 

Option Description 

Destination Indicates where the data will be sent.  For a download operation, PC is assumed, 
although it could be changed here. 

Target path The location on the PC where the save file(s) will be sent.  A save file will be 
created for each library name. 

Run in a command 
prompt window 

Indicates if the status of transfers should be visible in a command prompt window.  
 
Note: This only appears if the IBM i Connection’s file transfer method is SSL or 
SSH. 

Open target 
directory in File 
Explorer when done 

Indicates if Window’s File Explorer should be opened and navigated to the path 
after the transfer is complete. 

 

3.6.4 Upload 

This option when used from a Library folder shows the Upload File(s) from PC window and fills in the 
target directory or library textbox with the library selected.   
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Press the Add button to add the save files to transfer to the library and select them from the window that 
appears. 

 

 

3.6.4.1 Interface 
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Option Description 

Target directory or 
library 

This window can be initiated from an IFS directory or IBM i library.  Depending on 
the context the value will be one or the other. 

Binary mode Check this box to have the data sent in binary mode, which should always be used 
unless transferring text files to an IFS directory. 

Run in a command 
prompt window 

Indicates if the status of transfers should be visible in a command prompt window.  
 
Note: This only appears if the IBM i Connection’s file transfer method is SSL or 
SSH. 

Target lib file name 
action  

Only if data is being sent to a library and the file name is greater than 10 characters, 
then one of these actions will be taken to determine the file name to use: 
 
- Use the first 10 characters. 
- Use the last 10 characters. 
- Use the first 7 characters and a 3-digit unique number.  

 
Note: This only appears when sending data to a library. 

Remember this list Use this option if you want the GUI to remember the list of files and repopulate the 
list again with the same set of files.  This can be handy if sending the same files to 
multiple LPARs. 

Upload file list This is the list of files on the PC that will be transferred to the remote server. 

Add button Use this button to add files from the PC to the list. 

Remove button This button removes the selected files from the list. 

Remove all button Removes everything from the list. 

 

3.6.5 Copy URL 

Use this option to copy and paste a URL into an email or instant messaging program to allow another 
user to access the same interface currently being viewed.  Using this option from a library, will bring up 
the iDoctor GUI on the PC and open the component and library that was being viewed when this option 
was taken. 

The URL generated by this option starts with idoctor:// and tells your web browser to launch iDoctor and 
perform the desired action. 

 

3.6.6 Copy… 
A library may have its contents copied into a new library or into an existing library by using the Copy... 
menu.  The progress of the library being copied may be viewed using the Remote Command Status View. 
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3.6.6.1 Interface 

Option Description 

From library Displays the name of the library to be copied. 

To library The name of the library that will receive the contents of the from library.  By clicking the 
down arrow you can choose from a list of all libraries on the system. 

 

3.6.7 Save… 
A library's contents can be saved using the Save... menu.  The progress of the library being saved may 
be viewed using the Remote Command Status View. 
 

 
 

3.6.7.1 Interface 

Option Description 

Library to save The name of the library to be saved. 

Save file/library The name of the save file and library to save the contents of the library into.  If the 
save file doesn't exist it is created.  If the save file does exist, you will be asked for 
confirmation before continuing.   

Target release Specifies the release of the operating system on which you intend to restore and use 
the object.                      

Data compression Specifies the data compression setting from the SAVLIB command. 
 
The choices are: 
*NO      
*YES     
*LOW     
*MEDIUM  
*HIGH                

 

3.6.8 Transfer to an IBM i 
This option is used to save and send one or more libraries to another IBM i.  When using this option, the 
Transfer Library(s) window appears with the destination set as IBM i library. 
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Transfer Library(s) to an IBM i  
 

3.6.8.1 Interface 
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Option Description 

Destination This indicates where you will be sending data to. 

Target system The IBM i to save and restore the library(ies) to. 

Port The FTP port to use for the transfer.  (1-65535 are valid)   
 
Default: 21  
Secure: 990 
 
Note: This parameter is passed down to the PORT parameter on the FTP command 
on the IBM i. 

Secure connection Specifies the type of security mechanism to be used for protecting information 
transferred on the FTP connection (which includes the password used to authenticate 
the session with the FTP server).  Transport Layer Security (TLS) and Secure 
Sockets Layer (SSL) are compatible protocols which use encryption to protect data 
from being viewed during transmission and verify that data loss or corruption does 
not occur.     
 
Default:  If the PORT parameter specifies Secure or 990, Implicit is used; otherwise, 
None is used.      
 
Implicit:  The FTP client immediately attempts to use TLS/SSL when connecting to 
the specified FTP server (without sending an AUTH subcommand to the server).  If 
the server does not support implicit TLS/SSL on the specified port, or the TLS/SSL 
negotiation fails for any reason, the connection is closed.        
 
SSL:  After connecting to the specified FTP server, the FTP client sends an AUTH 
(authorization) subcommand requesting a TLS/SSL protected session.  If the server 
supports TLS/SSL, a TLS/SSL negotiation performed.  If the server does not support 
TLS/SSL or the TLS/SSL negotiation fails, the connection is closed.             
 
None:   The FTP client does not use encryption when connecting to the specified 
FTP server.                            
 
Note: This parameter is passed down to the SECCNN parameter on the FTP 
command on the IBM i.                               

Data to transfer This is the list of libraries to transfer 

 

3.6.9 Clear 
A library's contents may be cleared using the Clear... menu available by right-clicking on a library.  The 
progress of the library being cleared may be viewed using the Remote Command Status View. 
 

3.6.10 Clear Server Cache 
This option clears the iDoctor cache that keeps track of collections.  This is also known as the Collections 
Database.  It exists to speed up listing collections in libraries in iDoctor.  This data is stored in tables 
QUSRSYS/QAIDRLIBS and QUSRSYS/QAIDRCOLS. 
 
It is sometimes necessary to use this option if the collections show incorrect status information such as 
missing files or analyses data is not being displayed correctly. 
 

3.6.11 Delete 
A library may be deleted using the Delete... menu available by right-clicking on a library.  The progress of 
the library being deleted may be viewed using the Remote Command Status View. 
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3.6.12 Rename 
A library may be renamed using the Rename...  menu.    
 

 
Rename Library Window 
  

3.6.13 Locks -> Library 

This option opens the Object lock info folder for the selected library object. 

 

3.6.14 Locks -> All objects 

This option opens the Object lock info folder for the selected library showing the locks on any objects 
found in the library. 
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3.6.15 Properties 
The library property pages are accessible by right-clicking on a library and choosing the Properties menu.  
The next section discusses the library properties pages. 

3.6.15.1 Overview 

The Overview tab for libraries displays basic information about the library, including the type, owner and 
total size of all objects in the library. 
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Interface 
 

Option Description 

Type Indicates if the library is a production (PROD) or TEST library.     

Owner The user profile that owns the library. 

Create authority The default public authority for an object created into this library.   

Create object 
auditing 

The auditing value for objects created into this library. 

Description Library description.  You can change this value if you wish. 

 
 

Created on The timestamp when the library was created. 

Created by The user that created the library. 

Object domain The domain of the library.   
 
User - The object may be accessed directly by user-state programs at all system 
security levels.  This is not a supported programming interface unless it is explicitly 
stated in the software product documentation.                                           
 
System - The object cannot be accessed directly by user-state programs when the 
system security level is set to level 40.  The object can only be accessed by           
system-supplied programs at security level 40.  This object is not a supported 
programming interface.  At security levels below 40, the object can be referred    
to but access will be recorded in the audit journal if the journal QAUDJRN has been 
created.                        

Changed on The timestamp when the library was last changed. 
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Total Size Total size of all objects in the library including the library itself.  Click the Calculate 
button to compute this value.   
 
Note:  This calculation can take a long time (minutes or worse) depending on the 
number of objects and members in the library.  The GUI may appear to freeze during 
this time as well. 

Number of objects Number of objects in the library.  Click the Calculate button to determine this. 

ASP The ASP the library resides in. 

Overflowed Indicates if the object has overflowed the ASP it resides in.                               

 

3.6.15.2 Save/Restore 

The save/restore property page displays information about how and when the library was last saved or 
restored. 

 
 
 

3.6.15.3 Authorities 

The Authorities tab shows a list of users that have authority to the library and each authority setting.  This 
interface is like the DSPOBJAUT command. 
 

 
 
Interface 
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Option Description 

User The names of users who are authorized to use the object.  The value *PUBLIC is 
used to indicate the authorities of users who are not specifically named and are not 
in the object's     
authorization list. 

Group A group from which the user receives authority. 

Obj Authority The user's authority to the object. This field contains one of the following values:  

*ALL  
The user has all object (operational, management, existence, alter, and reference) 
and data (read, add, update, delete, and execute) authorities to the object.  

*CHANGE  
The user has object operational and all data authorities to the object.  

*USE  
The user has object operational, and data read and execute authorities to the object.  

*EXCLUDE  
The user has none of the object or data authorities to the object, or authorization list 
management authority to the authorization list.  

*AUTL  
The public authority for the object comes from the public authority on the 
authorization list securing the object. This value can only be returned if there is an 
authorization list securing the object and the authorized user is *PUBLIC.  

USER DEF  
The user has some combination of object and data authorities that do not relate to a 
special value. The individual authorities for the user should be checked to determine 
what authority the user has to the object.  

Obj Opr Object operational authority provides authority to look at the object's attributes and to 
use the object as specified by the data authorities that the user has to the object. 

Obj Mgmt Object management authority provides authority to specify security, to move or 
rename the object, and to add members if the object is a database file. 

Obj Exist Object existence authority provides authority to control the object's existence and 
ownership. 

Obj Alter Object alter authority provides authority to change the attributes of an object, such as 
adding or removing triggers for a database file.                                                  

Obj Ref Object reference authority provides authority to specify the object as the first level in 
a referential constraint.                

Data Read Read authority provides authority to access the contents of the object.                    

Data Add Add authority provides authority to add entries to the object.  

Data Update Update authority provides authority to change the content of existing entries in the 
object. 

Data Delete Delete authority provides authority to remove entries from the object. 

Data Execute Execute authority provides authority to run a program or search a library or directory. 

 

3.6.15.4 Cross Check 

This interface is used to validate that the physical files in the library match the same record formats as 
those in QSYS.  This tab is only available in Job Watcher, Disk Watcher, Collection Services Investigator 
and PEX Analyzer. 

Tip: If any files indicate NO in the first column, then new data should not be captured in this library. 
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3.6.15.5 SQL 

This tab provides information about the last SQL statement ran for the component view this option was 
initiated from.   It does not apply to the library itself, but to the iDoctor SQL statement used that built the 
list of libraries. 

This interface is mostly for IBM internal use. 

If desired, there is an Open in Data Viewer button available, which allows you to modify the SQL 
statement. 

The bottom of the window contains information about the success of the SQL statements ran to produce 
the list of libraries and how long each took.   
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3.6.15.6 Columns 

This tab provides information about the columns found in the last SQL statement ran for the component 
view this option was initiated from.   This data comes from the ODBC driver.  It is intended primarily for 
IBM internal use. 
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3.7 Collections Folder 
If the Filter Libraries Pane has been used to reduce the number of libraries displayed, then this folder will 
also appear in Job Watcher and Collection Services Investigator as another way for working with the 
collections on the system. 

Tip: This folder is the only way to create a graph against data in different libraries at the same time by 
selecting the desired collections and right-clicking. 

 

Note: For performance reasons the maximum number of libraries that will be displayed in this folder is 25.  
It is also a good idea but not required to make sure the collections database has been refreshed before 
using. 
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4 Collections 

This section describes interface options for collections which are available for any of the components. 

Collections exist under a Monitor, Library or within the Collections folder in iDoctor. 

Below is an example of a list of collections in a library within Job Watcher: 

 

Collections in a library in Job Watcher  

4.1 Menu Options 
A collection in iDoctor has the following menu options available (right-click): 
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Menu Description 

Explore Show the contents of the collection.  

Refresh Status In some situations, the Status column may indicate files are missing incorrectly.  
This option is used to refresh the collections cache for the selected collection(s) to 
be sure that the files are truly missing. 
 
This also can be used in cases where report folders are missing. 

Analyses -> Analyze 
Collection… 

This interface lets you see more details about each analysis and decide which 
ones to run on your collection.  It also provides options for editing which situations 
to run when using the Situational Analysis in the CSI and JW components. 

Analyses -> Run ALL 
default analyses 

In some of the components this will run the “default” set of analyses on the 
selected collections.  This list of “default” analyses varies by component and can 
be viewed by using the previous option “Analyses -> Analyze Collection” and 
looking for the “Run All Default” column in the list of analyses. 
 

 
Analyses -> Run 
analysis 

Provides a list of all available analyses you can run against the selected 
collection(s.)  By picking the desired one the analysis will run immediately (unless a 
prompt is required.) 
 

 
 
Tip: If you wish these to run in batch job rather than a QZDASOINIT job use the 
Preference -> Miscellaneous -> Always run analysis in a batch job. 

Report menu options Most collections provide menu options that allow a user to open graphs or tables 
by right-clicking the desired collection(s) and picking a report. 
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Tip: You can also select multiple collections by using the Ctrl or Shift keys on the 
keyboard.  This allows you to graph multiple collections at once for many reports in 
iDoctor.  If it’s available, you will be asked if you wish to combine the collections 
into a single graph / report or not. 

Graph Job(s) Use this option to graph one or more jobs over time in Job Watcher or Collection 
Services Investigator. 

Search Some components allow a search capability.  This typically will give you different 
types of data to look and a list of results that match the search.  From the search 
results you will be able to drill down to retrieve more detail.  See the CSI or Job 
Watcher documentation for more details. 

Generate Reports… This option can be used to build a report of the desired set of graphs or reports.  
The report consists of a screenshot of each graph along with its title and collection 
information.  The reports are built into a HTML page and displayed in a web 
browser when completed. 

Download… This is used to save the selected collection(s) to a save file then download it to the 
PC. 

Change 
Description… 

This option is used to modify the description shown in the list for a single collection. 

Copy URL Creates a link to the component, library and collection that can be accessed later, 
or sent to another user.   

Copy... Allows you to copy the collection(s) to another location.   

Delete Deletes the selected collection(s). 

Rename Rename the selected collection. 

Save... This option lets you save the collection(s) into a save file on the server. 

Split… Divides a large collection into 1 or more smaller collections based on time filtering 
you specify.  This option is only available in the Job Watcher and PEX Analyzer 
components and is covered in the applicable documentation. 

Transfer to... Allows a user to create a save file of the selected collection(s) and transfer it to 
another system, the PC or to IBM. 

Locks Use this option to check for object locks against the collection files, either the OS 
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QAPM* files if using CSI, QAPYJW* for Job Watcher, QAPYDW* for Disk Watcher 
or QAYPE* for PEX.  Another option will check for locks against any QAIDR* in the 
collection library.  Results are shown in the Object lock info view. 

Properties Displays the property pages for the collection. 

 

4.2 Graph Job(s)  
This interface is found only in the Job Watcher and Collection Services Investigator and is used to graph 
the desired job in any collection over time.  This allows a user to graph and compare 1 job with another 
job on the same system or any system and collection they wish. 

An example follows: 

 

 

 

Graph Job(s) Window 

 

Some of the less obvious columns are described below: 

Option Description 

Job or task 
contains 

This allows you to enter part of the job name to reduce results when pressing the 
Browse button which is recommended. 

Taskcount The taskcount is the unique identifier for the job and/or task.   
 
It must be provided using the Browse option before using the Open Graph(s) button. 

Graph This is the name of the selection over time graph to open.   

Keep open Check this box if you wish to keep this interface open after pressing the Open 
Graph(s) button.  This will let you open several different graphs at once into a Data 
Viewer more easily before reviewing them. 
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Graph Job(s) Example graph 

 

4.3 Report Generator 
This interface allows a user to generate an HTML report for the desired graphs or tables.  The user can 
select the reports of interest, and the GUI will automatically open each report, capture a screenshot and 
then build an HTML page showing all the reports in a single window for review.    This feature is intended 
to allow a user to easily save a series of graphs for comparison with other collections or for a consultant 
to present their findings to a client. 
 
In most components this feature is accessible by right-clicking a collection and choosing the Generate 
Reports… menu option. 
 
An example of this interface is: 
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iDoctor Report Generator 
 
To use this interface, select the desired reports from the list of available reports and press the “Add 
Selected” button to add them to the “Included reports” list.   To save the list of included reports for future 
use, enter a name in the drop-down box next to the Save button and press the Save button. 
 
The Configure button at the top of the screen will take you to the Preferences for the Report Generator 
window.  These preferences control various aspect to how the reports will look and whether the resulting 
file generated is an HTML file or a PDF file. 
 
After pressing Submit, each table or graph will be opened into the Data Viewer capturing a screenshot for 
each one.  If you wish to cancel this process, close the Data Viewer while the Report Generator is 
running.  After all reports are loaded, a file is built to show all the screenshots captured.  This page will be 
opened with the default web browser installed on the PC.  Depending on how many reports are selected 
this could take a long time.  You can also use the Schedule button at the bottom of the window to have 
the graphs/reports be opened later.   
 
The following table describes some of the less obvious options available on the iDoctor Report Generator 
window: 
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Option Description 

Configure button This button opens the Preferences for the iDoctor Report Generator.  This controls 
where the reports are generated and how they will look. 
 
This is also used to control if the reports will be emailed to someone else 

Graph type drop-down In the top right corner of the window is a drop-down list that allows the user to filter 
the graphs shown by type.  The options are: 
- All 
- No rankings 
- Only rankings 
- No graphs 
- Only graphs 

Folders drop-down This drop-down list provides a list of all primary folders that appear under a 
collection.  By selecting one of these you will be able to filter the list of available 
reports to a smaller number. 

Description filter box The textbox next to the folders drop-down allows the user to enter a text string to 
reduce results in the list.   

Saved reports drop 
down list 

This is a list of saved lists of reports that are available.  Selecting a name from the 
list will update the list of reports selected to the ones indicated in the list.  
You can define a new list by typing a name into the drop-down box and pressing 
the Save button.  These lists are saved into the User-defined reports database 
which allows them to be reused by other users. 
 
Note:  Saved report lists you created are also visible under the Favorites folder 
(under a collection) in Job Watcher and Collection Services Investigator. 

Schedule This option allows you to schedule the reports to be generated later using the 
Windows task scheduler.  Options are available to have this occur repeatedly.    
 
The PC must be on, and the current user must be still logged in at the indicated 
date/time for this to work.   

Use newest collection This option appears only when the scheduling option is used.  If this option is 
checked then when the report is generated it will use the newest collection in the 
library rather than the one used to launch the Report Generator interface originally. 

An example of a report generated by this interface follows: 
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Report generator example - page 1 
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Report generator example - page 2 

 

4.4 Download 
This option will transfer one or more collections to the specified location on the PC. 
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Option Description 

Target path The directory on the PC to send the collection(s) to.  If a filename is not provided, 
then a random IDRDATAnnn.savf name is generated.  Multiple collections are saved 
into a single save file.  

Run in a command 
prompt  

This option appears only if the File transfer method setting on the IBM i connection is 
not set to Wininet.  A command prompt window will appear showing the status of the 
transfer when checked. 

Open target 
directory in File 
Explorer 

After transfer has finished, this option will open the File Explorer to show the newly 
transferred save file. 

Target release This indicates the release of the IBM i you intend to transfer the data to. 

Data compression Specifies whether data compression is used.  If the save is running while other jobs 
on the system are active and software compression is used, the overall system           
performance may be affected.  
   
The choices are: 
*NO      
*YES     
*LOW     
*MEDIUM  
*HIGH                                           

Include all 
collections from 
library XYZ 

This option lets you include ALL collections from the library of the collection you 
opened this option from. 

 

4.5 Copy URL 
Use this option to copy and paste a URL into an email or instant messaging program to allow another 
user to access the same interface currently being viewed.  Using this option from a collection, will bring 
up the iDoctor GUI on the PC and open the component, library and collection that was being viewed 
when this option was taken. 

The URL generated by this option starts with idoctor:// and tells your web browser to launch iDoctor and 
perform the desired action. 

An example URL to open a CSI collection is:    

idoctor:///viewinfo1[type=CFolderCollection,sys=Idoc720,lib=CSLABEX1,comp=CS,col=Q175102853] 

4.6 Copy 
A collection can be copied by using the Copy... menu found by right clicking on a collection within the 
component view. 
 
This option will execute the appropriate iDoctor collection copy command depending on the type of 
collection selected.  Copying a collection that is still running is not allowed.  Multiple collections can be 
copied at the same time if desired to another library. 
 
Note: Be sure to only copy a collection to a library with existing performance data of the same type if the 
collection matches the same IBM i release.  If not sure, it’s best to copy the collection to a new library. 
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4.7 Delete 
A collection can be deleted by using the Delete... menu found by right clicking on a collection within the 
component view. 
 
This option will execute the appropriate iDoctor delete collection command depending on the type of 
collection selected.   This option is not allowed if the collection is running.    
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4.8 Rename 
This interface allows a user to rename a single collection. 

 

 

4.9 Save 
One or more collections can be saved to a save file by using the Save... menu found on the collection. 
  

 

Save Collection(s) Window 
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4.10 Transfer to… 
A collection can be transferred to another system by using the Transfer to... menu found by right clicking 
on a collection within the component view.  Use the Download menu option instead to send the data to 
the PC.  This option is only available for collections that are no longer running.   
 
The transfer options for collections consists of the following choices: 
 

 
 
Picking one of these will take you to a Transfer window. 
 
After reviewing the Transfer window and pressing the Transfer button, a validation step takes place to 
help detect any problems before continuing.  Any errors that occur will be shown to the user.  Afterwards 
commands will be issued on the local and remote servers to save, send and restore the data.  These 
commands will be shown in the Remote Command Status View. 
 
In the Remote Command Status View, if an error occurs during the FTP part you can right-click the failing 
part and use the Show Job Log or Show History Log options.  Another option for debugging is to open an 
SQL Editor (either in iDoctor or STRSQL) and issue the following query: 
 
SELECT * FROM QIDRGUI/FTPLOG  
 

4.10.1 Transfer to another IBM i 
This option allows you to transfer one or more collections to another IBM i and have them automatically 
restored. 
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Option Description 

Target system The IBM i to transfer data to.  This is the same list of systems found in the IBM I 
connections view and can be modified there. 

Target library The library on the target system to send data to. 

ASP The ASP of the target library.  Only applies if the library does not exist and you want 
to create a new one. 

Clear remote library Indicates if the remote library should be cleared before restoring the data.  
Sometimes this is necessary if existing library contains existing performance data of 
the same type. 

Port The FTP port to use for the transfer.  (1-65535 are valid)   
 
Default: 21  
Secure: 990 
 
Note: This parameter is passed down to the PORT parameter on the FTP command 
on the IBM i. 

Secure connection Specifies the type of security mechanism to be used for protecting information 
transferred on the FTP connection (which includes the password used to authenticate 
the session with the FTP server).  Transport Layer Security (TLS) and Secure 
Sockets Layer (SSL) are compatible protocols which use encryption to protect data 
from being viewed during transmission and verify that data loss or corruption does 
not occur.     
 
Default:  If the PORT parameter specifies Secure or 990, Implicit is used; otherwise, 
None is used.      
 
Implicit:  The FTP client immediately attempts to use TLS/SSL when connecting to 
the specified FTP server (without sending an AUTH subcommand to the server).  If 
the server does not support implicit TLS/SSL on the specified port, or the TLS/SSL 
negotiation fails for any reason, the connection is closed.        
 
SSL:  After connecting to the specified FTP server, the FTP client sends an AUTH 
(authorization) subcommand requesting a TLS/SSL protected session.  If the server 
supports TLS/SSL, a TLS/SSL negotiation performed.  If the server does not support 
TLS/SSL or the TLS/SSL negotiation fails, the connection is closed.             
 
None:   The FTP client does not use encryption when connecting to the specified 
FTP server.                            
 
Note: This parameter is passed down to the SECCNN parameter on the FTP 
command on the IBM i.                               

Target release This indicates the release of the IBM i you intend to transfer the data to. 

Data compression Specifies whether data compression is used.  If the save is running while other jobs 
on the system are active and software compression is used, the overall system           
performance may be affected.    
 
The choices are: 
*NO      
*YES     
*LOW     
*MEDIUM  
*HIGH                                           

Include all 
collections from 
library XYZ 

This option lets you include ALL collections from the library of the collection you 
opened this option from. 
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4.10.2 Transfer to FTP server 
This option allows you to transfer one or more collections to a directory on another system.  The 
collection(s) are combined into a single save file and sent the path/filename specified. 
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Option Description 

Target system The IBM i to transfer data to.  This is the same list of systems found in the IBM I 
connections view and can be modified there. 

Target path The location and filename of where to send the data. 

Create subdirectory This option (if checked) will create on the target system any subdirectories required 
by using the target path specified.  Otherwise the transfer will fail if the location does 
not already exist or the user lacks the ability to create directories. 

Port The FTP port to use for the transfer.  (1-65535 are valid)   
 
Default: 21  
Secure: 990 
 
Note: This parameter is passed down to the PORT parameter on the FTP command 
on the IBM i. 

Secure connection Specifies the type of security mechanism to be used for protecting information 
transferred on the FTP connection (which includes the password used to authenticate 
the session with the FTP server).  Transport Layer Security (TLS) and Secure 
Sockets Layer (SSL) are compatible protocols which use encryption to protect data 
from being viewed during transmission and verify that data loss or corruption does 
not occur.     
 
Default:  If the PORT parameter specifies Secure or 990, Implicit is used; otherwise, 
None is used.      
 
Implicit:  The FTP client immediately attempts to use TLS/SSL when connecting to 
the specified FTP server (without sending an AUTH subcommand to the server).  If 
the server does not support implicit TLS/SSL on the specified port, or the TLS/SSL 
negotiation fails for any reason, the connection is closed.        
 
SSL:  After connecting to the specified FTP server, the FTP client sends an AUTH 
(authorization) subcommand requesting a TLS/SSL protected session.  If the server 
supports TLS/SSL, a TLS/SSL negotiation performed.  If the server does not support 
TLS/SSL or the TLS/SSL negotiation fails, the connection is closed.             
 
None:   The FTP client does not use encryption when connecting to the specified 
FTP server.                            
 
Note: This parameter is passed down to the SECCNN parameter on the FTP 
command on the IBM i.                               

Target release This indicates the release of the IBM i you intend to transfer the data to. 

Data compression Specifies whether data compression is used.  If the save is running while other jobs 
on the system are active and software compression is used, the overall system           
performance may be affected.                   
 
The choices are: 
*NO      
*YES     
*LOW     
*MEDIUM  
*HIGH                            

Include all 
collections from 
library XYZ 

This option lets you include ALL collections from the library of the collection you 
opened this option from. 
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4.10.3 Transfer to IBM   

These options are used to send your data to IBM for analysis.  Typically, you will need a case # to 
associate this data with.  

The options for these modes are the same as the previous section (Transfer to FTP server), except there 
is also an option to transfer using QMGTOOLS.   Command FTP2IBMCMD is used. If using that then the 
interface looks like this instead and most of the settings are controlled through preferences.  

Tip: In order for the *IBMSDDUU option to be successful, your password must have been previously set 
on the IBM I using the GO MG menu option 25 (STORFTPPWD command.)  Also, within the Send to IBM 
Preferences the IBM ID/password fields should be set to *STORED and blank. 

 

 

 

Option Description 

Type These options are the same as found on the QMGTOOLS/FTP2IBMCMD FTPTYPE 
parameter.   
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4.11 Server-side output files 
Most collections provide a folder called Server-side output files.  This provides access to a list of tables 
applicable to the current collection.  This list contains both iDoctor created files and files created by IBM i 
performance data collection mechanisms.   
 
You can right-click this folder and use the Select fields… menu to configure the list of fields shown in this 
list. 
 
Tip: The number of records found in each table is also shown, which if 0 can help indicate a problem in 
some situations.  This view is also used to tell if certain expected tables do not exist (and presumably did 
not get transferred successfully) 
 
Note: For performance data like QAPYJW* files in Job Watcher, this information applies to the member 
name in the file matching the collection name. 
 

 

4.12 User-Defined Reports  
When viewing collections in most iDoctor components an option called “User-defined reports” will be 
shown.  This option allows you to show reports from your user-defined reports database but applied to the 
current collection.  This folder contains both graph and table views. 

Note: Before using this feature some graphs and/or table reports must be created first.  This is typically 
done by modifying features of an iDoctor graph/table (either SQL statement, columns shown, labels 
and/or colors) and using the Graph Definition -> Save As… menu for graphs or Query Definition -> Save 
As… menu for tables. 

 



IBM iDoctor for IBM i  

4.12.1 Creating a user-defined graph 

In CSI to create a user-defined graph showing only the QSQ* server jobs, a user could follow these steps: 

1. Open the Waits -> Dispatched CPU rankings by thread graph. 

2. Right-click in the legend on the X-axis label field Job name/user/number: Thread ID (OBJNAME) 
and choose Add Filter… 

 

3. Type in the value QSQ into the box and change the Operator to Starts with.   

4. Click the Add Filter button then Apply button. 

5. Right-click on the graph and use the Graph Definition -> Save As option 

 

6. Updated the description if desired then press the Save button 

 

4.12.2 Creating a user-defined report 

In Job Watcher a user-defined report showing only QAPYJWTDE file records with page fault time could 
be created by following these steps: 

1. In Job Watcher, expand the server-side output files folder and open the QAPYJWTDE file. 

2. Click the SQL button on the toolbar to view the SQL statement. 
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3. Modify the SQL statement to include a where clause such as WHERE QTIME05 > 0 and include 
QTIME05 near the front for the list of columns displayed. 

 

4. Press F4 to rerun the SQL statement 

5. Right-click the report and use the Query Definition -> Save As… option 

 

 

  

4.12.3 Graphs  

This folder contains all user-defined graphs that are applicable to the current collection.  
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Double-click a graph to open it.  You may also right-click the graph and use the Properties option to view 
and change some of the settings for the graph such as the SQL statement used. 

 

4.12.3.1 Properties 

User-defined graphs have properties pages that let you change several settings with how the graph looks.  
Tip:  You can also change these same settings by opening the graph and saving the user-defined graph 
there instead.   
 
These properties for user-defined graphs are mostly identical to those for iDoctor supplied graph 
definition properties.   The main differences are you can edit user-defined graph definitions and the SQL 
statement and your changes will be saved. 
 

 
This interface is covered in the Data Viewer documentation. 

4.12.4 Tables 

This folder contains all user-defined table-based reports that are applicable to the current collection.  
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4.12.4.1 Properties 

User-defined reports have properties pages that let you change several settings with how the graph 
looks.  Note:  You can also change these same settings by opening the table and resaving the report as 
a user-defined report instead. 
 

4.12.4.1.1 Details 

The details page lets you change the title for the report or modify the IBM i VRM levels that the report 
should apply to. 

 

 

User-Defined Report Properties – Details 
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Option Description 

Description The name to give the user-defined report. 

Minimum VRM The minimum IBM i release in nnn format such as 610, 710, 720, 730, etc.   
The minimum release currently functions at is V6R1 (i.e. 610)  

Maximum VRM The maximum IBM I release in nnn format this report should appear at. 
Use a value of 0 if no max. 

Location Identifies where this report exists in the user-defined reports database.   
User-defined reports are located within the database (either the .mdb file or IBM I 
library) in table QAIDRSQL. 
 
Within table QAIDRSQL the following columns are used in the example in the 
screenshot above: 
 
SIDCOMP = JW     (component identifier) 
SQRYCAT = DTL  (folder identifier – also see table QAIDRCATS) 
SREFNO = 2          (unique report identifier within this component and folder) 

Open Opens the user-defined reports database. 
 
Note:  If using a local .mdb database, the QAIDRSQL table is not opened.  You will 
need to open the table from the Tables section of MS Access manually and find the 
record using the information in the Location field above. 

 

4.12.4.1.2 SQL 

The SQL statement tab lets you change the parameterized SQL statement behind the report. 

 

 

User-Defined Report Properties - SQL 



IBM iDoctor for IBM i  

 

Option Description 

Find Lets you find the entered text within the SQL statement by pressing the Next or 
Previous button. 

Parameterized SQL 
statement 

This is the SQL statement including parameters such as: 
 
<<LIBNAME>> = library name 
<<MBRNAME>> = collection/member name 
 
Tip:  If parameters are included in the SQL statement but are not known to iDoctor 
then you will be prompted to enter a value when running the report by the Change 
SQL Parameters window. 

 

4.12.5 Menu Options 
Each user-defined graph or report in these folders has the following menu options when right-clicked: 

Menu Description 

Open Graph / Table Opens the selected report in a new or existing data viewer depending on the sub-
menu option taken. 

Edit Opens the selected report into the SQL Editor.  The SQL statement will not be ran 
until requested by the user.   
 
This is most useful if the queries are long running and you wish to modify them 
before execution. 

Delete... Removes the selected user-defined reports from the user-defined reports database. 

Properties Displays details about the current user-defined graph definition or query definition 
that can be modified such as the SQL statement or fields shown on the graph. 

 

4.12.6 Column settings overrides  

This folder contains each column that has been modified in iDoctor by any user using the currently 
defined user-defined reports database.  Whenever a user modifies a graph or table column using the Edit 
column interface they will be saved here.   These overrides apply to iDoctor supplied reports and user-
defined reports for any where the column short name in the SQL statement matches the values in this list. 

If you delete a column from this view, then the iDoctor-defined settings for this column (colors and 
description) are used instead (assuming the same column name exists in the iDoctor reports.)  Tip: After 
deleting column overrides you may need to Clear the iDoctor cache from the component icon popup 
menu in order for the changes to take effect. 

4.12.7 Other repositories  

This option allows you to work with any other repositories (libraries) found on the current IBM i you are 
using.  Only libraries will appear that contain the iDoctor repository SQL tables such as QAIDRGPH or 
QAIDRSQL. 
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5 Analyses 

Analyses in iDoctor are used to process performance data to either summarize the data in some manner 
or dig deeper and look for specific information for a given performance problem.   

Analyses can be found in the main iDoctor components: Job Watcher, PEX Analyzer, Disk Watcher and 
CSI (Collection Services Investigator).   

Analyses are initiated by right-clicking collection(s) (or library(ies)) and using the Analyses menu and 
picking either the Analyze Collection... menu (which shows a window to pick and choose from any 
available analyses) or pick one of the available "fast path" analysis options such as "Run Collection 
Summary", "Run Situational Analysis", etc. 

 

A list of available analyses for a collection in Job Watcher.  

 

Tip: The Analyses menu is also available if you select multiple collections and right-click.  This will run the 
desired analyses on all the selected collections.   

Analyses in iDoctor are SQL stored procedures.  When an analysis runs it runs in the Remote SQL 
Statement Status View at the bottom of the main window. This window shows the progress of the analysis 
and from there completion or error messages will be shown. If an error is shown, you should right-click 
the error and use the Display job log menu to view the job log and try to determine the error.  If you are 
unable to determine the reason for the error, send the job log and related information about the 
component, collection you are trying to analyze to iDoctor@us.ibm.com. 
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Remote SQL Statement Status View 

 

After an Analysis is complete, the tables it creates can be accessed under the SQL Tables folder found in 
iDoctor under the component icon or under each library within the Libraries folder.  Reports are often 
available from the SQL tables generated by the analysis.  In many cases additional reporting options are 
also available under the collection, by right-clicking the collection and accessing a new menu option 
applicable to the new analysis. 

 

5.1 Analyze Collection(s) Window  
Use this option to be presented with a list of possible analyses to run against the selected collections.  
You can select one or more analyses to run by checking the checkbox next to each.  In the Job Watcher 
and Collection Services Investigator components, a Situations button will exist that allows you to 
configure options related to the Situational Analysis. 

If you want the analyses to run in a batch job instead of a QZDASOINIT job, then check the checkbox 
called “Submit this request to a batch job…”.  Doing so is usually desired if the collections have large 
amounts of data or if the analyses are expected to take a long time to run as this will free up the Remote 
SQL Statement Status View for other actions you may wish to take. 

 

Analyze Collections Window 
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Option Description 

Situations… This button opens the interface to work with the situations found in the Job Watcher 
or Collection Services Investigator components. 

Clear This button will uncheck all selections in the list. 

Toggle selected The selected analyses will either be checked/unchecked (i.e. toggled ) from their 
current values. 

Analyses available This is the list of possible analyses to run.   It contains these columns: 
 
Description: The name of the analysis.  Typically, under the SQL Tables folder you 
will find folder of the same name which allows you to work with the data generated by 
these analyses. 
 
Used by:  This describes where in the GUI the data created by this analysis is used. 
 
Program:  The name of the program object in the QIDRGUI library.  This is the SQL 
stored procedure that behind each analysis.  These programs all have a text 
description which is a number such 005.  This is the version number of the program. 
 
Run all default:  If this value is set to a 1 then the analysis will be executed when 
using the Run ALL default analyses menu option found when right-clicking a 
collection. 

Submit this request 
to a batch job 
instead of using a 
QZDASOINIT job 

This option will run the desired analyses in a batch job on the IBM i using a file sent 
to the IBM i’s IFS with the SQL statements to run and the RUNSQLSTM command. 
 
The job name used will be one of the following depending on the component 
identifier: 
 
Collection Services:  QIDRCSSUM 
Job Watcher:  QIDRJWSUM 
PEX Analyzer:  QIDRPASUM 
Etc. 
 
Note: This option requires a valid FTP connection to the IBM i.  Your FTP connection 
settings can be configured in the IBM i Connections View. 

Run at high priority This will submit the batch job to run the SQL statements at priority 1.   
 
Note: You probably do not want to use this option on production systems as in some 
cases the SQL can be intensive. 

Schedule This button is used to specify in the analysis should run now or later.  

Always run 
analyses in a batch 
job 

This option effects the same preference on the Misc tab.  If checked then the next 
time this screen is used the “Submit this request to a batch job…” will be prechecked 
for you. 

 

After pressing OK, the Remote SQL Statement Status View window will show calls to several stored 
procedures that are used to create the analysis tables.  These tables will appear under the SQL Tables 
folder under the library and collection. 

After the analyses are complete it’s important to refresh (F5) the library to ensure that all new data is 
recognized by the GUI and it used in the reports shown.  If a Collection Summary analysis was ran the 
“Using iDoctor collection summary” flag may also change from “No” to “Yes.”  This will typically cause 
additional reports to shown as well. 
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Using iDoctor collection summary flag changed to Yes after analyses complete 

 

5.1.1 Situations Window 

The Situations Window allows the user to control parameters used by the IBM defined situations or you 
may also create new user-defined situations to run against the data in your collections.  Using this 
interface, you may also control which situations should be ran. 

An example of this interface is: 

 

The options on the interface above is described in the table below: 
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Option Description 

Situation text box This field allows the user to modify the name of the situation. 

Update button This button will save any changes made within the Selected situation quick edit 
options frame to the selected situation in the list.  These changes are saved in the 
windows registry.  

Filter value text box The filter value text box lets you modify the filter's value to use.  The filter value 
replaces the <<FITLER>> parameter marker within the SQL statement. 

Color change 
button 

Changes the situations color shown as the background color when graphed. 
If multiple situations occur in a time period, then the color is always red. 

Situations available 
list 

This list contains all the IBM-defined and user-defined situations.   
 
The following columns are provided: 
 
Show: The show checkbox/column can be used to avoid running certain situations if 
desired.  
 
Changed: If the user has made changes to a situation this column will contain “Yes”. 
 
ID: The ID number is used to uniquely identify each situation. 
 
Situation: Name of the situation. 
 
Filter:  Some situations have a <<FILTER>> parameter in the SQL statement.  This 
is the value to use for that parameter and helps indicate if the situation should occur. 
 
Filter description:  Describes the (optional) filter used by this situation.  
 
Color:  Identifies the color of the situation in RGB format (0-255,0-255,0-255). 
 
IBM-defined: This column indicates if the situation is IBM-defined or user-defined.  
Typically, the situation ID will be >=50 for user-defined situations.   
 
SQL: Shows the SQL statement for the situation.  It may be modified by pressing the 
Edit button. 

New button The new button displays the Situations Editor window which allows you to create 
your own situation. 

Edit button The edit button displays the Situations Editor window and fills in the information for 
the current situation. 

Delete button  This button lets you delete the currently selected user-defined situations.  IBM-
defined situations cannot be removed. 

Default button This button removes all changes made to the IBM-defined situations, remove all 
user-defined situations and restores them to their original (shipped-default) state. 

Toggle selected 
button 

This button changes the checked state of all selected items in the list. 

 

5.1.2 Situations Editor Window 

The Situations Editor window is used to create a new situation or modify advanced settings of an existing 
one.  It allows the user to modify a situation to suit their individual needs.  Situations are built from a 
special SQL statement that meets certain characteristics. 

 

An example of this window looks like this: 



IBM iDoctor for IBM i  

 

Job Watcher Situations Editor 

 

Option Description 

Situation ID The situation ID must be unique and needs to be between 50-99 for user-defined 
situations. 

Color change 
button 

Changes the situations color shown as the background color when graphed. 
If multiple situations occur in a time period, then the color is always red. 

Description text box This field allows the user to modify the name of the situation. 

Filter value text box The filter value text box lets you modify the filter's value to use.  The filter value 
replaces the <<FITLER>> parameter marker within the SQL statement. 
 
Note: This field is optional and can be blank. 

Filter description The filter description describes the filter that has been included in the SQL statement. 
 
Note: This field is optional and can be blank. 

SQL Statement 
examples 

The SQL statement examples drop down box contains a list of all IBM-defined 
situations.  Selecting one of these situations replaces the current SQL statement 
shown.  These examples contain comments and should help you get a better idea on 
how to create your own situation to suit your needs. 
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SQL Statement The SQL statement that performs the testing to see if the situation has been satisfied 
in the data.  The tables should be referred to using <<LIBNAME>>/QAPYJWTDE 
syntax where <<LIBNAME>> is a parameter marker replaced at runtime with the 
current library and QAPYJWTDE is the desired file.   
 
Note: Aliases will be automatically created for you to point to the current collection 
member and do not need to be referred to here. 
 

The outer select must contain the following 4 fields (in this order): 

1. ID = situation ID   (User-defined situations are numbered 50+.  IBM-defined 
situations are 1-49.) 

2. INTERVAL = interval number when the situation occurred 

3. TASKCOUNT = unique identifier for the job/task.  Use a value of 0 if the 
situation applies to the entire collection and not a specific job or task. 

4. TOTAL = The number of occurrences of this situation for this job/task and 
interval.  If the situation does not apply to any specific job or task, then a 
value of 1 should be used. 

Include job name in 
results 

This option will modify the SQL statement slightly under the covers to display the Job 
name and thread ID associated with each taskcount found.   Because Job name and 
thread ID are not returned in the situation analysis table they are only shown here for 
test purposes. 

Test SQL  This button executes the current SQL statement shown above against the current 
collection.  If any results are found, they will be shown in the SQL Statement results 
list. 
 

For testing purposes, use the Test SQL button and the “Include job name in results 
checkbox” to see the jobs in your test collection that match your situation before 
using.  In this way you can modify the SQL Statement to control verbosity to best suit 
your needs. 

SQL Statement 
results 

This list contains the result set returned by running the SQL Statement shown above. 

Accept button Accepts all changes made and closes the window, returning to the Situations 
Window. 

 

5.2 Run ALL Default Analyses 
In some of the components this will run the “default” set of analyses on the selected collections.   

 

Collection menu -> Analyses -> Run ALL Default Analyses  
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This list of “default” analyses varies by component and can be viewed by using the menu option 
“Analyses -> Analyze Collection” and looking for the “Run All Default” column in the list of analyses. 
 

 
Analyze Collection(s) Window -> Run All Default column example 
 
Tip: On the green screen these default analyses are ran when using the QIDRGUI/STRIDRSUM and 
QIDRGUI/RSTIDRDTA SUM(*YES) commands. 

 

5.3 Analyses -> Run analysis menu 
This option (by default) when used on a collection, will kick off the desired analysis in the Remote SQL 
Statement Status View.   If the submit to batch preference is used instead, then you must wait until the 
batch job created finishes. 

When complete additional reports will become available (after refreshing the component view).   

5.4 Change sensitive user data 
Most components include this analysis which can be ran to modify the performance collection in order to 
hide/rename potentially sensitive data such as system names, job names, user profiles, etc.  The data 
modified varies by component. 

It is a good idea to create a backup of the collection before using this feature since the changes are 
permanent except when using PEX Analyzer. 

Note: This analysis does NOT modify existing iDoctor-created QAIDR* SQL tables.  If you want that data 
to be sanitized as well, you should run this analysis first and then run the desired analyses after. 

After running this analysis, the collection status should indicate SANITIZED which means the original 
data has been changed by this analysis. 
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In PEX, a Restore sensitive user data analysis also exists that can be used to restore the data back. 

 

5.5 Restore sensitive user data  
This analysis appears ONLY in PEX Analyzer and can be used to restore the data that was sanitized 
back to the original contents.  This only works if the QAIDR* tables that were originally created by the 
Change sensitive user data analysis still exists in the same library and the collection has not been 
renamed. 
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6 Monitors 

All components provide an option to start and work with monitors.  Monitors allow the user to continuously 
collect Job Watcher, Disk Watcher and/or PEX data.    
 
Tip: Data in monitors can be optionally sent to another LPAR using an FTP definition. 
 
Note: For Collection Services, a monitor of that type allows data to be sent to another LPAR automatically 
after each cycle is completed.  Only 1 CS monitor can be started at a time.  Multiple JW, DW or PEX 
monitors can be running at the same time if desired. 
 
Monitors run continuously storing only the desired number of collections.  Monitors will run until ended 
manually by the user or when ended via a scheduled job.  Monitors can be held and released if the user 
wishes to stop collecting data, and then continue collection again later.  Monitors can also be scheduled 
to start and end at the desired times.   
 
Once a monitor has been completed, it must be restarted using the Restart Monitor option.   
 

Monitors Folder  
 

6.1 Commands 
The green screen commands related to monitors (and the collections they contain) in the QIDRWCH 
library are: 

Addftpdfn - Create a definition for sending data  

Cpycscol - Copy a Collection Services Collection  

Cpydwcol - Copy a Disk Watcher Collection  

Cpyjwcol - Copy a Job Watcher Collection  

Dltcscol - Delete a Collection Services collection  

Dltdwcol - Delete a Disk Watcher Collection  

Dltdwmon - Delete a Disk Watcher Monitor  

Dltjwcol - Delete a Job Watcher Collection  

Dltjwmon - Delete a Job Watcher Monitor  

Dltpamon - Delete a PEX Analyzer Monitor  

Endcsmon - End the Collection Services monitor (if active)  

Enddwcol - End a Disk Watcher Collection  
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Enddwmon - End a Disk Watcher Monitor  

Endjwcol - End a Job Watcher Collection  

Endjwmon - End a Job Watcher Monitor  

Endpamon - End a PEX Analyzer Monitor  

Ftpcol - Transfer perf collection to another system  

Hlddwmon - Hold a Disk Watcher Monitor  

Hldjwmon - Hold a Job Watcher Monitor  

Hldpamon - Hold a PEX Analyzer Monitor  

Rlsdwmon - Release a Disk Watcher Monitor  

Rlsjwmon - Release a Job Watcher Monitor  

Rlspamon - Release a PEX Analyzer Monitor  

Rmvftpdfn - Remove a definition for sending data  

Strcsmon - Start a Collection Services Monitor  

Strdwmon - Start a Disk Watcher Monitor  

Strjwmon - Start a Job Watcher Monitor  

Strpamon - Start a PEX Analyzer Monitor 

Tip: Many of these commands contain help text.  See the command help text for more details on usage. 

Note: When using a FTP definition, the QIDRGUI/FTPFILE command is used to send performance data 
to other LPARs. This creates a script and uses the IBM I FTP command. 

6.2 Filter Libraries pane 
This interface automatically appears whenever working with the Monitors folder to control which libraries 
are included. 

 

6.3 Menu Options 
The menu options found when right-clicking on one or more monitors in the list are: 
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Menu Description 

Explore This option will expand the monitor and view the collections it contains. 

Explore data on 
remote LPAR 

If this monitor has an FTP definition set, this option will open a new component view 
to the remote LPAR of the applicable component to view the data there. 

Edit FTP definition Use this option to change the FTP definition behind the monitor.   
Changes can be made while the monitor is still running if desired. 

View definition This option will display the definition used when creating the monitor.  
Note: This is not applicable to CS monitors. 

Edit definition This option displays the interface to modify the definition used when creating the 
monitor. 
Note: This is not applicable to CS monitors. 

Select fields… This is used to control which fields are shown in the list of collections found by 
double-clicking or using the Explore menu. 

Start New Monitor Opens the Start iDoctor Monitor Wizard to create a new monitor. 

Restart Monitor Opens the Start iDoctor Monitor Wizard to restart the selected monitor.  This option is 
only enabled if 1 monitor is selected. 

Hold/Release  This option allows the selected monitor to be held.  If held the active collection will be 
ended immediately and no more collections will be started until the monitor is 
released.  

End immediately This option will end the monitor and all active collections defined within immediately. 

End after current 
collection 

This option will end the monitor once the current collection running completes. 

Clear Server Cache This will clear the collections cache for the library and type matching the selected 
monitor. 

Delete Removes the monitor and all collections within it from the system.   
Note: This does not remove collections on the remote LPAR if an FTP definition has 
been set. 

Save Creates a save file containing all collections within the monitor. 

Transfer to Use these options to send data to another LPAR or the PC. 

 

6.4 Fields 
All columns are shown by default.  You can hide or rearrange columns using the Select Fields… menu by 
right-clicking the Monitors folder. 
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Field Description 

Monitor name The name of the monitor.  Monitor names cannot be greater than 7 characters.  The 
collections within the monitor use the monitor name concatenated with 001 through 
999. 
 
Note: Collection Services monitors are always named STRCSMON and there is only 
1 on a system. 

Library name The name of the library containing the performance data collected by the monitor. 

Collection type Either Job Watcher, Disk Watcher, PEX Analyzer or Collection Services. 

Status  This is either Ended or Active.  If Active it will include the current job status for the job 
running the monitor. 

FTP Definition This is optionally used to send data in the monitor to a remote LPAR.   
In the case of Collection Services, this is required. 

Definition This is the name of the definition used when creating the monitor.   
Note: For Collection Services this is the default collection profile setting on the 
CFGPFRCOL command. 

Collection duration 
(minutes) 

This is the elapsed time that each collection should contain. 

Last active 
collection 

The name of the last active or currently running collection. 

Maximum historical 
collections 

This is the number of collections to retain. 

Description An optional description to give the monitor. 
Note: Does not apply to Collection Services monitors. 

Partitions count If the monitor is collecting data simultaneously over multiple partitions this field 
indicates the number of partitions data is being collected for. 

Start time The date and time when the monitor started. 
Note: For Collection Services this is the time when the currently running collection 
started. 

Maximum collection 
size (megabytes) 

This option indicates the maximum collection size for each collection created within 
the monitor.  This value only applies to Disk Watcher and Job Watcher.   
 
Tip: If this maximum size is reached before the collection duration has elapsed, then 
NO DATA is captured. 

Monitor job That job that is running or ran the monitor. 

ENDPEX data 
option 

This option applies only to PEX monitors and can be one of the following: 
 
1) Create DB files - The data is dumped into the PEX DB files when each collection 
ends 
2) Create *MGTCOL - The PEX data is dumped into a PEX *MGTCOL object when 
each collection ends 
3) Suspend - The PEX data is not dumped and the collection will move to 
suspended status.  After the desired maximum historical collections have been 
created, the PEX monitor will end.  At that point the data must be dumped to 
database files or *MGTCOL objects manually using either the ENDPEX command or 
the Active collections folder within PEX Analyzer. 

 
 

6.5 Start iDoctor Monitor Wizard 
This section describes the interface used when starting (or restarting) an iDoctor monitor.   
Monitors for all types can be started at the same time using this interface if desired.  A separate job is 
used to collect data for each type. 
 
Tip: Data can be optionally sent to another system using an FTP definition. 
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When restarting a monitor, the parameters that were used to last start the monitor are preloaded into this 
interface. 
 

6.5.1 Welcome 
The Welcome page introduces the user to the Monitor. 
 
Selecting Yes on this screen will allow you to pick the partitions to collect data on. 
 

 
 
Pressing Next on the Welcome page shows the Partition Selection screen if Yes is selected on this page. 
 

6.5.2 Partition Selection 
The Partition Selection screen lets the user configure the list of partitions to collect data on.   
 
Tip:  In order to make it easier to analyze the data, the system clocks on the partitions used should be in 
sync. 
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Option Description 

Add Adds the partition name or IP address in the text box to the list. 

Browse Shows a list of IBM i connections to select from. 

Remove Removes the selected partitions from the list 

Load Loads a list of partition names from a text file.  The file should have a partition name 
or IP address, 1 per line. 

Save Saves the current list of partitions to a text file that can be used later via the Load 
option. 

 

6.5.3 FTP Definition 

This screen is used to optionally send data collected by the monitor to another LPAR. 

For Collection Services, additional options exist to control how the data is sent. 
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Option Description 

FTP definition The name of the definition to use or *NONE. 
Tip: Only 1 FTP definition can be used at a time.  If you wish to use a different FTP 
definition for each type of collection, then you will need to use this interface multiple 
times. 

Actions This button shows menu options that can be used against the selected FTP 
definition. 
These options are View, Change, New and Delete. 

Include Collection 
Services 

This indicates that collection services data should be sent to another LPAR based on 
the FTP definition. 

Only CS If this is checked, then none of the additional panels except Finish will appear and 
only a CS monitor will be started. 

Transfer *MGTCOL 
object only 

This indicates that only the *MGTCOL object for the CS collection will be sent.   
Note: This should only be used if the target system is at the same OS VRM or 
newer. 

Run CRTPFRDTA 
on *MGTCOL 

If the previous checkbox is checked, this indicates if the data should be automatically 
created as QAPM* files from the *MGTCOL object. 

 

6.5.4 Basic Options 
This page allows the user to enter the parameters like the monitor name, library, and the type(s) of 
monitors to create.    
None of these settings apply to Collection Services monitors. 
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The following section lists the parameters available on this interface: 
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Option Description 

Monitor name The name of the monitor.  Monitor names cannot be greater than 7 characters.  The 
collections within the monitor use the monitor name plus 001 through 999. 

Library The library name the monitor’s collections should reside in. 

ASP limit This value indicates the maximum allowed ASP percentage used.  If while the 
monitor is running this value is exceeded the monitor will end.   
 
Note: The ASP checked is the same as the ASP that the library resides in.  

Maximum collection 
duration 

Indicates how long each collection should run for (in minutes).   
 
Tip: Ensure that the definitions specified would allow the collection to run for at least 
this long to avoid having gaps in the monitor data where no data is being collected. 

Maximum collection 
size 

This parameter indicates the maximum size to allow for each collection in the 
monitor.  If the size is exceeded, then the collection will stop and there will be a gap 
in the collection data until the monitor starts the next collection in the sequence. 
 
Note: This parameter only applies to Job Watcher and Disk Watcher Monitors.  For 
PEX monitors you will need to change this value in the PEX definition instead.. 

Maximum historical 
collections 

This parameter indicates how many collections the monitor should contain at 1 time.  
As time progresses and this maximum is reached, the oldest collections are replaced 
as new collections are added. 

Run JW active 
collection summary 

If starting a Job Watcher monitor, this option indicates that data should be 
summarized as it is being collected.   
Tip: This is used for the Active Data menu options found under the Job Watcher 
component popup menu. 

Run analyses 
automatically 

If checked, the Run ALL default analyses option will be used.   All default analyses 
will be executed for each collection after it completes.  This is NOT all analyses but 
only a select few that are most commonly needed. 
 
WARNING:  In some situations, this can be very resource intensive and typically 
should not be used on production systems. 
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Submit new JW 
collections on early 
collection end or 
failure 

This optional parameter indicates if the Job Watcher monitor should attempt to 
submit a new collection if it's detected that the current collection has ended 
prematurely (for any reason).  If this option is enabled, a new collection will be 
submitted up to the maximum specified by the max resubmits parameter if the 
current collection has stopped running.  Use caution when using this option; your 
collection may have ended early because of disk space limits.            

Max resubmits The parameter indicates the number of times collections will be resubmitted if the 
previous field is enabled. 

Description A description given to the monitor. 

Collection types to 
start 

The user can collect Job Watcher, Disk Watcher and/or PEX.  If multiple choices are 
selected a different monitor job is started one for each collection type.   

Definition This list provides the definitions available on the current system to pick from of the 
applicable type. 

Actions The definition actions include: 
 
View – Displays the Properties interface for the selected definition. 
Change – Displays the Add Definition Wizard with the selected definition’s 
parameters filled into the interface. 
New – Displays the Add Definition Wizard in order to create a new definition.  
Reload IBM-supplied definitions – Runs a stored procedure to ensure that the 
IBM-supplied definitions are loaded and up to date. 

ENDPEX option The ENDPEX option is only applicable to PEX Analyzer monitors.  It indicates how 
the collections generated by the monitor should be handled by providing 3 options: 
 
1) Create DB files - The data is dumped into the PEX DB files when each collection 
ends 
2) Create *MGTCOL - The PEX data is dumped into a PEX *MGTCOL object when 
each collection ends 
3) Suspend - The PEX data is not dumped and the collection will move to 
suspended status.  After the desired maximum historical collections have been 
created, the PEX monitor will end.  At that point the data must be dumped to 
database files or *MGTCOL objects manually using either the ENDPEX command or 
the Active collections folder within PEX Analyzer. 

 

6.5.5 Scheduling 
This page allows the user to determine how to when the monitor should be started/ended, held or 
released.   
 
Note: This interface does not apply to Collection Services monitors. 
 
To run the monitor right away, click Next. 
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The following section lists the parameters available on this interface: 

Option Description 

Scheduled start 
time 

Use this option to schedule the monitor to start later..   
 
 

Scheduled end time Use this option to schedule the monitor to end at a desired date and time. 

Scheduled hold 
time 

Use this option to hold the monitor at the desired date and time. 

Scheduled release 
time 

Use this option to release the monitor (assuming it’s in a held state) at the desired 
date and time. 

 

6.5.6 Finish 

This screen provides a summary of the monitor that will be started/restart on the current system.   

For your convenience the remote commands that will be executed to start the monitor(s) are listed at the 
bottom of this page. 
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Start iDoctor Monitor Wizard – Finish 
 
The following section lists the parameters available on this interface: 
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Option Description 

Submit job options This button allows you to change parameters on the SMBJOB command(s) used to 
start the monitor(s).   
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7 FTP Definitions 

An FTP definition is used to send performance data to another LPAR.  It is used in the monitor 
commands found in the QIDRWCH library. 

FTP Definitions are stored in file QUSRSYS/QAIDRXDFN. 

These can be created or removed using commands QIDRWCH/ADDFTPDFN and 
QIDRWCH/RMVFTPDFN. 

The FTP Definitions folder shows the FTP definitions found on the current system. 

 

7.1 Menu Options 
The menu options found when right-clicking on one or more definitions in the list are: 
 

Menu Description 

Edit… This option shows the interface used to modify the definition. 
Tip: You can also double-click to open this. 

Add FTP definition Use this option to create a new FTP definition. 

Delete This option removes the selected FTP definitions from the system. 

Properties This option displays a read-only version of the FTP Definition window. 

7.2 Fields 
All columns are shown by default.  You can hide or rearrange columns using the Select Fields… menu 
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Field Description 

Definition The name of the FTP definition.   
 
This doesn’t necessarily need to match the remote system name. 

Description An optional description to give the FTP definition. 

Remote system This is the remote LPAR name or IP address where data will be sent. 

Port The FTP port to use for the transfer.  (1-65535 are valid)   
 
Default: 21  
Secure: 990 
 
Note: This parameter is passed down to the PORT parameter on the FTP command 
on the IBM i. 

Secure connection Specifies the type of security mechanism to be used for protecting information 
transferred on the FTP connection (which includes the password used to authenticate 
the session with the FTP server).  Transport Layer Security (TLS) and Secure 
Sockets Layer (SSL) are compatible protocols which use encryption to protect data 
from being viewed during transmission and verify that data loss or corruption does 
not occur.     
 
Default:  If the PORT parameter specifies Secure or 990, Implicit is used; otherwise, 
None is used.      
 
Implicit:  The FTP client immediately attempts to use TLS/SSL when connecting to 
the specified FTP server (without sending an AUTH subcommand to the server).  If 
the server does not support implicit TLS/SSL on the specified port, or the TLS/SSL 
negotiation fails for any reason, the connection is closed.        
 
SSL:  After connecting to the specified FTP server, the FTP client sends an AUTH 
(authorization) subcommand requesting a TLS/SSL protected session.  If the server 
supports TLS/SSL, a TLS/SSL negotiation performed.  If the server does not support 
TLS/SSL or the TLS/SSL negotiation fails, the connection is closed.             
 
None:   The FTP client does not use encryption when connecting to the specified 
FTP server.                            
 
Note: This parameter is passed down to the SECCNN parameter on the FTP 
command on the IBM i.                               

Target release This indicates the release of the IBM i you intend to transfer the data to. 

Targe library This is the library on the remote LPAR where data will be sent. 

Remote collection 
delete offset 

This is a positive or negative number indicating which collection to delete on the 
remote system in relation to the current one beyond the current system's number of    
collections to retain.  Does not apply to Collection Services, only JW/DW/PEX.    
 
For example. if normally 5 collections are retained, make this value 3 to retain 8 
instead on the remote system, or -3 to retain 2.                              

Delete local 
collection after 
restore? 

This value indicates if the collection on the local system should be deleted after it has 
been successfully transferred and restored.   
Does not apply to Collection Services, only JW/DW/PEX. 
 
Note: If this is set to *YES, this option requires that another collection already exists 
in the library where data is being collected NOT matching the monitor.  Otherwise, 
when the local collection is deleted the performance database files will be deleted as 
well, and future save/restores will fail on the target system saying the files where from 
a different version. 

Data compression Specifies whether data compression is used.  If the save is running while other jobs 
on the system are active and software compression is used, the overall system           
performance may be affected.                   
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The choices are: 
*NO      
*YES     
*LOW     
*MEDIUM  
*HIGH                

Change timestamp This is the time when the FTP definition was last changed. 

Log output If Y is specified, then the remote job name used to do the transfer will be saved to 
the local logfile (QIDRGUI/FTPLOG).  This will only work if program                  
QIDRGUI/QIDRGETJBI exists on the remote system.           

Function Should always be P.  (*PUT option on QIDRGUI/FTPFILE)   

User The name of the user profile to use when doing the transfer. 

App ID Specifies the name of the application identifier to use when using Secure Sockets 
Layer (SSL) protection.  The client application identifier must be configured in the   
Digital Certificate Manager (DCM) application database.   
 
*DFT                                                   
    The system supplied default client application     
    identifier QIBM_QTMF_FTP_CLIENT is used.           
character-value                                             
    Specify the DCM configured client application ID.  The  
    first character of the application identifier must be   
    an uppercase character ('A' to 'Z'); the remaining      
    characters can be alphanumeric (uppercase 'A' to 'Z'    
    or digits '0' to '9').  You can also use a period       
    ('.') or underscore ('_').                              

Pre-transfer 
command 8-10 

These are additional commands that will be ran on the remote system before the 
transfer occurs. 
Note: commands 1-7 are reserved for iDoctor use. 

Post-transfer 
commands 18-20 

These are additional commands that will be ran on the remote system after the 
transfer occurs. 
Note: commands 11-17 are reserved for iDoctor use. 

 

7.3 FTP Definition Window 
This interface is used to create a new FTP definition or modify/view an existing one. 

This is an interface over the QIDRWCH/ADDFTPDFN command. 

Regarding delete local collection after restore option:  STRPAMON/STRDWMON/STRJWMON with 
an FTP definition using DLTLOCAL(*YES) will only work properly if the source system has an existing 
collection in the library being used (not named the same as the monitor). 
Otherwise, when the local data is deleted after the 1st collection is transferred/restored, DLTPFRCOL will 
delete the perf files and the next recreated collection will be unable to be restored on the target system 
due to a possible bug in RSTPFRCOL.   
 
Job log says the source and target are not at the same code level.  Using RSTOBJ with 
ALWOBJDIF(*ALL) will copy / replace certain files which obviously won’t work for this so best to avoid 
deleting the source collection files if you want to use DLTLOCAL(*YES).  (i.e.)  It won’t work on a clean 
library with nothing in it to start with. 
 
The password must be reentered each time changes are made using this interface. 

See the previous section for more information about the data to supply on this interface. 
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8 Preferences 

The Preferences window allows a user to work with the customizable options in the GUI.  Several 
different categories of options are available.   
 
The Preferences window is accessible via the Edit -> Preferences menu in the Data Viewer or from the 
Main Window.  

8.1 Display 
The Display page on the Preferences window lets the user work with options that effect the visible 
presentation of table or graph views in the IBM iDoctor for IBM i client. 
 
An example of this interface is shown below: 

 
 

The options available on this page apply to either table views or graph views and each have their own 
section. 
 
Title format options:  Use these options to identify how the titles of iDoctor reports should be named.  A 
different format can be used based on the type of graph or report.  The dropdown list contains several 
different possible name formats.  Other possible titles are available by modifying the value in the list and 
including any of the tabs listed below in <>. 
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<system> - The current system the data resides on 
<collection system> - The name of the system the collection was created on (if known). 
<library> - Library name for the collection 
<library desc> - Description for the library 
<collection> - Collection name 
<collection start> - time the collection started (if known) 
<collection end> - time the collection ended (if known) 
<report name> - The report description. 
 
 

Table Views 
Options 

Description 

Column 
headers 

This drop down lets the user determine if field descriptions or short (SQL generated) field 
names or both should be displayed in the column headings for of all table views.   
 
The choices are: 

- Display field names 
- Display descriptions 
- Display descriptions and field names 

Note:  Field names will be displayed if the descriptions are not available within the report 
being viewed. 

Display 
thousands 
separators 

This option will display thousands separators (as commas) for numeric fields in the table 
views.  (i.e.  1000 will be displayed as 1,000) 

Right-click  
headers 
displays filter, 
sort options 

If checked, right-clicking columns headers in tables shows a menu with options instead 
of sorting the table in descending sequence. 
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Graph Views 
Options 

Description 

Default time 
grouping 

This option allows the user to control the default time grouping for all time interval 
graphs in iDoctor.  This option can be used to summarize many thousands of 
intervals in the data into a smaller set of bars in order to graph all of the data onto a 
single screen.   
For example, if you have 1000 1 second intervals in the data, and you pick 1 minute 
intervals as the time range size, you will end up with a graph of 17 bars summarized 
together instead of 1000 (the collected interval size). 
 
The available options are: 

 
Force use This checkbox is only available if the default time range size is set to the Collected 

interval size.  If checked (the default), then the collected interval size option is used 
instead of the minimum detected interval size (such as 5 min intervals in a CSI 
collection.)   This mainly causes slight differences in the look of the X-axis label 
depending on if checked or not. 
 
Force use checked: (includes interval number and seconds on the timestamp) 

 
Force use unchecked: (includes month/day) 

 
 

Show ms If checked, then collected interval size x-axis labels will include millisecond 
granularity. 

Bars per page - 
vertical 

Indicates how many bars (or points if the graph is a line graph) should be displayed 
per page in a graph.  Up to 5000 bars per page are allowed although realistically you 
should get this number down to perhaps 300-500 max.   
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Note: Unless your monitor can display 5000 pixels it will be impossible to physically 
display that many bars/points.   This also greatly consumes GDI objects which 
means you won’t be able to open very many graphs at a time per iDoctor session 
and it also will slow down GUI response time. 

Bars per page - 
horizontal 

Indicates how many bars (or points) should be displayed per page in a horizontal bar 
graph.  Up to 300 bars per page are allowed. 

Enable automatic 
scaling 

Indicates if the graph should automatically resize the scale on the Y-axis each time a 
new page is opened.  If this option is turned off the scale will be fixed based on the 
maximum and minimum values of the first page of the graph when it is opened. 

Patterns When checked, graph patterns or hatchings will be displayed to fill bars instead of 
solid colors.  The graph patterns are configurable using the Primary Y-axis panel of 
the graph definition interface. 

Widgets Indicates if widgets (shapes) will be added to points on lines shown on the Y2-axis of  
graphs.  This primarily is used in iDoctor to indicate options to allow for drilling down 
between one component to another. 

Situations This preference indicates if situation background colors will be displayed on the 

graph.  You can also control this option by using the  button on the Main Window 
toolbar. 

Contrast situations If checked, CSI and JW 'situations' will be displayed on the graph as the opposite of 
the Y1 setting for patterns.   
 
If patterns are in use, then solid background colors are used for situations.   
If solid colors are used for the bar graph then situations will be patterns. 

Width % This determines how wide each situation background is drawn as a percentage of 
each bar's width.  50% must be used if you wish to display a max of 2 situations per 
bar.  25% is used to display a max of 4 situations per bar.  Note: In the case when 
each bar is only 15 pixels or less wide then this setting is ignored. 

Always show the 
legend 

Indicates if the graph legend should always be shown when the graph is first opened.  
If checked this will override the option in some IBM-supplied graph definitions that 
indicates the graph legend should not be shown. 

Legend width 
percent 

Indicates what percentage of the graph window the legend should consume by 
default.  For example, if this value were 50%, graphs would be displayed with the 
graph on the left and the graph legend on the right with equal size. 

X-axis label length 
limit 

Indicates the maximum number of characters to include in X-axis labels.   
Different values are given for horizontal or vertical bar graphs. 

 

8.2 Display – Advanced 
This page contains less frequently used option related to the display of graphs.  It also contains options to 
control the fonts used in lists, trees, editors and log files. 
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The options available on this page are: 
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Option Description 

Enforce legend 
width percent on 
resize 

Check this option if you want to have width percentage of the graph legend shown be 
automatically adjusted each time the graph view window is resized.   
 
Note:  If this option is checked then adjusting the percentage of the legend that is 
shown manually is not possible. 

Automatically 
resize fonts and 
adjust labels 

This option controls whether or not the fonts and labels should be automatically 
resized and adjusted (recommended on). 

Show X-Axis values Indicates if labels for the X-Axis values should be displayed. 

X-axis font size Indicates the font size to use for values on the X-Axis.  The higher the number the 
larger the font will appear. 

Show Y2-Axis (if 
available) 

Indicates if the Y2-Axis (the secondary Y-Axis) should be displayed. This axis is not 
used on all graphs. 

Y1/Y2 axis font size Indicates the font size to use for values on the Y-Axis.  The higher the number the 
larger the font will appear. 

Minimum bars 
needed to perform 
zoom 

This option can be used to change how many bars are needed to perform a zoom 
operation.  If this value is set to a small number, then it will be more likely that the 
user will accidentally perform a zoom. 

Mouse wheel scroll 
percentage of total 
bars 

This option is used to change how much of the graph to scroll when the mouse wheel 
is used.   

Use normalize 
graphing option 

Indicates if the graph normalize option should be used when the graph is first 
opened.  This option divides each time value by the interval’s duration to provide a 
flattening effect to bar heights in the graph.  This option is only available for the 
vertical bar time range graphs. 

Use variable-width 
bar graphing option 

Indicates if the graph variable-width bar option should be used when the graph is first 
opened.  This option draws longer duration intervals with wider bars.  This option is 
only available for the vertical bar time range graphs. 

Sort CSI Graph 
History data in 
ascending time 
sequence 

Check this box if you prefer to see graph history data in ascending sequence (oldest 
data first.) 
 
Note: By default, data is shown newest data first when using CSI – Graph History 
data only. 

Font for lists/trees This font is used for lists and trees.   

Font for editors/logs This font is used for things like the SQL editor, when opening a file from the IFS and 
displaying the results, displaying a PEX definition, and displaying some error 
messages.  

 

8.3 Clipboard 
The Clipboard page on the Preferences window lets the user work with the 'Copy to Clipboard' options 
available for table views in iDoctor. 
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Option Description 

Text format Select the desired text format when copying records or cell selections to the clipboard.  
The possible choices are: comma separated, tab separated, rich text format and 
HTML. 

Include field 
headings in 
copied data 

Check this option to indicate that field headings (column descriptions) should be included 
as the first record of data when copying data to the clipboard. 

Use multiple 
lines 

This option only appears and applies when the Include heading option is checked and 
the Text format is *.csv or *.txt. 

 

8.4 File 
The File page on the Preferences window lets the user work with options related to creating output files 
from a table view's data. 
 

 
 
 

Option Description 

Include field 
headings in 
output file 

Check this option to indicate that field headings should be included as the first record(s) 
of data when generating the output file.  If this option is checked the user may choose to 
use short field names or long descriptions in the output file.  To generate an output file 
use the File -> Save -> View As... menu for an active Table View in the Data Viewer. 

Use multiple 
lines 

This option only appears and applies when the Include heading option is checked and 
the Text format when saved is *.csv or *.txt. 
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8.5 Scheduling 
The scheduling page allows you to define the default start time when scheduling collections in iDoctor.  
The default is 1 hour from the current date and time. 

 

8.6 Confirm 
This page contains a set of preferences to control whether you are prompted for confirmation before 
performing various actions in the GUI. 
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Option Description 

Check for new 
builds… 

This option will check for a new build each time the GUI is started and if a new 
version is available you will be prompted to download and install it.   This feature 
will only work if a connection to the internet is available. 

Check for .NET when 
starting the GUI 

This option will check for the required level of .NET when starting the GUI.  If not 
found, then you will be prompted to install it.  
 
If the required level does not exist, then some functions in the Power Connections 
interface will not work. 

Check for IBM i 
Access Client 
Solutions… 

This option will check for the required level of IBM i Access Client Solutions (ACS) 
when starting the GUI. 
 
Note: Installing the IBM i Access Client Solutions Windows Application Package 
is REQUIRED! 

Confirm when closing 
Data Viewers 

Indicates if the user should be warned before closing a Data Viewer.  If unchecked 
and a Data Viewer is closed all views within it are shut down without confirmation. 

Confirm when ending 
iDoctor GUI 

Indicates if the user should be warned before closing the iDoctor application.  If 
unchecked and the application is ended (close main window or Use File ->Exit 
menu) then all Data Viewers and views within them are shut down without 
confirmation. 

Confirm when 
stopping the Report 
Generator function 

Indicates if the user should be warned before stopping the reporting generator 
function while it is in progress.   Closing the Data Viewer the reports are being 
loaded into is the method for stopping this function. 

Confirm system name 
when opening new 
SQL editor 

When opening a new SQL Editor, the default action is to prompt the user for the 
desired system to open the editor for.  By unchecking this option the system will 
default to whichever system the user is currently working with. 

Confirm ASP 
selection when 
opening disk graphs 

If checked and opening disk graphs in CSI, DW or PEX that contain data from 
multiple ASPs, you will be prompted for the desired ASP to view the data for. 
 
From this window you will be able to select either a specific ASP or all of them if 
you desire.  Typically for time interval and disk unit ranking graphs performance 
experts prefer to segregate the data ASP rather than averaging data together 
across the various ASPs. 
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Confirm when closing 
tables or graphs that 
have dependent 
property sheets 

This option indicates if you should be prompted when closing a graph or table that 
has child windows opened associated with it that also must be closed at the same 
time.   

Confirm usage of 
query definition if SQL 
contains comments 

This option will prompt you if the current SQL statement contains comments and 
you wish to use the Query Definition interface instead of the SQL editor to modify 
the query.  The comments and formatting are lost when using the Query Definition 
interface. 

Prompt for time 
filtering options when 
running most PEX 
and some JW 
analyses 

If checked, the user will be presented with a screen to allow them to filter the time 
range to include in most PEX Analyzer analyses and some in Job Watcher. 

Confirm if Analyze 
Collections window 
will be shown when 
using Run ALL default 
analyses 

When using the Analysis option Run ALL default analyses this option will indicate if 
the Analyze Collection window will be shown first so the user can pick and choose 
which individual analyses to run. 

Confirm if IFS 
repository scripts 
should be installed 

If checked, you will be notified if the IFS scripts are out of date and will be asked if 
the latest version should be installed.  Depending on the FTP settings and 
environment this option may fail so this option is provided to avoid this message. 

Confirm if Collections 
folder should be 
opened… 

This option will prompt you when opening the Collections folder in CSI or JW if 
more than 3 libraries exist in the generic name value provided from the Filter 
Libraries pane. 
 
Tip: The maximum libraries displayable in the Collections folder is 25. 

Confirm before 
running Change 
sensitive user data 

This indicates if a prompt if shown before running the Change sensitive user data 
analysis. 

Change report 
visibility mode when 
starting iDoctor 

This setting either disables/enables the prompt about the report visibility setting 
(basic, detailed, advanced) at startup. 

Confirm before 
emailing reports in the 
Report Generator 

This indicates if a warning is shown before running the Report Generator if the 
email option is selected in preferences.   

 

8.7 SQL 
This page contains a set of preferences related to the ODBC driver, SQL statement processing, field and 
row limits and CHGQRYA defaults on the IBM i to use. 
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Option Description 

Disable file/member checks 
when running SQL 

By keeping this option checked it will improve performance but 
potentially cause errors if data is missing. 
 
This is mostly obsolete now with the new collections database (added in 
2021) and may be removed later. 

Disable field info retrieval when 
running SQL 

In older versions of iDoctor, each file encountered in an SQL statement 
would cause APIs to be called to retrieve all field information.  This was 
helpful but hurts performance.  Uncheck this to have the most possible 
field column descriptions available, but at the cost of slower performance 
in the GUI. 

Enable ODBC – EXTCOLINFO 
setting 

This is used to get field descriptions from the ODBC driver instead of 
using IBM i API calls if the previous setting is unchecked.  Checked by 
default and recommended. 

Enable ODBC – XDYNAMIC 
setting 

This is an option on the ODBC driver for extended dynamic support but 
has not been tested or supported. 

Enable ODBC – TRACE This enables various trace options on the ODBC driver when debugging 
issues but are not tested or supported. 

Include all ODBC calls in 
iDoctor Messages View 

This will report the status of every ODBC API call done by the GUI in the 
iDoctor Messages View.   

Disable running SQL 
statements in background 
threads in GUI interfaces 

This will turn off the multithreading support in the GUI.  This is not 
recommended, your GUI session will hang during long running 
operations, but this is available in case of problems are encountered 
relating to multithreading. 
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Maximum text field bytes to 
retrieve 

This value represents the maximum number of bytes to retrieve for any 
text field in an SQL statement (32K max).  Keep in mind that specifying a 
very large number for this value can result in more fetches being 
required and slower responses from the GUI.  Note: This value * max 
row set size preference cannot exceed 512K bytes. 
 
Note: It certain functions, this limit is exceeded automatically for usability 
reasons.  In other functions like viewing data within a table, data will be 
truncated when this limit is exceeded.  In table views a blue column 
heading indicates that the data in that column has been truncated. 

Maximum rows per fetch (IBM i) This value is the maximum number of rows to load per ODBC fetch.  
This is also used to indicate how many rows are skipped/jumped when 
using the Previous Row Set or Next Row Set buttons on the toolbar to 
navigate through data.  Note: This value * max text field bytes 
preference cannot exceed 512K bytes. 
 
Note: Due to problems in the ACS ODBC driver this value should 
generally not exceed 200 unless this has been fixed later. 

Maximum rows per fetch (MS 
Access) 

This value is the maximum number of rows to load per ODBC fetch when 
loading data from iDoctor’s mdb databases.  This has not been well 
tested with large values. 

Minimum rows per fetch (IBM i) This value is the minimum number of rows to load per ODBC fetch.  It 
should generally match the same value as maximum rows per fetch and 
different settings has not been well tested.   

Display Create Stored 
Procedure SQL script progress 

Indicates if the user should be able to view the progress of stored 
procedures being created when connecting to a system.   

Use RUNSQLSTM to create 
stored procedures at startup 

This option is used to speed up the creation of any needed stored 
procedures when the GUI starts by building a list of SQL statements and 
having it run on the server via the RUNSQLSTM command.  
 
Note: This requires a working FTP connection, or this process will fail. 
 
Otherwise, these statements will be processed one at a time in the GUI 
either in the Remote SQL Statement Status View or within the GUI 
thread.  

Use SQL_FETCH_RELATIVE This is for IBM debug use only and should not be used.  It is used to 
improve performance when scrolling through large data sets but may 
cause incorrect results.  There are problems with the ODBC driver. 

Override client code page 
setting with 

Check the box only in rare cases when the iDoctor GUI is unable to 
translate API calls or data sent/received using IBM i Access for Windows 
or IBM i Access Client Solutions.   Work with support for assistance with 
this setting. 

Change query attributes options These options control additional advanced preferences for how the query 
should be ran.   
 
*JOBCTL special authority is required in order to use them. 
 
Tip: The Options file configure button allows a few of these QAQQINI 
options to be overridden when using iDoctor. 
 
See the CHGQRYA command for more information on these settings. 

 

8.8 Data Viewer 
The Data Viewer tab in the Preferences window lets the user work with options only related to the Data 
Viewer window within iDoctor. 
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An example of this interface is shown below: 
 

 
Preferences - Data Viewer 
 
The options available on this page are: 
 

Option Description 

Always open new 
reports into an 
existing Data Viewer 

If checked and opening iDoctor tables/graphs, an existing Data Viewer will be used 
if one is available. 

Segregate reports in 
Data Viewers 

3 options are provided to control which Data Viewer a newly opened report will go 
into (if not otherwise specified): 
 
Never - Use this option if you do not wish to group your reports by LPAR names. 

 
By LPAR names - Use this option if you wish to group your reports by LPAR 
names.  Two LPAR names will be shown in this format [current system / collected 
on system]. 
 
By LPAR names / library name - Use this option if you wish to group your reports 
by LPAR name and library name.  Two LPAR names will be shown in this format 
[current system / collected on system].  The library name on the current system 
where the data resides will also be shown. 

Maximize reports 
opened into Data 
Viewers 

When checked every view opened into a Data Viewer is maximized.    
Tip: This only applies if the MDI tabbed style is set to None. 

Maximize Data 
Viewers 

This option indicates if Data Viewers should be automatically maximized when 
they are opened. 
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Auto refresh reports 
for active collections 
every N seconds 

This option lets the user specify how often to auto refresh reports in the Data 
Viewer that are over currently active collections.   
 
Note: only the report with the current mouse pointer focus will get refreshed every 
N seconds. 

Always display (scroll 
to) new data after 
refresh 

This option indicates that after an auto refresh occurs the scrollbar should be 
adjusted to scroll to the end of the table or graph.  This can be useful if new data is 
consistently being added to the end of the report. 

Override to collected 
interval size time 
grouping 

Normally the overtime graphs will honor the default time range size preference.  
However, if this option is checked, when opening a graph showing a single 
job/thread over time, the time range will always be set to the collected interval size. 
 
Note: This option is checked by default. 

Cache popup menus 
in memory 

This option is used to improve performance when building drill down menus in the 
Data Viewer, but has not been well tested. 

Sort disk rankings 
graphs by 

This option controls how disk graphs are sorted in CSI, PEX and Disk Watcher.   

Show situations 
information before 
opening graphs 

This indicates if the Situations found in a collection are displayed in the graph 
background as a graph is loaded in both CSI and JW. 

Name length for 
generic name 
grouping graphs 

This option can be used to indicate how many characters of the name to use for 
the generic name graphs shown in iDoctor and also the start position within the 
name to use.  This option can apply to job names, disk resource names, etc. 

Tree table indentation 
pixels per level 

This option indicates how much indentation is used in the tree tables per level. 
The value provided is in pixels. 

 

8.9 Misc. 
This page contains a set of preferences to control some miscellaneous features. 
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Option Description 

Maximum collections 
for library-level 
graphs 

This indicates the maximum number of collections that can exist in a library in 
order for the library popup menu graphing options to appear.  Keep in mind the 
larger this number, the more complex and slower the SQL statement will be. 

Exclude system 
names from window 
titles 

This option is used to remove system names from the window titles shown in 
iDoctor.   

Show non-modal 
property pages in a 
view 

Indicates if property pages should be shown in a view. (Recommended)  If this is 
not used property pages for interfaces such as call stacks will appear outside of 
the bounds of the Data Viewer window and drill down options from the call stack 
will appear behind the call stack (or inside of the Data Viewer). 

Display update history Indicates if the iDoctor Update History screen should be shown when starting the 
iDoctor client.  This panel lists the most recent changes made to iDoctor. 

Display splash screen Indicates if the iDoctor splash screen with copyright notice is shown when iDoctor 
is started.   
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Option Description 

Always run analyses 
in a batch job 

This option will cause the Analyses -> Run Analysis XYZ menu options to always 
run the analysis in a batch job instead of the Remote SQL Statement Status View. 
 
If you are working with large collections this may be preferred. 

Keep connections 
alive 

This option can be used if connections are regularly dropped on your network to 
keep your iDoctor connections alive by sending small requests over all iDoctor 
connections at the specified time interval (in minutes.) 

Verify IBM I 
connections 

This does extra checks when first connecting to an IBM i.   
Uncheck this to improve performance. 

Enable developer 
mode 

This option is intended by used by iDoctor development only. 

Maximize the Main 
Window 

This option if checked will always maximize the iDoctor Main Window when the 
GUI starts. 

Set QIDRGUI library 
owner to QSECOFR 

In some environments, this may be necessary to avoid problems when trying to 
analyze nmon data. 

Enable debug logging 
to C:\temp 

If checked, each iDoctor session will create a log file in C:\temp.  This should only 
be enabled when debugging issues. 
 
This can slow down the GUI a bit. 

Log SQL statements 
to remote systems 

If checked, then the debug logging will include SQL statements to IBM i. 

Log SQL to .MDB If checked, then the debug logging will include SQL statements to the local MS 
Access databases on the PC. 

Maximum number of 
collections to display 

These options are used to control how many collections are returned when 
displaying a list of collections in a library or other type of containing folder.   
 
This is most useful in cases where you have performance delays building lists of 
collections and only need to see the top N collections.   
 
Note: With the redesigned collections database, the maximum collections any 
library can display is now 500. 

 
 

8.10 Send to IBM 
This page contains a set of preferences to control how data will be sent to IBM.  These settings apply to 
the Transfer to IBM functions.    
 

Tip: In order for the Use QMGTOOLS FTP2IBMCMD *IBMSDDUU option to be successful, your 
password must have been previously set on the IBM I using the GO MG menu option 25 (STORFTPPWD 
command.)  Afterwards, within this interface the IBM ID/password fields should be set to *STORED and 
blank  
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Option Description 

Support case # This value will be prefilled on the Transfer Collections window. 

IBM ID / password If using QMGTOOLS/FTP2IBMCMD to send data to IBM, the IBM ID value should 
be *STORED and password should be blank.  
 
If not using QMGTOOLS, then these values are used to make the connection to 
IBM using QIDRGUI/FTPFILE command. 

 

8.11 Terminal Sessions 
This tab contains a set of preferences related to IBM Personal Communications (PCOMM) as well as IBM 
i Access Client Solutions terminal (green screen) sessions. 

 

 

The options available on this page are: 
 

Options Description 

Sessions directory This is the localion where .ws files are stored that iDoctor should utilize. 

PCOMM directory This is the directory where IBM Personal Communications is installed.   

ACS launch string This is a copy of the ACS launch string used when starting green screen sessions. 
It is stored in the Windows registry but listed here to your awareness.  Be careful 
with changing this value. 
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8.12 Power 
The Power page on the Preferences window lets the user work with options that only apply to non IBM i 
systems (HMC or VIOS.) 
  

 
 

Option Description 

Create at startup If checked, then the Power Connections View will be created when the iDoctor GUI 
starts. 

Display at startup If checked, then the Power Connections View will be initially shown at startup 
rather than displaying the IBM i Connections View when the iDoctor GUI starts. 
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VIOS Investigator Description 

Include debug 
messages in job log 
when creating a disk 
mapping 

When running the VIOS to IBM disk mapping this option can be used to add extra 
information to the logs for IBM support purposes. 

Provide ASP filtering 
options 

When disk graphs are opened, indicates if the ASP filtering options will be shown 
to the user.  This means a window will be shown allowing the user to select the 
desired ASP(s) to graph before the graph is opened.   
 
Note: NMON data collected on a VIOS will sometimes contain disks that are not 
used and not included by the LPAR the disk mapping was created at.  Therefore 
using this option will either exclude these disks or (if disabled) include them. 

Disk name filter This option allows the user to select whether all disks will be shown on the disk 
graphs or only EMC/Powerpath will be shown or EMC/Powerpath will be excluded. 

Script directory The VIOS directory where the iDoctor scripts should be installed to.    

Data directory This VIOS directory indicates the default location where iDoctor created data 
should be stored.    

 

Option Description 

Display hidden files 
and directories 

When listing directories on VIOS, this option controls whether hidden files and 
directories are displayed.  

Show Java debug 
windows 

Java is used under the covers by the GUI to communicate via SSH to HMC and 
VIOS.  This option allows you to see these windows. 

Hide inactive disks Removes inactive disks from the disk mapping report. 

Java options These options are added to each java command/session started by the iDoctor 
GUI. 
 
In some environments, the SSH connections may fail if these default settings are 
not used: 
 
-Djava.net.preferIPv4Stack=true -Dcom.ibm.jsse2.disableSSLv3=false 
 
Note: In order to debug the SSH connections add the following to this field: 
-Dcom.ibm.ssh.trace=true 

Putty install directory This path should indicate the directory where Putty has been installed. 

  
 

8.13 Tips 
The Tips tab on the Preferences window lets the user work with preferences related to tooltips that 
appear in dialogs, wizards and property pages. 
 
Note: Tables and lists use tracking tooltips by design that are shown immediately when needed and 
these settings do not apply to them. 
 



IBM iDoctor for IBM i  

 

 

Tip delay times Description 

Initial delay time The amount of time (in milliseconds) the mouse pointer must remain stationary 
before showing a tooltip/flyover in a window for the first time. 

Visible time The amount of time (in milliseconds) the tooltip window will remain visible if the 
mouse pointer remains stationary. 

Reshow time The amount of delay time (in milliseconds) before showing subsequent tooltips. 
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Option  Description 

Maximum characters 
to display 

This is the maximum number of characters that should be displayed in an iDoctor 
tooltip. 

Maximum tooltip 
width 

Maximum number of pixels wide for tooltips. 

Include all non-zero 
Y2 fields in graph 
flyovers 

If checked, when viewing graph tooltips, then all Y2 fields (that are > 0) will be 
displayed.  Otherwise only the Y2 field that has current focus will be shown in the 
tooltip/flyover. 

Only include 
numbered flyover 
fields that match the 
current selection 

Include only numbered flyover fields (fields that are named XYZ_01, XYZ_02, etc) 
that match the current selection in graph flyovers.  i.e.  If enabled and field 
ABC_02 is selected, then XYZ_02 is shown and not XYZ_03. 

Include detailed job 
descriptions… 

This controls whether details about the job name is included in tooltips in Job 
rankings graphs. 

Disable tips options These options allow the user to customize if tooltips should be disabled for 
different parts of the GUI. 

 

8.14 MDI Tabs 
The MDI Tabs page on the Preferences window lets the user work with preferences related to the MDI 
Tabs style interface.  
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MDI Tabbed Style Use this option to change the current MDI tabbed style being used.  There are 3 
styles of MDI tabs available in iDoctor: 

• None – this is a classic Windows MDI without tabs 

• Standard – allows users to tile and cascade but you cannot create groups of 
MDI tabs to compare with other tabs. 

• Grouped – Tabs cannot be tiled or cascaded but you can create groups of MDI 
tabs in order to make comparisons. 

 
Tip: This can also be set under the View menu -> MDI Tabbed Style. 

 
Note: The rest of these options do not apply if the MDI Tabbed Style is set to None. 
 

Option Description 

Show close button on 
label of the active tab 

If checked, then the close button will be visible on the active tab.  If unchecked 
then the close button will be placed at the far right-side of the tabbed group. 

Use colors on the 
MDI tabs 

If checked, then automatically assign a color to each tab opened. 

Each tabbed group 
provides a popup 
menu 

If checked, then a popup menu to show all opened views in the tabbed group will 
be available on the right-side of each tabbed group.  If unchecked, then a left and 
right arrow buttons can be used to navigate through the open views. 

Allow tab swapping 
via drag and drop 

If checked, then allow tabs to be reorganized within a tabbed group via drag and 
drop. 

Display icons on MDI 
tabs 

If checked, then icons will be displayed on each tab. 

Display tab labels at 
the bottom 

If checked, then the tabs will be displayed at the bottom of each tabbed group 
rather than at the top. 

Move Remote 
Command Status 
Views to bottom of 
Main Window if using 
grouped mode 

This option will automatically move the Remote Command Status View and 
Remote SQL Statement Status View to the bottom of the main window if checked 
when grouped MDI tabbed style is enabled.  If this option is unchecked, then the 
tab will be created when needed and occupy the entire visible area of the Main 
Window. 

 

8.15 Report Generator 
This tab is used to control preferences related only to the iDoctor Report Generator.  You can access this 
function by right-clicking on most types of collections in iDoctor and using the Generate Reports menu. 
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Option  Description 

Report directory This indicates the location where iDoctor Report Generator files should be 
generated.     

Save as PDF If checked, the report generator will be a PDF instead of an HTML file + additional 
JPG images.   

Email reports to This option when checked will send the report generated to the email address 
listed. 
 
This requires Outlook to be installed on the PC.  Manual setup in Outlook is also 
required and iDoctor must be launched as the administrator.  The Outlook setup 
steps are:  
 
 a.  In the outlook search box type macros, then click on Run Macros in the list 
 b.  In the macros popup, if no macros exist, type a name like "test" and click 
Create or if a macro exists, then click it and use the Edit button instead. 
 c.  Within the Visual Basic for Applications window, use the File -> Import File 
option, then navigate and select the SendiDoctorMail.bas file which is located in 
the directory where iDoctor was installed with 1548 or higher. 
 d.  This will load the SendiDoctorMail macro into your outlook installation. 
 e.  In the outlook search box type "security" and click Security action. 
 f.  In the Trust Center window, under Macro Security you will need to select 
Enable all macros. (or digitally sign the SendiDoctorMail macro yourself instead.  
 
Note: When auto emailing the PDF from the report generator this requires that any 
open instances of Outlook will be closed after the report generator is finished in 
order for the macro to successfully work and send the email.  

Pages to capture (per 
report) 

This is the number of pages/screenshots to capture per graph or table.  If the 
amount of data in the report cannot be shown on a single page and this value is 
greater than 1, this means the data will be scrolled and an additional screenshot 
taken N times. 

Debug mode / Test 
DTL 

IBM use only. 

Delete report 
directory 

This option will delete the report directory and everything in it. 

Run report N times IBM use only. 

Multiple collections 
graphed individually 

If checked and if selecting multiple collections before running the Report Generator 
this option will cause the graphs to be created once for each collection rather than 
combining the data into a single graph. 
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Option  Description 

Default time range 
size 

This option indicates the default time range grouping to use for the report 
generator graphs.  You may wish to use a larger value here than you would 
normally so more data from the collection will be summarized and visible on a 
single page/graph. 

Bars per page – 
vertical bar graphs 

This is the max number of bars to show on vertical bar graphs.  If you wish to show 
more data on a single graph another option is to increase the default time range 
size to a larger value. 

Bars per page – 
horizontal bar graphs 

This is the max number of bars to show on horizontal bar graphs.  If you wish to 
have the labels visible next to each bar, then it is best to keep this value fairly 
small (10-40.)  

Provide 1 graph for 
each ASP 

This option is used for disk graphs that contain multiple ASPs in the data.  If 
checked for those types of graphs then a screenshot will be generated for each 
ASP, per report selected. 

Patterns This option uses hatchings in addition to colors to aid those with color-blindness. 

Situations This option indicates if the situational analysis background colors will be displayed 
on the graphs or not. 

Always show the 
legend 

This option simply indicates if the legend shall be shown or not. 

Legend width percent 
(0 to 50) 

This option indicates how much (as a percentage) of the graph window the graph 
legend shall consume.  It only applies if the “Always show the legend” option is 
checked. 

Graph 1st default drill-
down 

For each report opened, the 1st default (right-click on 1st bar in graph) option will 
be taken and also captured. 

Graph 2nd default 
drill-down 

For each report opened, then a 2nd (1st default option) graph is opened and 
captured.  This typically is used only when the 1st default option is also checked. 
For an overview graph included in the Report generator checking both options 
would mean capturing all 3 graphs for Overview, Rankings and Selection over 
time. 

 

8.16 KB 
These preferences apply to the Knowledge Base component. 
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Option  Description 

Local files directory This directory indicates where the local files will be stored on the PC relating to the 
Knowledge Base.  A KB subdirectory will be created. 

Default owner When creating a KB doc, this value is used as the owner by default. 

Default interested 
parties 

When creating a KB doc, this value is used for the interested parties field by 
default. 

Outlook email 
settings 

 

Label color (hex 
RGB) 

This a RGB color in hex.  The format must be #RRGGBB. 

Text color (hex RGB) This a RGB color in hex.  The format must be #RRGGBB. 

Label size HTML font size for labels 

Text size HTML font size for text 

Include PDF when 
using Update and 
Notify 

Indicates if a PDF attachment should be included in the email containing the KB 
document. 
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9 IBM i Explorer 

This section covers the free IBM i Explorer component.  This provides functions to access many areas on 
the system including the IFS, libraries, and objects. 

This section covers the interfaces specific to IBM i connections.  For Power (non-IBM i connections), the 
interface to work with file systems/directories is discussed in the document on Power Connections. 

This interface can be launched in two ways: 

1) Double-click the IBM i connection and it will exist in the iDoctor components window: 

 

2) From the IBM i Explorer folder within another component. 

 

Job Watcher -> IBM i Explorer folder 

 
The contents of the IBM i Explorer folder are described in more detail in the next sections, but high-level 
descriptions are described in the table below. 
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Folder Description 

System The system folder contains options that pertain to the entire system including: 
- System status metrics (like WRKSYSSTS) 
- System operator messages 
- History log 
- ASPs 
- Disk Units 
- Memory pools 
- User profiles 

IFS / This allows the user to browse the IFS starting at the directory listed which will vary.   
Change the directory using the IFS pane. 

Libraries This folder is used to browse the libraries on the system and work with the objects 
within them.  This can be filtered using the Objects Pane.   

Objects This allows you to browse objects on the system in any library, but an object filter 
must be set before using it via the Objects Pane.    

Tables This allows you to browse files on the system in any library, but a filter must be set 
before using it via the Tables Pane.   

Work management These options allow you to work with active jobs, subsystems, job queues, output 
queues, spool files and message queues. 

Power  These options apply to data collected on non IBM i systems like HMC or VIOS.  The 
primary data collected is nmon. 

Db2 for i This folder contains reports relating to or using IBM i SQL services and index advisor.  

Find collections 
results 

The folder contains results after running the Find Collections function.   

Saved collections This folder contains save files created by the Save function on any collection.  By 
default these are stored in library QIDRTMP. 

 

9.1 System 
This folder contains high-level options pertaining to the IBM i. 

 

9.1.1 Status 

This folder contains a report like that provided by the WRKSYSSTS command.  It provides information 
like current temp storage used, system ASP percentage used and system serial number. 

This report is produced using the QSYS2/SYSTEM_STATUS SQL table function as well as the 
SYSTEM_ACTIVITY_INFO SQL table function.   

https://www.ibm.com/docs/en/i/7.3?topic=services-system-status-table-function
https://www.ibm.com/docs/en/i/7.3?topic=services-system-activity-info-table-function
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9.1.1.1 Fields 

Field Description 

System name HOST_NAME 
Name of the system where this information was generated. This is the name set by 
CHGNETA. 

Average CPU 
utilization (%) 

AVGCPU_UTIL 
The average CPU utilization for all the active processors. 

Active jobs ACTIVE_JOBS_IN_SYSTEM 
The number of jobs active in the system (jobs that have been started, but have not 
yet ended), including both user and system jobs. 

Active threads ACTIVE_THREADS_IN_SYSTEM 
The number of initial and secondary threads in the system (threads that have been 
started, but have not yet ended), including both user and system threads. 

Total jobs TOTAL_JOBS_IN_SYSTEM 
The total number of user and system jobs that are currently in the system. The total 
includes: 

- All jobs on job queues waiting to be processed. 
- All jobs currently active (being processed). 
- All jobs that have completed running but still have output on output queues to 

be produced. 

Total memory 
(GBs) 

MAIN_STORAGE_SIZE_GB 
The amount of main storage, in gigabytes, in the system. 

System ASP 
capacity (GBs) 

SYSTEM_ASP_STORAGE_GB 
The storage capacity of the system auxiliary storage pool (ASP number 1) in 
gigabytes. This value represents the amount of space available for storage of both 
permanent and temporary objects. 

System ASP used 
(GBs) 

SYSTEM_ASP_USED 
The percentage of the System ASP that has been consumed. 

Total disk space 
(GBs) 

TOTAL_AUXILIARY_STORAGE_GB 
The total auxiliary/disk storage, in gigabytes, on the system. 

Current temp 
storage (GBs) 

CURRENT_TEMPORARY_STORAGE_GB 
The current amount of storage, in gigabytes, in use for temporary objects. 

Current temp 
storage used (%) 

CURRENT_TEMPORARY_PERCENTAGE_USED 
The percentage of temp storage used on the System ASP of the space remaining. 

Maximum temp 
storage used since 
IPL (GBs) 

MAXIMUM_TEMPORARY_STORAGE_USED_GB 
The largest amount of storage, in gigabytes, used for temporary objects at any one 
time since the last IPL. 

Interactive jobs INTERACTIVE_JOBS_IN_SYSTEM 
The percentage of interactive performance assigned to this logical partition. This 
value is a percentage of the total interactive performance available to the entire 
physical system. 

Elapsed average 
CPU used (%) 

ELAPSED_CPU_USED 
The average of the elapsed time during which the processing units were in use. 

Elapsed shared 
CPU utilization (%) 

ELAPSED_CPU_SHARED 
The percentage of the total shared processor pool capacity used by all partitions 
using the pool during the elapsed time. 
Returns null if this is a dedicated partition. 

Elapsed CPU 
uncapped capacity 
(%) 

ELAPSED_CPU_UNCAPPED_CAPACITY 
The percentage of the uncapped shared processing capacity for the partition used 
since the last time statistics were reset. 
Returns null if this partition cannot use more that its configured processing capacity. 

Elapsed seconds ELAPSED_TIME 
The time that has elapsed, in seconds, between the measurement start time and the 
current system time. 

Configured CPUs CONFIGURED_CPUS 
Total number of configured CPUs for the partition. 
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Virtual processors VIRTUAL_PROCESSORS 
The number of virtual processors currently used by this partition. 

CPU sharing CPU_SHARING_ATTRIBUTE 
This attribute indicates whether this partition is sharing processors. If the value 
indicates the partition does not share physical processors, then this partition uses 
only dedicated processors. If the value indicates the partition shares physical 
processors, then this partition uses physical processors from a shared pool of 
physical processors. 
 
CAPPED - Partition shares processors. The partition is limited to using its configured 
capacity. 
UNCAPPED - Partition shares processors. The partition can use more than its 
configured capacity. 
 
Contains the null value if this is a dedicated partition. 

Current CPU 
capacity 

CURRENT_CPU_CAPACITY 
The current processing capacity specifies the processor units that are being used in 
the partition. For a partition sharing physical processors, the current processing 
capacity represents the share of the physical processors in the pool it is running. For 
a partition using dedicated processors, the current processing capacity represents 
the number of virtual processors that are currently active in the partition. 

Average CPU rate 
(%) 

AVGCPU_RATE 
The average CPU rate expressed as a percentage where 100% indicates the 
processor is running at its nominal frequency. A value above or below 100% 
indicates how much the processor has been slowed down (throttled) or speeded up 
(turbo) relative to the nominal frequency for the processor model. For instance, a 
value of 120% indicates the processor is running 20% faster against its nominal 
speed. 

Perm addresses 
(%) 

PERMANENT_ADDRESS_RATE 
The percentage of the maximum possible addresses for permanent objects that have 
been used. 

Temp addresses 
(%) 

TEMPORARY_ADDRESS_RATE 
The percentage of the maximum possible addresses for temporary objects that have 
been used. 

Temp 256 MB 
addresses used 
(%) 

TEMPORARY_256MB_SEGMENTS 
The percentage of the maximum possible temporary 256MB segments that have 
been used. 

Temp 4 GB 
addresses used 
(%) 

TEMPORARY_4GB_SEGMENTS 
The percentage of the maximum possible temporary 4GB segments that have been 
used. 

Perm 256 MB 
addresses used 
(%) 

PERMANENT_256MB_SEGMENTS 
The percentage of the maximum possible permanent 256MB segments that have 
been used. 

Perm 4 GB 
addresses used 
(%) 

PERMANENT_4GB_SEGMENTS 
The percentage of the maximum possible permanent 4GB segments that have been 
used. 

LPAR ID PARTITION_ID 
The identifier for the partition in which this view is being run. 

Number of 
partitions 

NUMBER_OF_PARTITIONS 
The number of partitions on the physical machine. This includes partitions that are 
currently powered on (running) and partitions that are powered off. 

Restricted state RESTRICTED_STATE 
Whether the system is in restricted state. 
 
NO - System is not in restricted state. 
YES - System is in restricted state. 

Machine type MACHINE_TYPE 
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The machine type 

Machine model MACHINE_MODEL 
The machine model 

Serial number SERIAL_NUMBER 
The machine serial number 

Attention light ATTENTION_LIGHT 
The status of the system attention light. 
 
OFF - The light is off. 
ON - The light is on. 

IPL mode IPL_MODE 
The current IPL mode setting. 
 
AUTOMATIC - Used for automatic remote IPL, automatic IPL by date and time, and 
automatic IPL after a power failure. 
MANUAL - An operator uses the control panel to direct the system for special needs. 
NORMAL - Requires no operator intervention during the IPL. 
SECURE - Prevents use of the control panel to perform an IPL. 

Hardware 
multithreading 

HARDWARE_MULTITHREADING 
Indicates whether hardware multi-threading is enabled. 
 
NO - Hardware multi-threading is not enabled. 
YES - Hardware multi-threading is enabled. 

Threads per 
processor 

THREADS_PER_PROCESSOR 
The number of hardware threads per processor when hardware multi-threading is 
enabled. 
Contains the null value if HARDWARE_MULTITHREADING is NO. 

Jobs signed on JOBS_SIGNED_ON 
The number of jobs currently signed on the system. System request jobs and group 
jobs are not included in this number. 

Jobs disconnected JOBS_DISCONNECTED 
The number of jobs that have been disconnected due to either the selection of option 
80 (Temporary sign-off) or the entry of the Disconnect Job (DSCJOB) command. 

Bound hardware 
threads 

BOUND_HARDWARE_THREADS 
Whether hardware threads are bound. 
 
NO - Hardware threads are not bound. 
YES - Hardware threads are bound. 

Dispatch latency 
(ms) 

DISPATCH_LATENCY_MS 
The maximum time in milliseconds between dispatches of this partition on a physical 
processor. 

Dispatch wheel 
rotation time (ms) 

DISPATCH_WHEEL_ROTATION_TIME_MS 
The number of milliseconds in the hypervisor's scheduling window. Each virtual 
processor will be given the opportunity to execute on a physical processor some time 
during this period. The amount of time each virtual processor is able to use a physical 
processor is determined by partition processing capacity. 

CPU used since 
IPL (ms) 

TOTAL_CPU_TIME_MS 
The number of milliseconds of CPU time used by this partition since IPL. 

Interactive CPU 
used since IPL (ms) 

INTERACTIVE_CPU_TIME_MS 
The amount of CPU time, in milliseconds, used by interactive processes in this 
partition since partition IPL. An interactive process is any process doing 5250 display 
device I/O. 

Interactive CPU 
used above 
threshold since IPL 
(ms) 

INTERACTIVE_CPU_TIME_ABOVE_THRESHOLD_MS 
The amount of CPU time, in milliseconds, used by interactive processes while 
exceeding the interactive threshold. This is a total since IPL. 

Idle unused shared UNUSED_CPU_TIME_SHARED_POOL_MS 
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CPU time (ms) The number of milliseconds of CPU time that the physical processors in a shared 
processor pool have been idle since system IPL. 
Contains the null value if DEDICATED_PROCESSORS is YES or if the partition is 
not authorized to retrieve shared pool data. 

 

9.1.2 Messages 

This view allows you to work with the QSYSOPR messages and the jobs associated with each message. 

Right-click on a message/job for Active job options to view the call stack or job log (if the job is still active).   

 

For information on the fields shown in this view, see the MESSAGE_QUEUE_INFO view documentation. 

9.1.3 History log 

This option allows you to view and work with the contents of the history log. 

Right-click on a message/job for Active job options to view the call stack or job log (if the job is still active).   

 

For information on the fields shown in this view, see the HISTORY_LOG_INFO SQL table function 
documentation. 

9.1.4 ASPs 
The ASPs folder displays disk information for the current system on a per ASP basis.  You can also 
expand the ASPs to see information about the disk units within the selected ASP.  This information is 
similar to WRKDSKSTS but includes extra fields not found there. 
 
 

https://www.ibm.com/docs/en/i/7.5?topic=services-message-queue-info-view
https://www.ibm.com/docs/en/i/7.5?topic=services-history-log-info-table-function
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The folder contains a row for every ASP found on the system.   By right-clicking on an ASP within the list 
the user can reset statistics visible in this session for the disk units shown in the selected ASP. 
  
Expanding the ASP will show the disk units within.   
 
Tip:  Right-click the ASPs folder and pick the Select fields menu to rearrange or add/remove fields from 
the view. 
 

For information on the fields shown in this view, see the ASP_INFO SQL view documentation.  

 

9.1.5 Disk units 
The Disk Units folder displays disk information for the current system.  This information is similar to 
WRKDSKSTS but includes extra fields not found there. 
 
Tip:  Right-click the Disk units folder and pick the Select fields… menu to rearrange or add/remove fields 
from this view. 
 

 
 
The folder contains a row for every disk unit found on the system.   
 

For information on the fields shown in this view, see the SYSDISKSTAT SQL table function 
documentation.  

 
 

https://www.ibm.com/docs/en/i/7.5?topic=services-asp-info-view
https://www.ibm.com/docs/en/i/7.5?topic=services-sysdiskstat-table-function
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9.1.6 Memory pools 

The Memory pools folder displays the memory pools that exist for the current system. 

Tip:  Right-click the Memory pools folder and pick the Select fields… menu to rearrange or add/remove 
fields from this view. 

 

For information on the fields shown in this view, see the MEMORY_POOL SQL table function 
documentation. 

 

9.1.7 User Profiles 

This folder allows the user to work with the user profiles found on the system. 

Note: The User profiles pane will automatically appear when using this interface to allow for filtering the 
results. 

 

For information on the fields shown in this view, see the USER_INFO SQL view documentation. 

9.1.7.1 Menu Options 

Right-clicking a user profile provides these functions: 

https://www.ibm.com/docs/en/i/7.5?topic=services-memory-pool-table-function
https://www.ibm.com/docs/en/i/7.5?topic=services-user-info-view
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Menu Description 

Delete Removes the user profile from the system. 

Run 
QIDRGUI/ADDIDRUSR 

This runs the CL command QIDRGUI/ADDIDRUSR to grant minimum required 
authorities for the user to be able to use most iDoctor functions.  
 
See the help text for this command for more information. 

Grant authority to use 
performance data in 
library… 

This option grants *USE authority to JW, DW, PEX and CS types of performance 
data in the specified library.   
 
User must enter the desired library on this screen and press OK. 

 

 

9.2 IFS  
This folder lets users work with directories and files on the current system they are using in the Integrated 
File System.  By default, the starting point is the root folder (/) but this can be modified. 

Tip: Up to 20 selections for IFS paths can be saved in the Object drop down list in the IFS pane. 

Note: The IFS pane will appear automatically when using this interface. 

 

 

9.2.1 Directory menu options 

The default right-click menu options available for any directory in this view are: 
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Menu Description 

Explore Expands the current folder and displays the results in the list. 

Upload This will present an interface to transfer one or more files from the PC to the remote 
system. 

Create Directory This option will create a new directory on the IFS in the desired location. 

Copy… This will present an interface that allows the user to copy the directory and all its 
contents to another location on the system. 

Delete  This will delete the directory from the system. 

Rename This option will rename the directory. 

Save Use this option to save the directory and its contents to a save file. 
Tip: Afterwards you can use the Saved Collections folder to download the save file 
or work with it if desired. 

 

9.2.2 File menu options 

The default menu options for a file within the IFS are: 
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Menu Description 

Download / Open This option will first download the file to the PC and then attempt to open it using the 
default program for the current file type. 

Download  This can be used to download the selected file(s) to the PC. 

Edit This option will download the file to the PC and then present an interface that lets 
you edit the results.  When finished the file is sent back to the remote system. 

Analyze NMON 
Data… 

This option will display the Analyze Data window which allows .nmon files to be 
analyzed and DB files created in the desired location. 
 
This menu option only appears if an .nmon file has been selected. 
 
Note: For more details, see the documentation on Power Connections. 

Upload This will present an interface to transfer one or more files from the PC to the remote 
system. 

Create Directory This option allows the user to create a directory on the system. 

Copy… This will present an interface that allows the user to copy the selection to another 
location on the system. 

Delete  This will delete the selection from the system. 

Rename This option will rename the currently selected file. 

Save Use this option to save the selection to a save file. 

Transfer to This option presents an interface that allows the user to transfer the current file(s) to 
another system, to IBM or to the PC. 

 

9.2.3 Download / Open 

This option is used to download and then execute the default Windows program for the file type being 
opened.  For example, using this option on a .txt file would probably open the file in Notepad.    

Note: Files are downloaded into the iDoctor temp directory.  This path can be determined by viewing the 
application properties. (Help -> About menu) 

https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_Power.pdf
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_Power.pdf
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_Power.pdf
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9.2.4 Download 
This option can be used to download the selected file(s) to the PC.  The files will be placed in the 
directory specified. 
 

 

  

9.2.4.1  Interface 

Option Description 

Destination Indicates where the data will be sent.  For a download operation, PC is assumed, 
although it could be changed here. 

Target path The location on the PC where the file(s) will be sent.   

Run in a command 
prompt window 

Indicates if the status of transfers should be visible in a command prompt window.  
 
Note: This only appears if the IBM i Connection’s file transfer method is SSL or 
SSH. 

Open target 
directory in File 
Explorer 

Indicates if Window’s File Explorer should be opened and navigated to the path 
after the transfer is complete. 

 

9.2.5 Edit  

This option can be used to download an IFS file to the PC and then open it within an editor inside of 
iDoctor. 

Note: Files greater than 10 MBs cannot be edited with this interface. 
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Option Description 

OK If changes have been made this will send the file back to the remote system and 
replace it.  You will be prompted to confirm. 

 

9.2.6 Upload   

The Upload file(s) window allows the user to transfer 1 or more files from the PC to the desired directory 
on the remote system.  These transfers occur via the Remote Command Status View and the results of 
which can be viewed there. 
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Option Description 

Target directory (or 
library) 

This value contains the desired location to send the file(s) on the PC to. 

Binary mode Check this box if you wish to use binary mode to send the files.   

Run in a command 
prompt window 

Indicates if the status of transfers should be visible in a command prompt window.  
 
Note: This only appears if the IBM i Connection’s file transfer method is SSL or 
SSH. 

Remember this list… Use this option is you want the GUI to remember the list of files and repopulate 
the list again with the same set of files.  This can be handy if sending the same 
files to multiple LPARs. 

Upload file list This is the list of files on the PC that will be transferred to the remote server. 

Add button Use this button to add files from the PC to the list. 

 

9.2.7 Create Directory 

This option is used to create a directory on the remote server.  By default, the window will show the path 
for the current directory and you will need to modify this path appropriately. 

 

 

 

9.2.8 Copy 

This option copies one or more files/directories to the desired new location.  Only if copying a single file 
should the new value entered contain a file name.  Otherwise, the value provided should be the directory 
to copy the files or directories into. 

 

 

9.2.9 Delete 

The Delete option will remove the file(s) and/or directories and their contents from the remote server.      
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9.2.10 Rename 

The Rename menu option allows you to change a specific file or directory and give it a new name.    

The interface looks like this: 

 

 

9.2.11 Save  

This option will save all selected directories and files to a save file file that you specify. 

You can work with this save file afterwards using the Saved Collections folder. 
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9.3 Objects Pane 
This Objects Pane is used to filter the contents of the Libraries and Objects folders within IBM i Explorer.  

This interface appears automatically when either folder is used. 
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9.4 Libraries  
The IBM i Explorer’s libraries folder is an interface over the IBM i objects and libraries that exist on the 
system.  The list of libraries shown can be filtered down and reduced if necessary. 

This interface can be used to work with any IBM i objects such as physical files, save files and output 
queues. 

 

 

9.4.1 Menu options 

Right-click the Libraries folder to display the available options: 

 

 

Menu Item Description 

Select fields… This option allows you to modify the columns shown in this folder.  

Create library… This option creates a library on the IBM i.  It may or may not appear in the list 
depending on the current filters set. 

 

9.4.2 Create Library 

This window is used to create a new library on the IBM i.  The action is performed in the Remote 
Command Status View. 

Note: Creating a library in an Independent ASP that has not been configured as viewable within the IBM i 
Connection for the current system would mean it would not show up in the GUI until this has been done. 
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9.4.2.1 Interface 

Option Description 

Library name Name of the library to create 

Description Specifies the text that briefly describes the library.      

ASP number Specifies the number of the system or basic user auxiliary storage    
pool (ASP) where storage for the library is allocated.  For           
libraries created in an ASP, all objects in the library must be in    
the same ASP as the library.  When a value other than *ASP is         
specified for the ASP device (ASPDEV) parameter, *ASPDEV is the only  
valid value that can be specified for the ASP number (ASP)            
parameter, if specified.  Also when a value other than *ASP is        
specified for the ASPDEV parameter, the ASP parameter can be omitted  
and its defaulted value will be ignored.                              
                                                                      
1                                                                     
    The storage space for the library is allocated from the system    
    auxiliary storage pool ASP 1.                                                                                                          
*ASPDEV 
    The storage for the library is allocated from the primary or     
    secondary ASP specified for the ASPDEV parameter.                                                                                    
number                                                               
    Specify a value ranging from 1 through 32 that is the number of  
    the system or basic user ASP.                                    

ASP device Specifies the auxiliary storage pool (ASP) device name where storage   
is allocated for the library.  When a value other than *ASPDEV is      
specified for the ASP number (ASP) parameter, ASPDEV(*ASP) is the      
only valid value for the ASP device (ASPDEV) parameter, if             
specified.  Other values for the ASPDEV parameter are valid if the     
ASP parameter is omitted.  In this case, the defaulted value for the   
ASP parameter is ignored.                                             
                                                                      
*ASP                                                                  
    The storage for the library is allocated from the system or       
    basic user ASP specified for the ASP parameter.                                                                                      
*ASPGRPPRI                                                            
    The storage for the library is allocated from the primary ASP of  
    the thread's ASP group. If no ASP group is associated with the    
    thread an error message is sent.                                                                                                       
*SYSTEM                                                               
    The storage for the library is allocated from the system ASP      
    (ASP 1).                                                          
name                                                                 
    Specify the name of a primary or secondary ASP device.  The      
    storage for the library is allocated from the primary or         
    secondary ASP. The primary or secondary ASP must have been       
    activated (by varying on the ASP device) and have a status of    
    'Available'.                                                     
                                                                     
        Note:  To specify a specific auxiliary storage pool (ASP)    
        device name, you must have use (*USE) authority for each ASP 
        device in the ASP group.                                     
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9.4.3 Library Folders 

A library within the Libraries folder displays a list of objects within the library that match the filters set in 
the Objects Pane. 

 

For more information see the Library Folders section within the Component Views chapter. 

  

9.5 Objects  
This folder contains a list of objects that match the filters set in the Objects Pane.  It is required to set a 
filter before using this interface.   

Note: Using a filter that is too broad will cause a much longer response time. 

 

Depending on the object type, several additional options are available on a right-click of the object.  Some 
object types can also be expanded like multiple member physical files will show a list of members, and 
output queues will contain spool files. 
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Tip: If this folder is taking a long time to build and you wish to cancel the operation, then click the X on 
the tab for this view and the SQL statement will be canceled.  This is only possible if the mouse pointer is 
an hourglass/pointer combination. 

9.5.1 Fields 

The columns with a (*) are shown by default.  The other columns can be added using Select Fields… 
menu. 

Tip: These same columns are used and shown by expanding a library under the Libraries folder. 
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Field Description 

Object name (*) Name of the object 

Library (*) Library 

Object type (*) The object type.  This describes the kind of object shown. 

Attribute (*) This is used to further describe the type of object.  For example, 
*FILE objects will have an attribute of SAVF, PF, DSPF or LF. 

Owner (*) The user profile that owns the object. 

Creator's user profile (*) The user profile that created the object. 

Creation time (*) The timestamp when the object was created. 

Size (KBs) (*) Size of the object in kilobytes. 

Description (*) The text that briefly describes the object.      

IASP (*) IASP name or ASP number. 

Days-used count The number of days an object has been used on the system. 

System created on The name of the system on which the object was created. 

System version The VRM of the system on which the object was created. 

Licensed program The name of the licensed program if the object is part of a licensed 
program. 

Licensed program version The VRM of the licensed program if the object is part of a licensed 
program. 

Compiler The licensed program identifier of the compiler that created the 
object (if applicable.) 

Compiler version The VRM of the compiler that created the object (if applicable.) 

Object control level The object control level for the object. 

PTF The Program Temporary Fix that resulted in the creation of this 
object. 

APAR The authorized program analysis report (APAR) with this 
identification number is associated with the last change. 
Will contain the value CHGDFT for a command that is changed 
using CHGCMDDFT. 
 
The Change Object Description (QLICOBJD) API can change this 
field to any value. 

User-defined attribute Further defines an object type. This field is set by the user by using 
the QLICOBJD API. 

Allow change by program Identifies whether or not any changes other than the text or the days 
used count and reset date can be made to the object's description by 
the Change Object Description (QLICOBJD) API. 

Changed by program Identifies whether the object has been modified by the Change 
Object Description (QLICOBJD) API. 

Compressed Indicates whether the object is compressed or decompressed.  
 
NO - Permanently decompressed and compressible. 
YES - Compressed. 
TEMP -Temporarily decompressed. 
FREE - Saved with storage freed; compression status cannot be 
determined. 
 
Contains the null value if the object is permanently decompressed 
and not compressible. 

Primary group The name of the user profile that is the primary group for the object. 

Storage freed The storage status of the object data. 
 
NO - The storage for the object data has not been freed. 
YES - The storage for the object data has been freed. See the 
SAVOBJ or SAVLIB command, STG parameter, for more details. 

Overflow storage Indicates if the object has overflowed the auxiliary storage pool it 
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resides in. 

Object domain The domain that contains the object. 

Object audit The type of auditing for an object.  
 
*ALL - Audit all access to this object by all users on the system. All 
access is defined as a read or change operation. 
*CHANGE - Audit all change access to this object by all users on the 
system. 
*NONE - No auditing occurs for this object when it is read or 
changed regardless of the user who is accessing the object. 
*USRPRF - Audit this object only if the current user is being audited. 
The current user is tested to determine if auditing should be done for 
this object. The user profile can specify if only change access is 
audited or if both read and change accesses are audited for this 
object. 
 
Contains the null value if you do not have either all object (*ALLOBJ) 
or audit (*AUDIT) special authority. 

Object signed Indicates whether the object has a digital signature. 

 

9.5.2 Menu Options 

The popup menu options for objects will vary based on the object type.   

All objects will have these options: 

Menu Description 

Cut This initiates a 2-part operation to move an object to another library using the 
MOVOBJ command.  Use the Paste menu option on the desired library to complete 
the process. 

Copy This initiates a 2-part operation to copy an object to another library using the 
CRTDUPOBJ command.  Use the Paste menu option on the desired library to 
complete the process. 

Save… This will save the selected objects to a save file. 

Delete Removes the objects from the system 

Rename Renames an object. 

Properties Displays object properties.  Some object types will have additional tabs. 

 

9.5.3 Physical/Logical Files (*FILE PF/LF) 

Physical and logical files have additional options available described in this section. 

9.5.3.1 Menu Options 

Menu Description 

Explore This views the members within the file. 

Select fields… This option allows you to modify the columns shown within this folder.  

Add Member This is used to add a member to a physical file. 

Clear (remove all 
members) 

This option will issue a RMVM command to remove all members from the selected 
file.  This only works for multi-member physical files. 

Properties The properties for PF/LF files will contain additional tabs File and Field. 
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9.5.3.2 Add Member 

If a physical file is selected, this presents a window that allows an additional member to be added to the 
file selected. 
 
Note: This only works if the maximum allowed members setting on the file has not been exceeded. 

 

 

9.5.3.3 Members 

The following is an example of the contents of a physical file in iDoctor. 

 

9.5.3.3.1 Menu Options 

Menu Description 

Open Table(s) This creates a table view in the Data Viewer, 1 for each selected member. 

Save… Saves the selected member(s) to a save file. 

Clear This option will run an SQL statement to delete all data in the selected member but 
leaves the member. 

Delete This option will remove the selected member(s) from the system. 

Rename This option renames the member. 

Properties These are the properties for the selected member, rather than the file. 

 

9.5.3.3.2 Open Table(s) 

This option opens the selected member(s) in the Data Viewer, each in a separate view. 



IBM iDoctor for IBM i  

 

9.5.3.3.3 Save 

This window is used to save one or more physical or logical file members to a save file using the SAVOBJ 
command. 

 

9.5.3.3.4 Properties 

Member properties provide many details about the physical file/member.  For more information on these 

values, see the QUSRMBRD API documentation. 

https://www.ibm.com/docs/en/i/7.5?topic=ssw_ibm_i_75/apis/qusrmbrd.html
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9.5.3.4 Properties 

This section describes the additional properties that only applies to *FILE object types. 

9.5.3.4.1 File 

This tab provides a large amount of detail about the File like that displayed when using the DSPFD 
command on the IBM i. 
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9.5.3.4.2 Fields 

This tab includes the list of record formats in a drop-down list, along with a list of fields that exist within the 
record format selected.  

This information returned is like the DSPFFD command on the IBM i. 
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9.5.4 Save files (*FILE SAVF) 

Save files are often used as a compression and transport mechanism to move data to another system. 

9.5.4.1 Menu Options 

Menu Description 

Display This option displays the contents of the save file in a new window. 

Download  This can be used to download the selected file(s) to the PC. 

Restore This option will present either the Restore Library or Restore Objects window 
depending on the contents of the data within the save file.  

Transfer to... Allows a user to transfer one or more save files to another system. 

Clear This option runs the CLRSAVF command against the save file to clear its contents. 

 

9.5.4.2 Display   

This interface is used to display the contents of a save file.  Changing the selection to include a *FILE 
PF/LF will update the member list shown in this window to indicate the members saved within the 
selected field.  

Note: This option does not work for save files created using the SAV command. 



IBM iDoctor for IBM i  

 

 

9.5.4.3 Restore Objects 

This interface is used to restore a save file’s contents created using the SAVOBJ command.  After 
confirming the desired options and pressing OK, a RSTOBJ command will be built and executed in the 
Remote Command Status View. 

See the RSTOBJ command help text for more information about the parameters shown in this interface. 

 

 

https://www.ibm.com/docs/en/i/7.5?topic=ssw_ibm_i_75/cl/rstobj.html
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9.5.4.4 Restore Library  

This interface is used to restore a save file’s contents created using the SAVLIB command.  After 
confirming the desired options and pressing OK, a RSTLIB command will be built and executed in the 
Remote Command Status View. 

See the RSTLIB command help text for more information about the parameters shown in this interface. 

 

 

9.5.5 Display files (*FILE DSPF) 

Display files contain logic that determines how a green screen interface will appear. 

The Source tab may appear in Properties if available. 

9.5.6 DDM files (*FILE DDMF) 

No additional information is provided for these files. 

 

9.5.7 Class (*CLS) 

A class contains parameters that control the running of a routing step (related to subsystems).    

9.5.7.1 Properties                                                     

Class objects have an additional Class tab in the Object properties.  See the QWCRCLSI API for more 

information. 

https://www.ibm.com/docs/en/i/7.5?topic=ssw_ibm_i_75/cl/rstlib.html
https://www.ibm.com/docs/en/i/7.5?topic=ssw_ibm_i_75/apis/qwcrclsi.html
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9.5.8 Command (*CMD) 

Commands are used to perform some action on the system. 

9.5.8.1 Properties 

Command objects provides an additional Command tab.  See the QCDRCMDI API for more information. 

 

https://www.ibm.com/docs/en/i/7.5?topic=ssw_ibm_i_75/apis/qcdrcmdi.html
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The Source tab will appear as well if the source code is available. 

 

9.5.9 Data Area (*DTAARA) 

Data areas are an object type used to store a small amount of information on the system. 

9.5.9.1 Menu Options 

Menu Description 

Change… Use this to view or modify the data area. 
Tip: Double-click will also perform this action. 

9.5.9.2 Change 

Use this interface to modify or view a data area or its description. 

 

 

9.5.10 Data Queue (*DTAQ) 

Data queues are used in certain programs where a data management sequence is needed. 

9.5.10.1 Menu Options 

Menu Description 

Display This action will display information about the data queue and its contents. 

 

9.5.10.2 Display 

This window displays information about the data queue and its contents (if not empty). 

The entries in the data queue are retrieved only for the range specified.   
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9.5.10.3 Properties 

This Data Queue tab in Properties provides additional information. See the QMHQRDQD API for more 

information. 

 

 

9.5.11 Job Description (*JOBD) 

Job descriptions control aspects of how a job will run. 

9.5.11.1 Properties 

The Job descriptions tab will appear in Properties with more details.  See the QWDRJOBD API for more 

information. 
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9.5.12 Job Queue (*JOBQ) 

A job queue contains an ordered list of jobs waiting to be processed by a subsystem. The job queue is 
the first place that a submitted batch job goes before becoming active in a subsystem. The job is held 
here until a number of factors are met.  

Tip: Viewing a job queue object within a library or the Objects folder does not contain status information 
or the number of jobs in the job queue.  Use the Work management -> Active job queues folder for those 
functions. 

9.5.12.1 Properties 

The Job queue tab provides information relating to the job queue.  See the QSPRJOBQ API for more 

information. 
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9.5.13 Module (*MODULE) 

Modules are used *PGM or *SRVPGM objects on IBM i. 

9.5.13.1 Properties 

The Module tab provides information found within the module object.   

Use the Display drop-down list to toggle between these choices: 
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See the QBNRMODI (Retrieve Module Information) API for more information. 

 

9.5.14 Program (*PGM) 

Programs are used to perform work on IBM i. 

9.5.14.1 Properties 

The Program tab provides information found within the program object.   

Use the Display drop-down list to toggle between these choices: 
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9.5.15 Service Program (*SRVPGM) 

Service programs are used to perform work on IBM i. 

9.5.15.1 Properties 

The Service program tab provides information found within the service program object.   

Use the Display drop-down list to toggle between these choices: 
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9.5.16 User index (*USRIDX) 

User indexes contain data commonly used by many APIs. 

9.5.16.1 Menu Options 

Menu Description 

Display This action will run an SQL statement to display the contents of the user index in the 
Data Viewer. 

9.5.16.2 Display 

This function uses the USER_INDEX_ENTRIES SQL table function to provide the contents of the user 
index within a table view in the Data Viewer. 

 

 

9.5.16.3 Properties 

The User index tab provides information found within the user index object.   

https://www.ibm.com/docs/en/i/7.4?topic=services-user-index-entries-table-function
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9.5.17 User space (*USRSPC) 

User spaces contains data commonly used by many APIs. 

9.5.17.1 Menu Options 

Menu Description 

Display This action will run an SQL statement to display the contents of the user space in the 
Data Viewer. 

9.5.17.2 Display 

This function uses the USER_SPACE SQL table function to provide the contents of the user space within 
a table view in the Data Viewer. 

 

 

9.5.17.3 Properties 

The User space tab provides information found within the user space object.   

https://www.ibm.com/docs/en/i/7.4?topic=services-user-space-table-function
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9.5.18 Object Properties 

The properties for objects consist of several tabs providing more details about the object. 

In some cases, additional tabs will appear based on the object type.  For example, *FILE objects contain 
File and Fields tabs within their properties. 

9.5.18.1 Overview 

The Overview tab contains general information about the object.  It offers the ability to modify the object 
description by typing in a new value and pressing OK. 

 

 

9.5.18.2 Source  

If the object contains source code information and that source code exists on the system, it will be 
displayed on this tab. 
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9.5.18.3 Save/Restore 

This tab provides information about the last save or restore operation done on the object. 

 

9.5.18.4 Authorities 

The Authorities tab shows a list of users that have authority to the object and each authority setting.  This 
interface is like the DSPOBJAUT command. 
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 The following information is shown for each user in the list. 
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Option Description 

User The names of users who are authorized to use the object.  The value *PUBLIC is 
used to indicate the authorities of users who are not specifically named and are not 
in the object's     
authorization list. 

Group A group from which the user receives authority. 

Obj Authority The user's authority to the object. This field contains one of the following values:  

*ALL  
The user has all object (operational, management, existence, alter, and reference) 
and data (read, add, update, delete, and execute) authorities to the object.  

*CHANGE  
The user has object operational and all data authorities to the object.  

*USE  
The user has object operational, and data read and execute authorities to the object.  

*EXCLUDE  
The user has none of the object or data authorities to the object, or authorization list 
management authority to the authorization list.  

*AUTL  
The public authority for the object comes from the public authority on the 
authorization list securing the object. This value can only be returned if there is an 
authorization list securing the object and the authorized user is *PUBLIC.  

USER DEF  
The user has some combination of object and data authorities that do not relate to a 
special value. The individual authorities for the user should be checked to determine 
what authority the user has to the object.  

Obj Opr Object operational authority provides authority to look at the object's attributes and to 
use the object as specified by the data authorities that the user has to the object. 

Obj Mgmt Object management authority provides authority to specify security, to move or 
rename the object, and to add members if the object is a database file. 

Obj Exist Object existence authority provides authority to control the object's existence and 
ownership. 

Obj Alter Object alter authority provides authority to change the attributes of an object, such as 
adding or removing triggers for a database file.                                                  

Obj Ref Object reference authority provides authority to specify the object as the first level in 
a referential constraint.                

Data Read Read authority provides authority to access the contents of the object.                    

Data Add Add authority provides authority to add entries to the object.  

Data Update Update authority provides authority to change the content of existing entries in the 
object. 

Data Delete Delete authority provides authority to remove entries from the object. 

Data Execute Execute authority provides authority to run a program or search a library or directory. 

 

9.5.18.5 SQL 

This tab provides information about the SQL statement that built the list that this object appears in.   

If desired, there is an Open in Data Viewer button available, which allows you to view the results and 
modify the SQL statement within that interface. 

The bottom of the window contains information about the success of the SQL statements ran to produce 
the list and how long it took. 
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9.5.18.6 Columns 

This tab provides information about the Columns used in the SQL statement that built the list of libraries.  
This data comes from the ODBC driver.  It is intended primarily for IBM internal use. 

 

9.6 Tables 
This folder contains a list of tables filtered by the Tables pane. 
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Double-click a file object to view its contents if it’s a single member table, or to see the list of members if 
it’s a multi-member table.   

Note: The menu options will vary based on the type of table indicated by the Type column. 

9.6.1 Menu Options (PF) 

These menu options are available by right-clicking a PF or LF type table and are documented in a 
previous section: 

 

9.6.2 Menu Options (TABLE) 

These are SQL created tables. 

These options will appear if right-clicking a TABLE type of table:  

Menu Description 

Open Table(s) This action will run an SQL statement to display the contents of the table in the Data 
Viewer. 

Edit This action will prepare an SQL statement and open it in the Data Viewer with the 
SQL editor visible but does not run the statement. 

Delete This option will remove the table from the system. 

Properties Displays object properties for the table.  
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9.7 Work Management 
This folder contains functions relating to work management on the IBM i. 

 

9.7.1 Active jobs 

The Active jobs folder shows the jobs matching the filters provided on the Active Jobs Pane. 

The columns shown in the report will vary based on the Perspective setting on the pane. 

 
Detailed perspective – Active jobs folder 
 
See the ACTIVE_JOB_INFO SQL table function for more information on the columns shown in this 
interface. 
 

9.7.1.1 Menu options 

By right clicking on an active job there are several options available.    

https://www.ibm.com/docs/en/i/7.5?topic=services-active-job-info-table-function
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Menu Description 

Explore Displays the list of threads found within the job.  The list of threads contains 
performance statistics that are updated on each refresh of the view.  You can reset 
these statistics by using the Reset Thread Statistics menu option. 

Display Job Log Displays the job log for the selected job.   

Active Data  This option provides a shortcut to view commonly used graphs for the desired job 
using either Collection Services or Job Watcher data if a STRJWMON is currently 
running. 

Active Job Options This contains a set of options applicable to the selected job such as viewing the call 
stack, open files, or searching the job log. 

Select fields… This option allows you to select the fields to display for the list of threads within the 
job.    

Add Job Watcher 
Definition 

Defines a new Job Watcher definition that collects data only for the selected jobs 
using the Add Job Watcher Definition Wizard. 

Start PEX 
Collection 

Launches the Start PEX Collection Wizard and preselects the selected jobs in the 
interface so that the collection only contains data for these jobs. 

Add PEX Definition Defines a PEX definition that will collect data over the selected jobs.  You will need to 
indicate within the wizard if you want to have a *STATS or *TRACE type PEX 
collection. 

Reset Thread 
Statistics  

This option resets the collected thread level statistics for the selected job.  This 
applies to the threads shown below the job when it is expanded in the tree. 

Properties This option displays the active job property pages for the selected job. 
This contains additional details about the job such as the call stack, and locks 
currently present. 

 

9.7.2 Threads 

When expanding an active job, the list of threads is shown within it.   
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Performance data shown in this list like CPU and IOs is based on the time between the initial refresh of 
this view and the most recent one.  You can also reset these statistics by right-clicking the job and using 
the Reset Thread Statistics menu.   

9.7.2.1 Menu Options 

Each thread has these options available on a right-click in the popup menu. 

Menu Description 

Active Data  This option provides a shortcut to view commonly used graphs for the desired 
job/thread using either Collection Services or Job Watcher data if a monitor 
(STRJWMON command) is currently running. 

Properties This option will display the call stack and additional information for the selected 
thread.  This action is also taken by double-clicking on a thread. 

 

9.7.2.2 Fields 

The less obvious columns in the list of threads are described below: 

Field Description 

Thread status 
The status may be one of the following values: 

 
- Blank The status of the thread is unknown. 
- CMTW The thread is waiting for the completion of save-while-active checkpoint 

processing in another job. This wait is necessary to prevent a partial commitment 
control transaction from being saved to the media. 

- CNDW The thread is waiting for a condition. 
- DEQA The thread is waiting for completion of a dequeue operation in the pool 

activity level. 
- DEQW The thread is waiting for completion of a dequeue operation. For example, a 

server may wait for work by waiting for a dequeue operation 
- EVTW The thread is waiting for an event. 
- HLD The thread is in a job that is being held. 
- HLDT The thread is being held. 
- INEL The thread is ineligible and not currently in the pool activity level. 
- JVAA The thread is waiting for completion of a Java program operation in the pool 

activity level. 
- JVAW The thread is waiting for completion of a Java program operation. 
- LCKW The thread is waiting for a lock. 
- LSPA The thread is waiting for a lock space to be attached while in a pool activity 

level. 
- LSPW The thread is waiting for a lock space to be attached. 
- MTXW The thread is in a mutex wait. A mutex is a synchronization function that is 

used to allow multiple threads to serialize their access to shared data. 
- RUN The thread is currently running in the activity level. 
- SELW The thread is in a select wait. More information on the select() function is in 

the Sockets APIs chapter in the System API Reference, SC41-5801. 
- SEMW The thread is waiting for a semaphore. A semaphore is a synchronization 

function that is used to allow multiple jobs or threads to serialize their access to shared 
data. 

- SIGS The thread has been held by a signal. 
- SIGW The thread is waiting for a signal. 
- THDW The thread is waiting for another thread to complete an operation. 
- TIMA The thread is waiting, in the activity level, for a time interval to end. 
- TIMW The thread is waiting for a time interval to end. 

Thread type The thread type indicates how the thread was created. If this field is requested for a job, the 
value for the initial thread of the job will be returned. The type of a thread may be one of the 



IBM iDoctor for IBM i  

following values: 

User - The thread was created either as the initial thread of the job or explicitly by the 
application. 

System - The thread was created by an operating system function. 

 

9.7.3 Completed Jobs 

Jobs that have completed, are listed with a red icon within the Active jobs folder. 

Expanding a completed job in the list displays a list of any spool files they contain.    

Note: These types of jobs are only listed if the Job Status in the Active Pane is set to *ALL or *OUTQ. 

Tip: Often completed jobs will NOT contain any spool files.  If you are looking for spool files, use the 
Spool Files Pane instead. 

 

 

9.7.4 Active Job Options 
This section covers the Active Jobs Options popup menu shown for Active Jobs.  This appears in a 
variety of interfaces where an active job is either shown or accessible behind a view.  
 

 
Active Job Options menu 
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Menu Description 

Call Stack Displays the Active Job Properties – Call Stack interface. 

Job Locks Displays the Active Job Properties – Job Locks interface. 

Open Files Displays the Active Job Properties – Open Files interface. 

QTEMP Displays the Active Job Properties – QTEMP interface. 

Open IFS Files Displays the Active Job Properties – Open IFS Files interface. 

SQL Displays the Active Job Properties – SQL interface. 

Display Detailed 
Job Log 

This produces a job log that includes the message details for each message entry. 

Display Job Log 
(uses lstjbl.exe) 

This shows the job log using the older but simple Client Access GUI function 
lstjbl.exe 

Job Log Message 
Text Search… 

This prompts the user for something to look for in the selected job(s).  The 
MESSAGE_TEXT column within the job logs will be searched. 

Job Log Message 
ID Search… 

This prompts the user for a specific message ID (7 characters) to look for in the 
selected job(s).  The MESSAGE_ID column within the job logs will be searched and 
only the exact matches will be returned. 

View Job in Active 
jobs folder 

These options shown the results in the Active jobs folder but only showing the 
selected job. 

End Job Immediate This ends the selected job(s) using the ENDJOB command immediate option. 

End Job This ends the selected job(s) using the ENDJOB command. 

 

9.7.4.1 Display Detailed Job Log 

Use this option to display the selected job’s job log.  The message details column will be included. 

 

Tip: You can double-click a row for more details about a specific message like from, to program 
information. 

9.7.4.2 Display Job Log (uses lstjbl.exe) 

Use this option to display the selected job’s job log in lstjbl.exe. 

 

9.7.4.3 Job Log Message Text Search 

Use this option to search one or more active jobs for a specific text string in within the job log messages.  
Only messages that contain the string provided are returned. 
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9.7.4.4 Job Log Message ID Search  

Use this option to search one or more active jobs for a specific message ID in within the job log 
messages.  Only messages that match the 7-character message ID provided are returned. 

 

 

 

9.7.4.5 View Job in Active jobs folder  

This opens the Active Jobs folder under Work management and filters by the selected job and desired 
status.  

 

9.7.5 Active Job Properties 

The properties for an active job consist of general information about the job at the top of the window for all 
tabs and additional information that varies for each individual tab selected.   



IBM iDoctor for IBM i  

These screens are designed to be like the ones found in Job Watcher.  They provide the wait object and 
holder information if one exists for the current job.  

9.7.5.1 General 

The General part of every tab in this interface has the same layout and allows the user to switch between 
threads for the job if desired using the Thread drop-down list. 

 

Interface 

Option Description 

Job information This lists the job name/user/number. 

Thread From here you can select which thread to display information for (such as the call 
stack.) 

Job subsystem Subsystem the job is running in. 

Job status Active job status (see WRKACTJOB help text for more information) 

Job function The function the job is running in if applicable. 

Pool Pool number the job is running in. 

Priority XPF current run priority. 

Current User The name of the user profile the job is running under. 

Job type Indicates the type of job, such as Batch. 

CPU CPU time consumed by the job since it started. 

I/Os I/O operations performed by the job since it started. 

Objects waited on If the job is waiting to get a lock on an object, this will list the object information (if 
known.)  This means QWCRJBLCK api lock status is 2 or 3 and the library and 
extended object name will be returned. 

DB CPU CPU time consumed related to DB operations since the job started. 

Tmp Stg Current temporary storage space consumed in megabytes. 

Holding job or task If an object is being waited on, this provides the job information that is holding or 
locking the object. 

Entered system The time the job entered the system. 

Started The time the job started. 

9.7.5.2 Call stack 

This tab displays the call stack for the active job/thread.  If a program is listed, the Work with Program and 
Program Properties buttons can be used to drill down and get more information about a program.  

The Include LIC option checkbox is an easy way to hide/show LIC call levels in the stack. 
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Active job properties – Call stack 

Interface 

Option Description 

Include Checks the box to include LIC call levels in the call stack. 

Work with program Select a call level that contains a MI program and this option will allow you to view 
the program within the Objects folder. 

Program properties This option goes directly to the Properties for the selected MI program object. 

 

9.7.5.3 Library List 

This tab displays the library list for the active job/thread.  It cannot be manipulated from here.  The Work 
with Library and Library Properties buttons may be used to drill-down into a library. 
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Active job properties – Library List 

Interface 

Option Description 

Work with library Select a library and use this option to view it within the Objects folder. 

Library properties This option goes directly to the Properties for the selected library. 

 

9.7.5.4 Job Locks 

This tab shows the job-scoped locks for the active job/thread.  It provides several drill-down options using 
the buttons shown on the screen. 
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Active job properties – Job Locks 

Interface 

Option Description 

Object properties This option goes directly to the Properties for the selected object. 

Work with object This option will view the selected object within the Objects folder. 

Work with table This option will view the selected table (*FILE object) within the Tables folder. 

Work with object 
locks 

This option will view the locks on the selected object within the Object lock info folder. 

 

9.7.5.5 Thread Locks 

This tab is the same as the Job Locks tab, but shows the thread scoped locks instead. 

9.7.5.6 Open Files 

This tab provides information about the files currently open by the active job/thread. 

Use the buttons to drill-down to get more information. 
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Active job properties – Open Files 

Interface 

Option Description 

Work with object 
locks 

This option will view the locks on the selected object within the Object lock info 
folder. 

Work with file This option will view the selected file within the Tables folder. 

File properties This option goes directly to the Properties for the selected file. 

 

9.7.5.7 QTEMP 

This tab provides information about the objects found in QTEMP for the current job. 

Note: This only works for QZDASOINIT jobs. 

 

Active job properties – QTEMP 
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9.7.5.8 Open IFS Files 

This tab shows Open IFS files and directories for the active job/thread. 

 

Active job properties – Open IFS Files 

Interface 

Option Description 

Work with object This option will view the selected object within the IFS folder 

 

9.7.5.9 SQL  

The SQL tab provides detailed about the SQL environment, resource counts and last ran SQL statement 
if available. 
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Active job properties – SQL 

 

9.7.5.10 SQL Open Cursors 

This tab provides the last ran SQL statement and a list of open cursor information if available. 
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Active job properties – SQL Open Cursors 

9.7.6 Server jobs 

This folder is like the Active jobs folder and utilizes the Active Jobs Pane to filter results, but further 
reduces the results to only include server jobs. 
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9.7.7 Scheduled jobs  
The Scheduled Jobs folder allows you to work with the iDoctor created scheduled jobs on the system.    
 

 
 
The folder contains a row for every iDoctor scheduled job defined on the system.  By right-clicking on a 
scheduled job entry the job can be submitted immediately, held/released or removed from the system. 
 

9.7.7.1 Fields 
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Field Description 

Job Name of the job that will run. 

Type An iDoctor defined description based on the job name. 

Submitted by This is the user that scheduled this job. 

Status The status of the scheduled job.  This will either be Scheduled or Held.  If the status 
is Held the scheduled job must be released before it will run. 

Scheduled 
date/time 

This indicates when the job will run. 

Next submit date The day when the next submission will occur (in ISO format). 

Job entry number The entry number of the scheduled job as defined on the system. 

Command The command string that will be executed when the scheduled job runs.   

 

9.7.8 Active subsystems  

This folder displays all active subsystems on the IBM i.   

 

Expand a subsystem to view the jobs running within it. 

For more information on the columns shown, see the SUBSYSTEM_INFO SQL view documentation. 

9.7.8.1 Menu Options 

Right-click a subsystem for additional options: 

Menu Description 

Explore Displays the jobs running in the subsystem. 

Select fields… This option allows you to select the fields to display for the list of jobs within the 
subsystem.    

Start subsystem This will issue a STRSBS command for the selected subsystem. 

End subsystem This will issue a ENDSBS command for the selected subsystem. 

Reset Statistics This option will reset the statistics shown in the list of jobs within the selected 
subsystem. 

 

9.7.9 All subsystems 

This folder displays all subsystems on the IBM i.  This works the same as described in the previous 
section except shows both INACTIVE and ACTIVE subsystems. 

https://www.ibm.com/docs/en/i/7.5?topic=services-subsystem-info-view
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9.7.10 Active JVM jobs 

This folder shows all jobs using a JVM on the system.  It does NOT utilize the job filters within the Active 
Jobs Pane. 

 

See the JVM_INFO SQL table function for details regarding the columns displayed in this interface. 

 

9.7.11 Active job queues 

This folder shows all job queues that are active and attached to a subsystem on the system. 

 

See the JOB_QUEUE_INFO SQL view for details about the columns shown in this interface. 

https://www.ibm.com/docs/en/i/7.5?topic=services-jvm-info-table-function
https://www.ibm.com/docs/en/i/7.5?topic=services-job-queue-info-view
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9.7.11.1 Menu Options 

Right-click a job queue for additional options: 

Menu Description 

Explore Displays the jobs waiting in the job queue.  
Note: This is only enabled only if jobs in queue value is > 0. 

Hold/Release Use this option to hold or release the job queue. 

Clear This option removes all jobs waiting on the job queue. 

Select fields… This option allows you to select the fields to display for the list of jobs within the job 
queue.    

Delete This option deletes the job queue. 

Properties Use this option to display object properties for the job queue. 

 

9.7.12 All job queues 

This folder is the same as the previous one except also includes job queues that are not active. 

9.7.13 Object lock info 

This folder displays the results from using the Object lock info Pane.  It provides a list of jobs that are 
locking the specified object and/or member. 

 

9.7.14 Output queues 

This folder contains the output queues on the system based on the filters provided in the Output Queues 
Pane.  Double-click one to view the spool files within (if any). 
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9.7.15 Spool files 

This folder shows the spool files found on the system based on the filters provided in the Spool Files 
Pane. 

Tip: These same results are displayed if accessed from an output queue described in the previous 
section. 
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9.7.15.1 Menu Options 

The following options are available when right-clicking a spool file in iDoctor: 

 

 

Menu Description 

Download / View This will download and open the spool file as a PDF in the default web browser. 
 

Download This will download the spool file as a PDF to the PC to the 
%AppData%\Local\Temp\IBM\iDoctor directory. 

Open in Data 
Viewer 

This opens the spool file in the Data Viewer.  This will be a long running operation for 
very large spool files and not recommended for large files. 
 
You can also do this by double-clicking on a spool file. 

Copy to -> IFS Make a copy of the spool file in the IFS at the desired location 

Copy to -> 
Database File 

This option will copy the spool file to a database file on the IBM i.  This allows it to be 
manipulated using SQL. 

Delete Removes the spool file from the system 

Properties This provides an interface with more details about the spool file. 

  

9.7.15.2 Download / View 

This will download and open the spool file as a PDF in the default web browser. 

 

 

9.7.15.3 Open in Data Viewer 

This option opens the file in the Data Viewer using IBM i APIs to access the data.   

Note: This is not recommended for very large files since it does not support only retrieving what is visible 
on the current screen and all data will be loaded. 
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9.7.15.4 Copy to IFS   

This interface is used to copy a spool file to the IFS on the specified location.  The data can be copied as 
a stream file or converted and saved as a PDF. 

 

 

9.7.15.5 Copy to Database file   

This interface is used to copy a spool file to a library and file.   This can be helpful in some situations if 
you need to use SQL to access the data. 
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9.7.15.6 Properties 

Spool files have additional details that are viewable in the Properties interface. 

 

 

9.7.16 Message queues 
This folder contains the message queues found on the IBM i.   
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9.7.16.1 Menu Options 

The following options are available when right-clicking a message queue in iDoctor: 

 

 

Menu Description 

Explore This will list the messages found in the message queue. 
 

Select fields… This option allows you to select the fields to display for the list of messages within the 
message queue.    

Clear Use this function to clear all messages from the selected message queue. 

Delete Removes the message queue from the system 

Rename This option can be used to rename the message queue. 

Properties This provides an interface with more details about the message queue. 

 

9.8 Power 
The Power folder provides access to analysis functions for non-IBM i data such as NMON, VIOS advisor 
and more.  It is provided here as a way for users to analyze already collected data that exists on the IBM i 
when they may not have authority to connect to the VIOS, HMC directly. 

A different subfolder is provided for each type of data supported. 
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For more information on the Power-based (non-IBM i) functions, please read the PDF on Power 
Connections. 

9.9 DB2 for i 
This folder provides functions related to database support (such as IBM i SQL Services) on the IBM i. 

 

 

Folder Description 

IBM i SQL Services These reports utilize the IBM i Services (SQL) information on a variety of topics. 
 
More information: 
https://www.ibm.com/support/pages/ibm-i-services-sql 

Index Advisor This contains graphs and reports utilizing the Index Advisor support on IBM i. 

   

https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_Power.pdf
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_Power.pdf
https://www.ibm.com/support/pages/ibm-i-services-sql
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9.9.1  IBM i SQL Services 

Over the last several IBM i releases, many functions have been added to IBM i SQL services.  This 
provides the ability to gather information about the system from a variety of differnet topics and areas 
using only SQL. 

Several IBM i Services are used in the development of iDoctor, but this document focuses on the stand-
alone reports that are available. 

For more information see the following: 

https://www.ibm.com/support/pages/ibm-i-services-sql 

https://www.ibm.com/docs/en/i/7.4?topic=optimization-i-services 

 

The IBM i Services folder provides the following options: 

 

Expand one of these to see the reports available. 

https://www.ibm.com/support/pages/ibm-i-services-sql
https://www.ibm.com/docs/en/i/7.4?topic=optimization-i-services
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9.9.1.1 Applications 

 

These reports use the Application services.  Several options were added that are iDoctor-specific but 
could be modified to suite your own needs. 

An example follows: 

 

9.9.1.2 Communications 

 

These reports use the communications functions from IBM i SQL Services. 

General system information 

This provides high-level system information. 
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ADMIN HTTP server information 

This lists the ADMIN HTTP server information only. 

 

 

 

All HTTP servers information 

This lists the HTTP server information. 

 

 

9.9.1.3 System values 

These reports show the current IBM i system values.  The reports are: 

 

 

All system values 
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QMAX* system values 

 

 

9.9.1.4 Group PTFs 

These reports provide information relating to group PTFs. 



IBM iDoctor for IBM i  

 

 

Group PTF list 

This report lists all group PTFs found on the system and the PTF group level installed. 

 

 

DB PTF Group Level 

This report lists the DB PTF Group level. 

 

 

Performance PTF Group Level 
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Check group PTF currency 

This option will check each group PTF and look for any updates available.  It will inform you of the level 
installed and the level that is available. 

 

Note:  In order for this report to work, the iDoctor client QZDASOINIT jobs’ CCSID must not be 65535.  
You can check or change this by right-clicking the component icon (i.e. Job Watcher, PEX Analyzer, etc.) 
in the component view and using Properties -> iDoctor Client Jobs then change the CCSID to 37 if 
necessary. 

 

Component properties -> iDoctor Client Jobs -> CCSID setting  

 

9.9.1.5 PTFs 

This folder contains several reports relating to PTFs.  Several of these use the PTF_INFO view. 

https://www.ibm.com/docs/en/i/7.5?topic=services-ptf-info-view
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PTFs by product 

This shows the total PTFs by product ID. 

 

Tip: From this report you can right-click to drill-down to list the PTFs for a specific product. 

 

 

List all PTFs 
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List PTFs impacted by the next IPL 

This lists the PTFs that have an action set in the PTF_IPL_ACTION column within the PTF_INFO view. 

 

List PTFs loaded but not applied 

This lists all PTFs loaded by not applied (if any). 

 

PTF search 

This option will prompt you to enter a PTF ID. Only an exact match is allowed.  

Tip: Right-click a connection within the IBM i connections view and use the Check -> PTF Search… 
function if you wish to do a generic PTF name search or search for multiple PTFs. 

 

Electronic service agent info (7.3+) 

This option shows the contents from the ELECTRONIC_SERVICE_AGENT_INFO view. 

 

Firmware currency (7.3+) 

This option can be used to check firmware levels and whether there is a recommended upgrade 
available.  It uses the FIRMWARE_CURRENCY view. 

 

 

Defective PTF currency (7.5) 

The DEFECTIVE_PTF_CURRENCY is a view which returns a list of defective PTFs on the system that 
do not have the corrective PTF applied. 

The data returned by this view is the same data that is returned by GO QMGTOOLS/MG option 24 (PTF 
Menu), then taking option 3 (Compare DEFECTIVE PTFs from IBM). 

 

 

9.9.1.6 Security 

These reports show information about user profiles, authorization lists and more. 

Tip: Additional options are available under the IBM i Explorer -> System -> User profiles folder. 

https://www.ibm.com/docs/en/i/7.5?topic=services-ptf-info-view
https://www.ibm.com/docs/en/i/7.5?topic=services-electronic-service-agent-info-view
https://www.ibm.com/docs/en/i/7.5?topic=services-firmware-currency-view
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List all group profiles 

This report lists all the group profile names and the user profiles that belong to each. 

 

List all user profiles 

This report provides detailed information about all user profiles on a system. 
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List users having trouble signing on 

This report will list all user profiles that have invalid signon attempts to the system. 

 

 

Authorization list info check 
This option prompts the user to enter an authorization list name and then displays information for that 
authorization list from the AUTHORIZATON_LIST_INFO view.  You can use the Browse option to display 
all of them that exist on the system. 

 
 
Function info 
This report shows the contents of the FUNCTION_INFO view. 

 
 

Function usage check 
This option prompts the user to enter an function ID and then displays information for that function from 
the FUNCTION_USAGE view.  You can use the Browse option to display all of them that exist on the 
system. 

https://www.ibm.com/docs/en/i/7.5?topic=services-authorization-list-info-view
https://www.ibm.com/docs/en/i/7.5?topic=services-function-info-view
https://www.ibm.com/docs/en/i/7.5?topic=services-function-usage-view
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9.9.1.7 DB2 system libraries 

These reports are intended for IBM use. 

 

9.9.2 Index Advisor 

This folder provides graphs and reports relating to the Index Advisor function on IBM i. 

 

9.9.2.1 All tables 

This folder contains these options: 

 

Indexes advised 

This graph shows the number of time indexes were advised over time. 

https://www.ibm.com/docs/en/i/7.5?topic=tools-index-advisor
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Tip: Right-click a time period to drill-down to see the specific tables where indexes were advised. 

 

Indexes advised last 24 hours 

This graph is identical to the previous one except only shows data for the previous 24 hours. 

 

Detail reports -> Indexes advised table 

This report identifies which tables where indexes are advised, the type of index to create and which 
columns to create the index over. 

Sorted by the time last advised. 

 

 

Detail reports -> Indexes advised by table, columns 

This report is like the previous one except groups the data by system_table_name, index_type and key 
columns_advised.  This is sorted by times_advised. 
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9.9.2.2 iDoctor-related tables 

The graphs and 1st 2 detail reports under this folder are the same as the ones described in the previous 
section except only show indexes advised for performance data tables and iDoctor-created SQL tables. 

 

 

Additional detail reports are provided to break down the list of tables shown by component.

 

9.10 Find Collections results 
This function displays the SQL tables created by the Find Collections option.  These tables can be 
opened in the Data Viewer or deleted from the system. 

Tip: The Find Collection interface is accessible by right-clicking the root folder icon (in PEX, CS, JW, DW) 
and using the Find Collections… menu.   

Only the tables applicable to the current component you are working with are displayed within this folder. 
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9.11 Saved collections 
Most components allow you to save iDoctor collections to a save file.  The Saved Collections folder within 
a component allows you to work with any saved collections found on the system.  See the section on 
save files for more information. 
 
Note: This interface will only show collections that were saved using the iDoctor GUI.   
 

 
 

See the section on Save files for information regarding the actions that can be performed on save files. 
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10  Knowledge Base 

This chapter covers the Knowledge Base component which is a free tool for keeping track of data, 
graphs, notes within iDoctor. 

 

 

 


